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Introduction

Welcome to TheBrain™, your ultimate digital memory and no limits mind mapping
software. Intelligence comes from the mind’s ability to think associatively—that is,
to leap from Thought to Thought, building webs of greater and greater complexity,
until new ideas are built. Associations are our inspirations. TheBrain allows you to
organize your information in the same way, without limiting you to a pre-
determined file structure. In fact, with your digital Brain there are no limits. You
can create a small project-focused Brain or grow your Brain to hundreds of
thousands of Thoughts!

Now you don't have to force any idea or project into a single folder. TheBrain
organizes information as Thoughts. Unlike folder directories and search lists, a
“Thought” in your Brain can have many connections and contexts. Moreover,
TheBrain displays your Thoughts by concept or project, linked according to how
you think. Now you can get the big picture and discover information that might
otherwise be overlooked.

Thoughts contain relevant notes, web pages, and files and can be synced for
easy access from your desktop to TheBrain Cloud or your mobile devices.

'> File Edit Thought View Options Online Window Help - =} >f
Jane's Brain | Jane's Brain { ) Philosophy | Plato ) Product Research | Product Research @ "e' 7: l
AR A| A e o °
£ Personal Life Goals 32 Hobbies Jane's Brain

.Notes. +
Notes to self

O Meetthenew-reighber

Smile at the mirror

’[‘:}h.JJajn? e's Bj rain] Smile at strangers!

L)
o Go.als . HNTy \‘Vcrk
o I'm Most.lngerested In... od Per'sollal Life
o My Latest.Prgoccupat\’ons o“ What I'm Tthk'ing About Now
4
»
4 p sHobbies < Personal Life [jjJane’s Brain :__;

Figure 1. TheBrain Interface

Thoughts are Information

TheBrain Thoughts can represent just about any type of information, including
concepts, people, documents, spreadsheets, images, videos, shortcuts, and web
pages. By letting you create links and associations between Thoughts, TheBrain
expands to become a visual interface that reflects the way you think.
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Using simple click-and-drag techniques, you'll be able to create and navigate
through networks of Thoughts in a conceptual space unique to your work habits.
When you begin using TheBrain, you will find that your computer becomes easier
to use—faster, more enjoyable, and less frustrating—helping you use your time
more efficiently.

TheBrain’s Dynamic Graphical Interface

TheBrain lets you create a simple, dynamic graphical map in which to input and
navigate all your information. Your Brain starts with a single Thought, to which
several other Thoughts can be visually linked. These Thoughts have their own
links to other Thoughts and, possibly, to each other. TheBrain’s flexible structure
allows any Thought to be linked to any other Thought, so you are never more
than a few steps away from the information you are seeking. It's simple to make
connections between Thoughts so that they reflect the connections you make in
your mind.

Cross Platform Accessibility

Brain data is accessible from virtually any device with rich full-featured clients on
Windows and macOS plus mobile clients for iOS and Android. Additionally, you
can access your Brain via a web browser by logging in at www.thebrain.com.
TheBrain’s sync service keeps all your data backed up and synchronized over
the cloud for seamless access.

This user guide is focused on the Windows and macOS software. Please visit
www.thebrain.com for information about the mobile clients.

About this Guide

The following icons are used throughout this guide to flag categories of
information:

) This icon is used to identify notes.

’ This icon is used to flag tips and suggestions.

TheBrain is offered in two editions—Free and Pro. Icons are used throughout the
guide to flag features that are specific to the Pro edition. Features that are
available in both editions are not designated with a special icon.

IP[;’@ This icon is used to indicate that the feature is available in the Pro edition only.

TheBrain 10 User Guide 2
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Because TheBrain works on Windows and macOS. OS-specific features are
flagged with icons throughout the guide. Features that are available for both
Operating Systems are not designated with a special icon.

#_ This icon is used to indicate that the information applies only to computers
‘ running macOS.

mll Thisicon is used to indicate that the information applies only to computers
M running Windows.

In addition:

Labels Names of buttons, menus, commands, keys, and icons appear in this font
throughout the guide in order to stand out.

Note to Macintosh Users

#_ Right-clicking: Most features in TheBrain can be accessed with just a single

' click of your primary mouse button. However, there are several context-
sensitive shortcuts available in context menus which appear when right-
clicking. On a Macintosh, many systems do not have a right mouse button. For
trackpad users, click or tap with two fingers. Alternatively, hold down the
Control key while you click. Note that many mice can be set up to interpret
clicks on each side of the main button differently so that Control-clicking is not
necessary. To enable this, alter the Mouse settings in the System Preferences
area of your Mac. Select “Secondary Button” for the right side of the mouse.

Ctrl key: Some features are accessed by clicking while holding down the Ctrl
key on Windows. For macOS, use the Command key.

Here is a list of working definitions for the basic terms used throughout TheBrain.

Brain A collection of associated Thoughts, each of which can have
content. You can create multiple Brains.

Thought The topics that you link together in your Brain are called
Thoughts and are the basic unit of a Brain. A Thought can
represent anything you want it to. It can include an icon, notes,
and one or more attachments (such as files and web sites) or it
can have no content at all and simply act as a subject heading
or organizer. Minimally, a Thought has a name.

Plex The visible, graphical portion of your Brain that displays your
Thoughts.
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Content Area  The portion of the Brain window that displays content that can
be associated with the active Thought or link. Types of content
include Notes, attachments (such as worksheets,

presentations, documents, videos, and images), links, URLs,
and events.

, Clicking any Thought or link in the Plex displays its associated content in the
. Content Area.

'} File Edit Thought View Options Online Window Help

\ / \ _ P
= Jane's Brain | Jane's Brain \ (9 Philosophy | Plate | == Product Research | Product Research | @ E’

A RS A A -
£ Personal Life Goals s Hob} PIeX COntent Area ne's Brain

N——

‘@‘ +
Notes to self

Meettherewreighber
Smile at the mirror

R Jane's Brain Smile at strangers!
=

o .Go.als L I\/Ty Work
of I'm Most’lnterested In... ol Personal Life

[+] L ]
o My Latest.PrEoccupations o“ What I'm Tthk.ing About Now

K
»
=3

;tHobbies £ Personal Life  [j5jJane’s Brain

Figure 2. TheBrain Plex and Content Area

Active The active Thought appears in the center of the Plex and is
Thought the current focus. Any items attached to the Thought, like
notes, files, links, and events appear in the Content Area.

\

/

- =)
AThought—"*=@My Work

Sircle and
Same Thought border

when active‘{ H |VTy \/’VOrij

Same Thought with
mouseover, but not active=
(border, but no circle)

\

Figure 3. What a Thought Looks Like

TheBrain 10 User Guide



Introduction

As shown below, when you click a Thought it moves to the center of the Plex and
it becomes the active Thought.

o2 Per.sorlal Life Goals &% Hobbies

§')Jane's Brain

é ' ———Clicking a
] Go.als *n NTy Work Thouaht

off I'm Most‘lnterested In... § 2 Personal Lif gL
o9 My Latest‘Prgoccupations o What I'm Thlnk.ing ABout Now

4 Personal Life Goals Hobbies

clTJJarié‘s,Brain

= 3
o Goals
» °®
£ I'm Most Interest...

22 Personal Life o@ My La?esg Preocc...

4 > Go... ®Com ° ul\ly WOrk

What Fm.Thinkin...

... activates .

i . a “ﬂ%afpily o= My Passion

it, moving it ] e +%ood 5 Rty pet

to the center o[t Health.arld Fitness o Perso‘naI.Finance
of the Plex . I-?ob.bies x@'l’ra.vel
o4& Home F.’rojects
Kl
4 P Go.. @Company Goals .gMyWork 4 Travel [Jane's Brain 2 Personal Life
Figure 4. Activating a Thought
Thought A Thought is said to be a “parent Thought,” “child Thought,”

Relationships “sibling Thought,” or “jump Thought” based on its relationship
to other Thoughts with which it is linked.

In your own life, you may be someone’s parent, and
someone’s child, and someone’s sibling, and someone’s
peer, advisor, or colleague. So, who are you? The answer to
that question is relative—it depends on the circumstances
and what hat you’re wearing at the moment.
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You may be ...

a child of
a parent

a colleague

a parent
of a child

Figure 5. Relationships are Relative to You

The same applies to Thoughts. The relationships between
Thoughts are displayed automatically, based on which Thought
is active at the moment.

4

Whether a Thought is a parent, child, or sibling depends on
its current relationship to the active Thought.

') File Edit Thought View Options
/ == Jane's Brain | Hobbies
OCARS A A+a

2 Personal Life Goals sz Hobbies

A jump Thought

—_—
\b §udgeto

The active Thought

—e—

5~
S 2
\ EL
A parent Thought
ontamlly

0.4 Personal Life / *® FOOd

f——— - - o® F!nends «\

Online Window Help =

@

—oft Health and Fitness K

Home PrOJects

ob4 Art and Culture
0% Gardenlng

o II|MUSIC

~o@ My Passmn Slbllng
Wt Thoughts
o8 Personal Fm%nce g
u&%ports

o éTechnoIogy

What I'm Readlng Now

o Snorkellng and Dlvmg\

Child Thoughts «

¢ Hobbies

§Jane's Brain 4 Personal Life

Figure 6. Thought Relationships are Relative to the Active Thought

Child
Thought
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Child Thoughts are subtopics of the active Thought. They
appear in the “child zone,” below the active Thought. In the
picture above, the active Thought “Hobbies” has seven child
Thoughts.
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Parent Thoughts represent super ordinate topics of the active
Thought. They appear in the parent zone, above the active
Thought.

Sibling Thoughts share a parent with the active Thought.
They appear in the sibling zone, to the right of the active
Thought. In the picture above, “Family,” “Food,” “Health and
Fitness,” “Home Projects,” “My Passion,” “My Pet,” and
“Personal Finance” are siblings of “Hobbies” because they
are all children of “Personal Life.”

”

Jump Thoughts are related to the active Thought but are
neither child nor parent topics. They appear in the jump zone
to the left of the active Thought. Jump Thoughts have an
“equal weight” relationship with the Thought to which they are
related. For example, as shown above, “Hobbies” has the
various hobbies “Art and Culture,” “Gardening,” “Music,”
“Snorkeling and Diving,” “Sports,” “Technology,” and “What
I’'m Reading Now” linked as child Thoughts since they are
types of hobbies. “Budget” affects the amount of resources
available to spend on the various hobbies and so it is closely
related, but it is not a hobby itself. Therefore, it makes a
perfect jump Thought—related, but not part of the main
Thought grouping.

Thoughts in the Plex have three circular “gates,” each of
which is used to link a specific type of relation: The parent
gate is above a Thought, the child gate is below it, and the
jump gate is to the left or right of it. A gate is hollow when
there are no links attached to it and solid when one or more
links are attached. Solid gates in a contrasting color have
links to Thoughts that are not currently showing in the Plex.
The color of gates is based on the current color scheme.
When you point at a gate, a highlighting circle appears
around it.

Parent gate
oti My Web.Service
\ IT Resources
e

%’ting . Tecf:noiogy
Web Cl.ients

‘ Companybresentations Online’Meetings
,Data Collection . Research
‘-Grsphics Child gate Talent
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Link A link is the line that connects two Thoughts. When used as a
verb, to “link” is the act of connecting Thoughts to establish
close relationships. Links can also show direction to help you
visualize relationships.

Installing TheBrain and Creating an Account

The first time you download and install TheBrain, you’ll be prompted to log in or
create an account if you don’t already have one. The log-in window provides the
ability to create a new account or log in to an existing account.

@
%

T HE&E
® S SBRAIN

| |

Forgot Password

Figure 8. TheBrain Log-in Window

Here are the fields to complete if you’re creating a new account:
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® T HE&E
®
BRAIN
Your first name

' /Your last name

L Email address to
&4 be associated with

Ausefmame [ this account
you create
(no spaces —V A password
and at least 2 4 You create
characters)

v—w Confirmation of
= your password

Newsletter [ | Interested in TeamBrain

| Create Account |

Login

TheBrain Cloud (https://api.thebrain.com/)

Figure 9. Creating a New Account

After you click the Create Account button, TheBrain will send an email to the
address you specified.

, Check for a message from no-reply@thebrain.com. Make sure to check your
. spam folder if you don’t receive the message promptly.

When you open the message you will see a green Activate Brain Account link.
After you click the link, you'll see a notice confirming your success.
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THE&E
S BRAIN'

Your Brain account is almost ready!

To activate your account, click the button below.

Activate Brain Account
For more resources on getting started with your BraX, visit our online support center.

Enjoy!

THE

BRAINT

TheBrain Team .

Questions? Call us at

el | Activation Successful: LeeSharpe67@gmail.com

Thanks for verifying your email address. Your account has been activated.
Return to TheBrain application to login.

TheBrain Technologies LP, 11522 W Washington Blvd, Los Angeles, CA 90066

Figure 10. Activating a New Account

Now you can return to TheBrain and log in.
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elements of your digital life
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<4 »  @©lTand.. @UseTheBrainfor &Welcome to TheBrain
Need help getting started? /
Create a Quick-Start Brain

Upgrading from TheBrain 87

Import a Brain from TheBrain 8

Figure 11. Welcome to TheBrain

Click “Create a Quick-Start Brain” and follow the directions on the screen to enter a
personalized name for this Brain. The Quick-Start Brain is actually a dynamic
resource for learning more about using your Brains and you'll find a wealth of
useful information in it. Click any of the links to see what is displayed.

v

You can always create a new Quick-Start Brain by selecting the Create a
Quick-Start Brain command on TheBrain Help menu.

Opening Older Brains

When you’re looking at old and new Brain files, note that Brains created in
TheBrain 7 or 8 have filename extensions of .brain. Brains created in some earlier
versions have a .brn filename extension.

To open a .brn file that you created in a version older than TheBrain 8, first
[ open it using TheBrain 8 and then import the resulting Brain in TheBrain 10, as
described in the steps below.
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To open a Brain that you created in TheBrain 8:

1. Open TheBrain.

2. Click the File menu, then click the Import command.

‘A

[ (® Create a new brain

() Add to "Jane's Brain™ and link to "Web Marketing"

—————
=

—_—

TheBrain 8 Brain

(brainzip, brain)

Brain Archive
Text Outline
MindManager
FreeMind
Folders
TheBrain 8 XML

(brz)
(txt)
(mmap)

(mm)

(xml)

TheBrain 8 Brain

All of the data from your Brain will be imported
into TheBrain 9. Your existing version 8 Brain will
not be changed and will remain available. Note
that any changes you make in version 9 cannot
be migrated backward to version 8.

To import data from earlier versions of TheBrain,
open it using TheBrain 8 first then import the
resulting Brain here.

[ Select File... H Cancel

Figure 12. Import Box for Opening an Older Brain

3. Click the Select File button, navigate to the Brain of your choice, then click
the Open button when the file is selected. You will see a running progress

report.

4. When TheBrain has finished converting, you will see a “Conversion
complete” message as shown below. Click the Import button.

S

TheBrain 8 Brain
Brain Archive
Text Outline
MindManager
FreeMind
Folders

TheBrain 8 XML

(® Create a new brain
(O Add to "Jane's Brain" and link to "Web Marketing"

(brainzip, brain)
(brz)

(txt)

(mmap)

(mm)

(xml)

Source: | A Writer's Brain Streamlined.brain

Import H Cancel

TheBrain 10 User Guide
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Figure 13. Import Conversion Progress

5. When TheBrain has finished importing, you will see the following dialog
box. Click the Open button to open the Brain you just imported in a new tab
of TheBrain window.

£ Import Complete X

Do you want to open the imported brain?

Open H Cancel

Figure 14. Open the Imported Brain in a New Tab

Suggestions for Transitioning to Your New Brain

Here are some tips for establishing a happy relationship with your Brain:

v

Begin by taking yourself on the guided tour provided in the next section of
this guide. As you exit the tour, you'll already have hands-on skills for getting
your Brain up and running quickly and easily. You may also want to attend one of
TheBrain’s free online seminars on getting started—TheBrain 101. To learn more
about TheBrain 101, go to http://www.thebrain.com/101.

Avoid “converting” to a Brain-only environment all at once. Make the
transition on a file-by-file basis so that every piece of information your Brain
contains will be useful.

Build your Brain as you go—associating Thoughts as they occur naturally.

Avoid the temptation to move large folders into your Brain. TheBrain can
handle this, but your Brain will be cluttered with Thoughts you may not need.

Remember that your first Brain doesn’t need to be your only Brain or your last

Brain. Experiment! Create a Brain just for fun, to try out the possibilities—give
yourself room to stretch and explore. Your Brain is waiting!

TheBrain 10 User Guide 13
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A Guided Tour of TheBrain

A Guided Tour of TheBrain

The best way to build your comfort level with your Brain is to build one yourself—
with your very own hands. This guided tour will walk you through the basics,
pointing out items of interest along the way. There’s no need to take notes and
you’ll never get left behind, because you’ll be going at the most strategic pace—
your own.

’ During this tour, you'll be asked to enter specific information to make it easier
to refer to items and areas as the tour proceeds. Naturally, when you’re on
your own, you’ll use your own ideas to create Brains that reflect your thinking.

Here are the sign posts you'll see along the way:

Enter here—the startup action for this phase of your guided tour

Point of interest—take out your virtual camera

/ Tip—where you can find more details about this step of your guided tour

<>
Take five—this is a good place to take a break if you want one

Exit here—this marks the end of your guided tour

Let’s go!

Part 1. Start Up and Explore the Brain Window

Itinerary: You'll start up TheBrain, create a new Brain, and tour through the
components of the Brain window.

@ Start up TheBrain, unless it's already running. You can select TheBrain from the
Start menu or the desktop icon.

TheBrain 10 User Guide 14
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0 S Filters \v/

Best match

TheBrain
Desktop app E
' ' TheBrain 9 7

Figure 15. Starting TheBrain

Log in to your Brain account. This enables integration with any subscriptions you
may have.

=

T H&E
® P SRAIN

Username or
Email address

| | ‘/ Your Brain
r%y password

| |

Forgot Password

Create Account

TheBrain Cloud (https://api.thebrain.com/)

Figure 16. Logging In to TheBrain

1. Click the File menu in the menu bar at the top of the window on the
welcome screen (or click the File menu, then click the New Brain

command).

TheBrain 10 User Guide
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@TheBrain
File | Edit Options Help
New Tab Ctrl+T

New Window Ctrl+Shift+N

| Create Braiq\
NS

Import...

Create a New Brain
Utilities 3
Close Tab Ctrl+W

Close Window

Exit Alt+F4

Figure 17. Create Brain Command

2. Inthe empty field, type: Tour

6> Create Brain X |

| Tout B

== | |

Figure 18. Create Brain Dialog

3. Press the Enter key or click the OK button to finish creating your new
Brain. It will appear in a new tab named “Tour.” Your screen should look
similar to the one below. Note that you can minimize, maximize, or restore
TheBrain window using standard Windows’ techniques.

TheBrain 10 User Guide
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.> File Edit Thought View Options Online Window Help < mm——m— Menu bar
/Etour | Tour 4 —» Brain tab

AR A 4+ @& <e—— Brain button bar

[Search box &3 -
=N M o

| + Name of Active Thought —>
The Plex

The Content Area

First Thought in I
your Brain

Past Thought List \
Tour“

=

Figure 19. New Brain in the Plex

TheBrain creates your first Thought for you. It has the same name as your Brain
(which you can change later if you want to). Since it's the only Thought, it's also
the “active Thought”—the Thought that’s currently selected.

4. Take a few minutes to click some of the Brain Themes to see how the
background of the Plex changes. Then click the Theme named “- Light Blue

Default” to select it. Click the “X” or press the Esc key to close the Brain
Theme box.

You can always return to the Brain Themes box by right-clicking within any
: blank area of the Plex and selecting Brain Theme.
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@ The Brain Toolbar
Adjust the Display

Activate Open the size of the Plex
the Home list of text in the layout
Thought; Typesi Plex ; goptions

Activate | Sync this
previous [ |~] [ ] [ ]D[ ] [ ]‘_ Brain with
Thought _.BB ﬁ A ‘ AA ‘k ‘ . the server
— 4 A [
Activate the Open the Show 1 fewer Show 1 more
next Thought list of Tags generation generation

of Thoughts of Thoughts

Figure 20. TheBrain Toolbar

1. Point at each one of the buttons in the Brain toolbar so that you see a brief
explanation in the pop-up tool tip.

Note that since your Brain has only a single Thought so far, some of the
toolbar options are currently disabled.

@ The Brain’s Content Area

’) File Edit Thought View Options Online Window Help =
== Tour | Tour /\*)
AR A A+ @ O
( Tour)

‘Notesl +7

| )
v

My tour of TheBrain

4 p> Tour

e
A

Figure 21. A Note in the Content Area
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1. Click in the empty white space of Content Area, then type: My tour of
TheBrain. You've just created your first Note, which is associated with the
“active Thought"—Tour.

Notes are saved automatically and always stay associated with the active
Thought, even when you activate other Thoughts or close your Brain.

.

2. Experiment with any of the buttons in the Notes tab toolbar if you want a
quick peek at some of the functionality.

/ Tip: See the section beginning on page 146 for details about working with the
Content Area.

Part 2. Create New Thoughts

Itinerary: You'll create a single Thought, multiple Thoughts, a Thought from an
existing file, and a Thought “pin,” and modify the relationship between two
Thoughts.

Your Tour Brain should be on the screen, as you left it in Part 1.

1. The three small circles in the border around the Tour Thought are called
“gates.” The bottom circle is called the child gate because it provides a
gateway towards creating a child Thought. Drag the mouse from the child
gate down a short distance, then release the mouse button. The Create
Child dialog will open.

/ Tip: If you prefer not to drag the mouse to create a Thought, right-click the Tour
Thought and then click the Create Child command on the context menu.

Child gate

(o)

NZ

|TB Buddieq

Figure 22. Dragging from the Child Gate
2. Inthe empty field, type: TB Buddies

This Thought will organize Thoughts about people you're going to talk to
about how they use TheBrain, so you can share experiences.
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3. Press the Enter key. A larger circle appears around a new Thought for a
few seconds, highlighting it for easy visibility. Your Tour Thought now has a
child Thought named “TB Buddies” (short for “TheBrain Buddies”).

@ Creating Multiple Thoughts at Once

You can create more than one Thought at a time by typing a semicolon to
separate each Thought.

1. Create four new child Thoughts for Tour, all at the same time. To begin,
drag Tour’s child gate down a bit, then release the mouse button.

2. Inthe empty field, type: Tips; Reminders; To-Do; New Brain Ideas

N1/

Tips;Reminders;To-Do;New Brain Ideas

\
|
|
1
|

Figure 23. Create Multiple Thoughts at Once

/ Tip: The semicolon (;) between each Thought name tells TheBrain that these are
separate Thoughts. Typing a space after each semi-colon is optional.

3. Press the Enter key.

.') Note that the new Thoughts are arranged in alphabetical order.

@ Create a Thought by Dragging and Dropping an Existing File

You can create a Thought by dragging a file from the desktop or from your file
manager (such as File Explorer on Windows or Finder on a Mac). The new
Thought will have the same name as the file (minus its extension) and it will
automatically have the file as an attachment. It will become a child of the active
Thought. You'll learn more about attachments in the next part of this tour.
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1. Choose any file, from your desktop or from any other location. Your original
file will not be affected—by default, drag and drop creates a copy of the file.
2. Size the TheBrain window so that you can also see either the portion of the
desktop containing the file you're going to use or the window in which the
file is listed.
3. Drag the file into the Plex.
= & |
L New  Open Select -
e » Tour
and v Se A
Name —_ é ; : b ®
i RN “*=P» oz Directions oTB Buddies
@= After Shoy#aces.docx o/ © e ©
= Direction;.doa oNew Bra'g Ideas OT|p§
@=| Guides.docx o Ren.ﬂnders OT(.)-DO
= Revival Theaters.docx o N
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Figure 24. File Dragged into Plex Becomes a Child Thought

The new Thought will appear in the Plex and it will include an icon that
represents the type of file. Any time you click this icon in the Plex, the
related file will open.
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@ Thought Pins

'} File Edit Thought View Options Online Window Help

; = Jane's Brain | Health and Fitness @

AR A A+ @

2 Personal Life Goals ¢ Hobbies \
Thought Pins

° .
of Persorgal Life

e HeaItI'Tar;d Fitness

Figure 25. Thought Pins in an Existing Brain

The area at the top of the Plex, just below the Brain toolbar functions like a
bulletin board on which you can “pin” Thoughts you want to keep at your
fingertips. These quick-access shortcuts to Thoughts are called “pins.” No matter
where you are in the Plex, the pins remain visible.

1. Right-click the Thought named “Reminders,” then click Create Pin on the
context menu.

Unlink

‘ [ Crela\te Pin

1

Set

o ] " -
og DlreCOtlon! Toggle a pin for this Thought

e/ Private
oNew Brain Ide :
e © Show History
© Remlngjers Show Thought Properties

Figure 26. Create a New Pin

2. Click any other Thought in the Plex. When you want to return to the
Reminders Thought, click the Reminders pin to get there instantly.
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@ Relationship Changes

1. Create a new child of Tour named “Experiments.” (Drag from Tour’s child
gate down a bit, type: Experiments and then press the Enter key.)

2. Now you’'ve decided that the Experiments Thought should really have an
equal relationship with Tour, and not be one of its children—because you’ll
use experimenting as much as touring to develop your Brain skills.

Drag Experiments up to the left side of the Plex so that it is level with Tour,
then release the mouse button.

Dragging Experiments ... @
aaasARSEAEEE » c Expe’riments

*
*
K »Tour

L S
og Directions

... then releasing the mouse
when Experiments is in the
“jump zone” of Tour

Expéfimentso Tour

Experiments

—
oNew Brain Ideas

..
Domindare

Experiments is now a
jump Thought of Tour™

$
og | Directions

o/ °
oNew Brain Ideas

Figure 27. Dragging a Thought to Change its Relationship

/ Tip: See the section beginning on page 87 for details about changing Thought
relationships.

<>

5 This is a good place for a break if you'd like to take one. You can leave your
Brain open or close the Brain window. Just start up TheBrain again when you're
ready to continue.

Part 3: Find, Add Attachments, Link, and Delete Thoughts

Itinerary: You'll find Thoughts, add an attachment to a Thought, add a web page
to a Thought, use a Thought to open an application, link some Thoughts, and
delete a Thought.
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Your Tour Brain should be on the screen, as you left it in Part 2. You'll begin by
creating a few more Thoughts for a little more scenery along the way.

1. Create four new child Thoughts under TB Buddies: John; Jill; Fred; Ann
(Drag from TB Buddies’ child gate, then type each name, separated by a
semicolon, then press the Enter key.)

2
oTB Buddi
ug))les

| John; Jill; Fred; Ann

Figure 28. Four New Thoughts

2. Click TB Buddies to make it the active Thought. It should be in the middle of
the Plex.

3. Enter a Note for TB Buddies: We should compare Brains sometime

4. Point the mouse at the Tour Thought and notice how the Note you just
entered for TB Buddies is still in the Content Area.

5. Click the Reminders pin at the top of the Plex to go quickly to your
Reminders Thought. Notice that the Content Area is blank, since you
haven’t created content for that Thought yet.

@ Instant Activation

“Instant Activation” is a Brain feature that lets you quickly find a Thought by
typing a few letters, and choosing from a list of “hits.” After you click the Thought
of your choice, that Thought is automatically activated.

Say you’re ready to work with Fred’s Thought—you want to add an attachment to
it. With such a small Brain, you could click around and find it pretty quickly, or
you could speed things up:

1. Click in the Search field in the top-right area of the window and type: f
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(Fun)
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Tour
TB Buddies

@ @ Directions.docx « Directions

Figure 29. Instant Activation

Because you only have one Thought that begins with the letter “f,” it is
found instantly. If other Thoughts begin with the same letter you will see
them in the box. The more characters you type, the more finely-tuned your
search will become.

Click on “Fred” in the Search field below Thoughts, Links, and Events. Fred
will be activated.
Type the letter “j” in the Search field to activate Jill. Notice that the two
Thoughts beginning with the letter “” appear in the list. Activate Jill.

/ Tip: See the Searching Your Brain section beginning on page 47 for details
about more complex searching and the Navigating Your Brain section on page
38 for more on cruising around your Brain.

@ Attachments

1.

2.

TheBrain 10 User Guide

Back to Fred. Activate Fred by clicking his Thought in the Plex.
Click the Add Attachment button, which displays as a + sign, next to the

Notes tab in the Content Area. As you see below, you can add many kinds
of attachments.
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Fred

Notes +b
) Add Attachment

(] Link to File || Enter URL

| Open Folder | | Create Event |

| Capture Image | | Templates... | I Paste Image |

Create File

Microsoft Access Database
@ Microsoft Excel Worksheet
£ . Microsoft PowerPoint Presentation
@ Microsoft Publisher Document

& . Microsoft Word Document

1 & . Text Document y

Figure 30. Add an Attachment

You can add an existing file or you can create a new one. For now, select
an existing file on your computer. To do so, click the Link to File button.

Navigate to any file on your computer, then click the Open button to attach
it to the active Thought. As soon as the file is attached you will see a
Preview button so you can look at the file right away if you want to. Or you
can double-click the file’s icon in the Content Area.

With Fred still active, click on the Notes tab and notice that the name of the
file you attached now appears as a new tab in the Content Area. Now you
can click on it whenever Fred is active to access and open the file. You
might use this function to add a file you're collaborating on, or a worksheet
with data for a project you’re completing together.

@ Web Page Thoughts

1.

2.

TheBrain 10 User Guide

Activate the John Thought.
Open your Internet browser and navigate to a web page of your choice.

Arrange the browser window and the Brain window so that you can see at
least part of both of them.

Drag from the address bar icon in your browser to an empty area of the
Plex, then release the mouse button.
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Figure 31. Inserting a Web Page as an Attachment

The web page will be added as a child Thought of John. When you click the

Thought the web page will launch in TheBrain’s built-in browser in the Content
Area.

/ Tip: If you want to add the web page to a Thought instead of creating a new child
Thought, drop the web page on top of the Thought. See the Adding Attachments
to Your Thoughts section beginning on page 161 for details about attachments.

@ Creating Attachments from a Thought

1. Activate the New Brain Ideas Thought by typing an “n” in the Search field
and then clicking on “New Brain Ideas” in the list.

2. Click the Add Attachment button in the Content Area.

3. Click Microsoft Office Word Document in the Create File tab (assuming
this application is installed on your computer—if not, select any other

application in the list). The new document will be named “New Brain Ideas,”
matching the active Thought.
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) TheBrain automatically detects file types for many applications that you may

. have installed on your computer and populates the list of available files to
create. You can also add templates for any file that you'd like to use as a basis
for new files yourself.

= Click the Templates... button to open the folder where templates are
stored, then copy empty files of the types you want to be able to create
from within TheBrain into the folder.

= When you are done, click the Add Attachment button again and chose
one of the templates you added.

Once you select a file type, two things will happen:

= First, a new file will be created and added to the Thought (in this example,
a Microsoft Word document named “New Brain Ideas”).

= Second, the file will be automatically opened so that you can work on it (in
this case, starting Microsoft Word).

After you add content to the document and save it, it will be saved internally
within your Brain. When you click on the Thought, the document will open
again.

4. Close the new document before moving on to the next section.

@ Linking Thoughts

One of the most powerful features of TheBrain is the ability to connect Thoughts
to each other. Remember, you can connect any Thought to any other Thought.
For example, say one of your TB Buddies, Ann, is full of ideas on how to use
your Brain. You might want to link her to the New Brain Ideas Thought.

1. Activate the New Brain Ideas Thought (if it isn’t still active).

2. Drag from the jump gate on the left side of New Brain Ideas as if you are
going to create a new jump Thought and release the mouse button.

®

/,, >~
‘____...@[jm New Brain Ideas)
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3. Type the first few letters of the Thought you want to connect (Ann) in the
Create Jump dialog box. Notice that the existing Thought is displayed in
the list below.

Ann -

4. Either double-click on Ann in the list of found entries or click Ann once then
press the Enter key.

Ann -

(@]
e Tour
@

)
Anne {m New Brain Ideasj
O —

Figure 32. Jump Thought Linked to an Existing Thought

Now that Ann is connected to New Brain Ideas, whenever you look at this
Thought, her Thought will be just a click away. Also, when you are at Ann’s
Thought, the New Brain Ideas Thought will be conveniently available.

There are many ways to link existing Thoughts. The method above is convenient
when the Thoughts you want to connect are not both visible, however if the
Thoughts are both visible, you can simply draw the link between the two, starting
from either one of the Thoughts’ gates. Both the Past Thought List below the
Plex and the pins can be used for linking Thoughts visually. When you connect
two Thoughts visually, the resulting relationship will be determined by which gate
you selected to start the linking—it does not matter where you release the mouse
button over the destination Thought.

@ Forgetting and Deleting Thoughts

If you’ve entered a Thought in error or you simply don’t need to keep it around
anymore, you can easily remove it from your Brain. TheBrain offers two ways to
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remove Thoughts—forgetting and deleting. When a Thought is forgotten, it can
be remembered later if need be, however, deleting is permanent.

Let’s forget the Thought Jill.
1. Make TB Buddies the active Thought.
2. Right-click the Jill Thought.
3. Click the Forget “Jill” command on the context menu.

Jill disappears from the display. Now, if you want to show Jill again, turn on
Forgotten Thoughts:

= Click the Options menu, then click Show Forgotten Thoughts.

Any forgotten Thoughts will appear faded.

Showing Forgotten Thoughts X
Reminders
o Tour
o
»
og Directions
e ©
oz New Bra...
. o ©
TB Buddies >Reminders
& ©
oTips
Vi
oTo-Do /
-] (3 '
-Ann S 4______/
o _ v o ©
og Fr_ed &3 John

Figure 33. Forgotten Thoughts

A message above the Plex reminds you that forgotten Thoughts are showing.
You can permanently delete Thoughts or remember them individually or all at the
same time, which is explained in the Deleting and Forgetting Thoughts section on
page 96. To turn off the display of forgotten Thoughts, simply click the X button
next to View Report or click the Show Forgotten Thoughts command in the
Options menu to toggle it off.

/ Tip: If you want to permanently delete a Thought without first forgetting it, hold
down the Shift key as you right-click on it and then select the Delete command.
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Concluding Your Tour

If you click the Home button in the Brain toolbar, your Brain should look
something like this:

.> File Edit Thought View Options Online Window Help = a X
. . A
Tour | Tour @ E' L :_
CARS A A e (=N e
Reminders Tour
Notes =+
My tour of TheBrain
Expeorirgents-
SR Yot { Jeprorr
o[« Directions oTB Bud.dles
- e/ © )
#[=] New Brain Ideas O'.I'|p§
¢ ® e O
©Reminders OTo-[ao
1
»
&
4 > [ New Brain... TB Buddies [§FJohn Tour1|3

Figure 34. Completed Tour

Where to go from here? You can stay and experiment more with your Tour
Brain, begin reviewing sections of interest throughout this guide, open the Quick-
Start Brain, or dive into creating your own Brain. You may want to glance at
some of the example Brains at https://thebrain.com/apps for more ideas—but you
probably already have plenty of your own!

/ Tip: If you are ready to dive into beginning your own Brain, start by creating a
few Thoughts for broad categories before you go to the detail level. For example,
if your name is Ed, “Ed’s Brain” might be the name of your Brain (and your first
Thought) and its first children might be Work, Family, Hobbies, and Friends.

=

This concludes your guided tour—-thanks for coming along!
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Understanding Thought Relationships

There are no rules governing the relationships between Thoughts—whatever
makes sense to you is the way your Brain ought to be organized. The three
primary relationship types—child, parent, and jump—can be used to express
different types of relationships. Sibling is a relationship that is derived from
child/parent relationships.

The examples in this section can help you understand the variety of relationships
and how they are used. The core concepts behind each type of relationship are
as follows:

= Children: Child relationships are usually used to link more specific
information or information that represents a subcategory.

= Parents: Parent relationships are usually used to link more general
information. Parents can also be thought of as higher level categories to
classify groups of information. They serve to indirectly connect their child
Thoughts as siblings.

= Jumps: Jump relationships are usually used to link two pieces of information
that are exclusively related, meaning that the two items are related to each
other but neither represents a group that the other is a part of.

Let’'s move on to an example to explore these relationship types. Imagine that
you are the owner of a company and you are reviewing personnel files. Each
employee has a file. You decide it makes sense to organize your employees by
department. Your Brain is called My Brain. From My Brain, you create a child
Thought called My Company (see Figure 35). My Brain is now My Company’s
parent Thought. You create four child Thoughts from My Company—
Manufacturing, Sales, Service, and Billing. These departments are sibling
Thoughts of each other.
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Figure 35. Sample Brain
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Now you go to each department and create more child Thoughts, one for each
employee of the department. If an employee splits time between two
departments, you can make him a child Thought of both departments—he’ll
appear in both and you won’t have to duplicate his file. In this example, Bob is a
child Thought of both Manufacturing and Sales (see Figure 36). This is one of the
most powerful features of TheBrain—having one Thought under more than one
heading.
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Figure 36. Child Thought with Two Parents

If you own more than one company, but have one accountant for all of them, you
might want to make a Thought called Accountant and link it as a jump Thought to

each company, as shown below.
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Figure 37. Jump Thoughts to the Active Thought
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Imagine that Joe’s company has just purchased one of your companies. Since
Joe’s company now owns this company, Joe’s Company becomes a parent (see

below).
.> File Edit Thought View Options Online Window Help = m] X
aw: ()
g My Brain | My Other Company @® ’ B
OCARS A A+ @~ (Y
, Q o .
oJoe's Company oMy Brain
@ ®
@ ©
Jg My Other Company] My Company
4 > Manufacturing  Billing Sales Service My Brain My Company Bob Accountant My Other Com...

Figure 38. New Parent Thought

Because Joe wants to avoid a conflict of interest, the acquired company (My
Other Company) no longer uses the same accountant. So its jump gate is hollow,
while its sibling’s jump gate (My Company) maintains that Link and is filled.

As you use TheBrain, you will develop a sense of the types of relationships you
wish to make between Thoughts. It is always easy to change relationships by
adding and removing links (see Changing Relationships Using Drag and Drop on
page 103).

Families of Thoughts

It is tempting to view Thought relationships as families, and indeed these
different parts of your Brain are types of families, with their ancestry visually
spread before you, represented by subjects and categories. But unlike human
families, a child Thought can be a parent of one of its siblings and a Thought can
have more than two parents.

The complex relationships you can form in TheBrain are the source of its power.
Let’s consider sibling Thoughts that also share a parent/child relationship.
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Let’s say you are studying philosophy. You might have a Thought called
Philosophy. Individual philosophers such as Plato and Aristotle could be child
Thoughts of Philosophy. Each of these siblings, in turn, may have child
Thoughts. Aristotle was a student of Plato, so you may want to make Aristotle not
only a child of Philosophy, but of Plato, so that when you’re working with
Aristotle, Plato is only a Thought away.

‘) File Edit Thought View Options Online Window Help == =] X
My Brain | My Other Company / == Philosophy | Aristotle ® 5:.’ &t
CARDS A A+ @ ©
>Philosophy /5Iato
Aristotle Theories

©Dialogues ©Meaning of Life

|

Philosophy  Plato  Aristotle

Figure 39. Example of Parent/Child Relationships

Notice that when Philosophy and Plato are in Aristotle’s parent zone, their
relationship (Philosophy is a parent Thought of Plato) is shown by the line linking
the child gate of Philosophy to the parent gate of Plato.

Clearly, TheBrain is a powerful method of organizing ideas and information. No
hierarchical file structure can provide as much cross-referenced information at a
glance. And our example is pretty basic—a fully developed Brain can hold many
more relationships and much more information.
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All Thoughts can be connected—directly or indirectly—even Thoughts that may
seem to have nothing to do with each other can be related through a chain of
links.

Let’s look at an example, say, the Queen of England and asparagus. You have a
Thought called Queen of England. One of its child Thoughts is Prince of Wales,
which has a parent Thought Famous Princes that is also linked to the story of the
Frog Prince.

oFamous Princes éQueen of England

==

Prince of Wales oFrog Prince

The story has another parent Thought called Fairy Tales. A sibling of Frog Prince
is Jack and the Beanstalk.

OFalry Tales oFamous Prmces

¢Jack and tﬁe Beanstock )
olLittle Red R|d|ng lwod
9 © ) Mother Goose

oPrince. of Wales

Jack and the Beanstalk has child Thoughts called Giant and Jack. Giant has
another parent Thought called Famous Giants.

$Famous .Giants oJack and tT‘le.Beanstock

(Giant)

Pe)
oJolly Gree.n Giant

Famous Giants has a child Thought called Jolly Green Giant. Jolly Green Giant
has child Thoughts named after canned vegetable products, one of which is
Asparagus. Thus, the Queen of England is connected to asparagus!

o Famous Glants

Jolly Greehmnt

oAsparagus OIseas
P ag 0
>Corn
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Depending on the relationship you create between them, Thoughts may be
closely or distantly related. Thoughts are considered to be closely related when
they are linked directly or are siblings. In the default view of the Plex, only close
Thoughts of the active Thought are always displayed in the Plex. Thoughts that
are one additional step (generation) away from the active Thought can be
displayed by expanding the view. See Advanced Navigation and Alternate Views
on page 137 for information about the different view options.

Opening a Brain

When you log into TheBrain 10, and no Brain is open, all local, synced or online

Brains will be displayed as thumbnails in the Brains tab, as shown below. This is
assuming that you have already created one or more Brains. Clicking on a Brain
thumbnail opens that Brain.

°> File Edit Options Window Help - a X
Brains D :ﬂ.’ =
©+ | C |z
/ - ’-—-"~
Jane's Brain Product Research
Marketing Philosophy

Figure 40. Example of Three Available Brains on the Brains Tab

By default, Brains are listed according to how recently they have been accessed.
You can also see the list of Brains sorted alphabetically using the Brains tab
toolbar, shown below. All Brains that are locally available are shown first,
followed by Brains that are available online.
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@TheBrain
File Edit Options Help

(1)

/ |:=| Brains )

Sort Brains by Ia;t

yad 2 C][A‘Z] 4" accessed date

Create a

new Brain H
Refresh Sort Brains by name

Figure 41. The Brains Tab Toolbar

The status of whether each Brain is available locally, online, or both is also
displayed. Each Brain in the Brains tab will have an icon appearing in the lower
right-hand corner of the thumbnail. Right-click on a Brain or click on the status
icon to display a menu of options for that Brain, as shown below. The
appearance of the icon(s) help you identify whether the Brain is Local, Synced
(local and online) or Online only.

Product Research

Figure 42. Icons Indicating Local, Synced, or Online Only

Local
Synced
Online

Figure 43. Status Indicator Icons
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Opening a Brain that Doesn’t Appear in the Brains Tab

If you have a Brain from an older version or from a backup, it will not appear in
the Brains tab until you import it. Click the File menu, then the Import command.
Choose the type of file you want to import, then click the Select File button,
navigate to the .Brain file of your choice, then click the Open button when the file
is selected. Click the Import button after TheBrain has finished converting the
Brain.

Managing Brains Using the Tabs

The tabbed interface of the Plex lets you switch instantly between Brains or even
keep the same Brain open in multiple Brain tabs or windows

To re-open the Brains tab to display the Brain thumbnails, click the + icon to the
right of the last tab.

@ TheBrain

File Edit Thought View Options Online Help

— One Brain for It All | I'm Most Interes...

ARS A A+ @

4* Personal Life %! My Work

Figure 44. Click the + Icon to Open the Brains Tab

open a Brain it will appear in a separate tab. Switch from Brain to Brain
instantaneously by clicking its tab. All tabs and their states are automatically
saved and restored when you quit and restart.

) There is no limit to the number of Brains you can open at once. Each time you

= Float tabs into their own dedicated window by dragging a tab out of TheBrain
application window. This creates a new Brain application window with just a
single tab.

= Merge tabs into one window by dragging and dropping. Click the tab of one
Brain window and drag the tab to another open Brain, hovering over the tab
area. Then release the mouse button.

= Open the same Brain in multiple tabs to view and edit multiple areas at a
time. This lets you view different areas of your Brain at the same time, and, if
you like, use a different layout in each tab. Note that tabs are simply views
into the same Brain data and changes made in one tab affect all other tabs of
that Brain.

= Duplicate Tabs. Right click on a brain tab to duplicate it, showing the same
content in a new Brain tab.
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Opening Content Associated with a Thought

As you navigate through your Brain, the content associated with the active
Thought is displayed in the Content Area. Notes associated with the Thought are
displayed automatically. There are several ways to open an attached file or web
page:

= Click on the tab for the attachment, then click the Open icon.
= Click on the attachment icon in the Plex.

= Right-click on the Thought, then click Open Attachment on the context
menu.

Showing Thought Content on Hover

By default, the content for the active Thought displays in the Content Area. If you
prefer, you can display content for any Thought your mouse pointer hovers over
by changing the setting. To do so, click the Options menu, click Preferences,
click the Ul tab, then select the “Update displayed content on hover” check box.
Close the Preferences window when you're finished.

Previewing Thought Content

Certain types of file attachments are automatically previewed inside of TheBrain.
These include web pages, images, text and PDFs. Simply click on an
attachment’s tab and its preview will be shown. In the example below, Tropical
Getaways is the active Thought and there are two attachments in the Content
Area—a Word document and an image. The tab for the image has been
selected.
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Figure 45. Content Area for the Active Thought
Pins

As you saw if you went along on the Guided Tour of TheBrain earlier, pins are
shortcuts to Thoughts to which you want quick access. They appear at the top of

the Plex, just below TheBrain toolbar. No matter where you are in your Brain, the
pins remain visible.

.> File Edit Thought View Options Online Window Help = O X
-
/E One Brain for It All | My Brain \ @ 5’ CQ)

"ﬁ&"AA‘ 7&*_‘.,/‘Thought|')|nS”

4 Personal Life  [7] My Work ] «—

o Go.als ofe Persor;al Life
o@dI'm Most. Ingerested In... o'y What I'm Th?nkgng About Now
o I\zy \‘Vork

Figure 46. Pins
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To create a pin:

* Right-click the Thought for which you want to create a pin, then click Create
Pin on the context menu

My Br.ain
d Goals Open in New Tab
o ] " .
! One Brain for It All | My Brain @ Open in New Window
3 Create Child
CARS Al Pins before .... ey
Create Jump
2 Personal Life [l My Work] SetType
< o Set Tags
~ Vacati... < Airlin
———— Add Attachment
Create Event
. . (1) Paste Ima
—1One Brain for It All | My Brain @® s
— Open Thought Folder
Select Stock |
< ﬁ '2 ‘ AA ‘ elect Stock Icon
Capture Image
) A Paste Icon
[_“ Personal Life | My Work | Goals ] =
Copy "Goals’
J Copy Local Thought URL
il after creatlng the new pln Copy Path to Thought's Folder
Duplicate Thought
Create Pin
Set ac Hoo Thoyoht

Figure 47. Creating Pins

To remove a pin:

» Right-click the pin or on a Thought that has a pin, then click Remove Pin on
the context menu

, Removing a pin does not remove or delete the associated Thought; it deletes
. only the reference to it at the top of the Plex.

To use a pin to link Thoughts:
= Drag from one of the Thought gates to the pin, or

= Move your mouse pointer over a pinned Thought and gates will appear; drag
from one of these gates to the Thought you want to link

Activating Recent Thoughts: The Past Thought List
TheBrain keeps a running breadcrumb trail of your Thoughts based on activation

and displays it in the Past Thought List. You can think of the Past Thought List as
the visual representation of the phrase, “train of thought”—a scrollable list of
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Thoughts in the order you activated them. The Past Thought List is displayed at
the bottom of the Plex window.

Clicking on any Thought in the Past Thought List activates that Thought. Also,
when a new Thought is created it appears in the Past Thought list immediately.

Scrolling arrows

[- <i i> i Tropical Vacati... "Airline Rewards...  {ii Jrban Travel J§ New York My Brain
w151

Figure 48. Past Thought List

The arrows located to the left of the Past Thought List enable scrolling to see
items that don't fit on the display.

The most recently activated Thought (the current active Thought) appears at the
right end of the list.

To use a Thought in the Past Thought List to link Thoughts:

= Drag from one of the Thought gates to one of the Thoughts in the Past
Thought List, or

= Move your mouse pointer over a Thought in the Past Thought List and gates
will appear; drag from one of these gates to the Thought you want to link
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In the example below, Tropical Vacations is going to become a parent of Airline
Rewards; the mouse is being dragged from the parent gate of Airline Rewards to
Tropical Vacations.

‘File Edit Thought View Options Online Help

| / =1One Brain for Everything | Goals @ c,’r IRAIN
4 A RS Aé ||

¢ Tropical Vacations)

—(é
<4 > ; : o A|rl|\r(rg%eward...

Figure 49. Creating a Link from the Past Thought List
Using the Back and Forward Buttons:

» |n addition to the Past Thought List, you can also use the Back and Forward
buttons, located near the top of the Window, to quickly retrace your steps;
these buttons work just like they do in a web browser

@TheBrain
File Edit Thought View Options

! One Brain for It All | Tropical Vacations

[<>ﬁ RS A A+dé

= Click the Back button to go back to the last active Thought

= Once you have clicked the Back button, the Forward button can be used to
re-activate the Thought you came from
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M Back and Forward Mouse Buttons: The back and forward buttons available on
some mice (typically on the left side of the mouse near where you place your thumb)
may be used to navigate backward and forward in your Brain. These mouse buttons
perform the same navigation as the Back and Forward buttons in the Brain toolbar,
shown above.

Searching Your Brain

Instant Activation

TheBrain includes powerful search capabilities. The Search box is in the top-right
area of the Plex.

, )
°|

Figure 50. The Search Box

The term “instant activation” refers to TheBrain’s ability to quickly find whatever
you’re searching for and activate the related Thought. You can easily scan the
search results as you type in the Search box. There's no need to click in the
Search box, your cursor is always there by default, unless you are actively typing
in the Notes tab or another field.

To activate one of these results, click it with your mouse or use the up-arrow,
down-arrow, page up, and page down keys on the keyboard then press the

Enter key.
S O
res ; o
6 matches [] Childward only |=
Thoughts, Links and Events
..... RO C N e
Restaurants
S Human Resources
= IT Resources
.+ Product Research
Notes and Internal Attachments tere
- U

Figure 51. Instant Activate Finds Matches Based on Thought Names,
Labels, Notes, and Attachments
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matches with the same name are found, the names of their parent or jump

, Accents are ignored when matching Thought names. Also, when two or more
: Thoughts are also displayed so you can differentiate them.

You can search for Thoughts by typing the first letter(s) of separate words and
the letters can be in any sequence; for example, to find the “Family and Friends”

Thought you could type “fa fr,” or “fr fa,” or “fa and fri.”
i’ ()

|fafr |'; o

[ ] Childward only | =

1 match

Thoughts, Links and Events

Figure 52. Use First Letters of Separate Words for Instant Activate

Attachments and Note search matches are identified with a yellow piece of paper
icon for Notes and a paper clip icon for Attachments.

mar

[] Childward only |=

A

14 matches

Market Trends
:_ Vice President of Marketing
& Target Markets
Online Marketing
Notes and Attachments
= 8 Increase Sales
=) - Territories
VIP Clients | 3
Marketing Events
Marketing Events.xlsx « Marketing Events
Marketing Events.docx « Marketing Events v

-
dit)

1
|

D

Figure 53. Search Results

When you do a search, the results are sorted with results that match Thought
names first, then notes, then attachments. Within the Thought name matches,

they are ranked in groups:
= Exact Matches—where the entire name of the thought matches the entire
query

= Starting Matches—where the entire query occurs at the start of the Thought
name
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= Continuous Matches—where the entire query occurs anywhere in the
Thought name

= Matches—where every term in the query occurs somewhere in the Thought
name

Within each group, Thoughts that have been activated in the last 30 days will be
shown first, ordered with the most recently activated first. Thoughts that have not
been activated within 30 days are sorted alphabetically.

Searching within Attachments

0) Pro

. Your searches automatically include matches based upon the contents of
attachments. If the text you're searching for exists within documents including
PDFs, Word, Excel, PowerPoint and many other file formats, the documents
containing the text will be found.

On Windows, TheBrain utilizes Windows Desktop Search to provide search
results to Brain notes and file attachments.

TheBrain integrates with Spotlight on macOS to provide search results from
within file attachments. No setup or additional steps are required to enable this
functionality.

Y
~ HR

For searches in TheBrain to return accurate results, Windows Desktop Search
or Spotlight will need to have access to the location where your Brains are
being stored. For more information on your Brain storage, see page 75.

.

Additional Search Functionality
Search now has several additional capabilities that are automatically enabled.
e External attachments are included in search results

e Search using automatic acronyms (ex. find "New York Stock Exchange"
by typing "nyse")

e Search for thoughts starting with punctuation. You may use this as a
shortcut to provide fast access to thoughts that you always start with a
certain type of punctuation. For example, you could use this for people
(@Mike, @Sally, @Debbie, etc.) or projects (#Ridgeline, #Palmdale,
#Westly, etc.)
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Figure 54. Search Finding External Attachments

50



Customizing Your Brain’s Environment

Customizing Your Brain’s Environment

You may choose to use your Brain just as it’s offered “out of the box” or you may
choose to change some of the environmental settings to suit your personal
preferences.

TheBrain’s Default Settings
Without making any changes, here’s what your Brain looks like:

= The area where your Thoughts appear (the Plex) will be the color and design

of one of TheBrain’s “Themes.” The initial theme is randomly selected and
you can change it at any time.

= The left half of TheBrain window will display your Thoughts and the right half
of the window will display the “Content Area” which holds Notes and any
other items you will attach to your Thoughts—files, web pages, Events, etc.

* Your Thoughts will be displayed in “Normal” view, meaning that you will see
only the direct parents, children, jumps, and siblings of the active Thought.

’) File Edit Thought View Options Online Window Help = =] X
G e
One Brain for Everything | My Brain ) :»:'
CARS A A+@ =Ns i °
4 Personal Life .z My Work Goals My Brain
Notes +
¢ My Brain
° d .
ol Goals o £ Personal Life
o/ ® ¢ ®
I'm Most Interested In... © What I'm Thinking About Now
K
*.a My Work
4
»
4 p> . Airline Re... f Urban Tra... Tropical V... | Goals My Brain @

Figure 55. TheBrain Window with Default Settings

Using Smart Splitter to Arrange TheBrain Window

The smart splitter controls let you manage where the Plex and Control Area
display relative to each other in TheBrain window.
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Figure 56. Smart Splitter

= Click the individual left- and right-arrows (or up- and down-arrows if the
window is in “over-and-under’” mode) to maximize the area the arrow is
pointing towards (either the Plex or the Content Area).

= Click the double-headed arrow icon to toggle the Plex to the right or left side
of the Content Area.

= Click on the two-arrow icon that forms a box to toggle between seeing the
Plex and Content Area "side-by-side" or “over-and-under.”

= You can also point at the border between areas and click and drag when the
double-headed arrow appears to move the border.

Moving Thoughts in the Plex

When the default settings are in use and the Plex is in “Normal” view, you can
move the Thoughts in the Plex up or down by dragging (up or down) in any blank
area of the Plex background.
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Figure 57. Dragging the Plex Vertically
Resizing the Thoughts in the Plex

The Plex is the heart and soul of TheBrain. You can change the size of Thoughts
in the Plex by using TheBrain toolbar or your keyboard and mouse.

To change the size of Thoughts using the toolbar:

Click the AA button to activate the slider, then click and slide the bar up or
down to grow or shrink the size of your Thoughts.
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Figure 58. Resizing Thought Size with the Slider
To change the size of Thoughts using the keyboard, mouse, or trackpad:

= Hold Cmd (Mac)/Ctrl (PC) on your keyboard and scroll up or down on your
mouse wheel or trackpad while your mouse pointer is in the Plex.

1

Ctrl = / 2 <} + or V1

Figure 59. Resizing with the Mouse or Trackpad

= Hold Cmd (Mac)/Ctrl (PC) on your keyboard and press - to make Thoughts
smaller or + to make Thoughts larger.

+ |- Jor|l

Ctrl = / ¥ e

Figure 60. Resizing with the Keyboard
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= Pinch to zoom on a Mac Trackpad.

LARGER SMALLER

Figure 61. Resizing on a Trackpad
Customizing Your Brain’s Appearance

Selecting a Theme

The Themes feature lets you choose from many built-in designs to customize the
look of your Brain, including the appearance of the Plex and Notes in the Content
Area. You can change many of the default colors and the style of Notes
associated with the Theme, then save the look of your Brain as a new Theme.
This lets you quickly switch from one saved Theme to another.
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Figure 62. Sample Themes
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To select a Theme:

1. Ether click the Options menu in TheBrain toolbar or right-click any blank
space in the Plex.

2. Click the Brain Theme command.
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Figure 63. Accessing the Brain Theme Window

In the Brain Theme window, you’ll see a scrollable list of available themes in the
left panel and Colors and Options tabs in the right panel. Click on any Theme to
see how it looks in the Plex.

€2 Brain Theme X

Themes Colors ( Options

- Classic Dark Blue (o)

- Light Blue Default

O Background, center
O Background, top and bottom

# 20 Years
# 20 Years-Light
# Brain Animals

# Brain Animals-Light

# Cold Ocean
# Dark Garden

@ Thoughts, text

© Thoughts, text shadow
O Thoughts, background
@ Highlighted Thoughts

# Brain Waves 1 ® Links
# Brain Waves 2 @ Highlighted Links
# Brain Waves 3 ® Gates

@ Highlighted Gates
@ Active Thought, outline

TheBrain 10 User Guide

Figure 64. The Brain Theme Window
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Customizing a Theme’s Colors

Have the Brain Theme window open when you want to customize a Theme
(right-click a blank area of the Plex, then click the Brain Theme command).

The default colors for virtually all items in the Plex vary based on the selected
Theme. The current color for each item is shown in the circle to the left of the
item’s description. Scroll through the list in the Colors tab to get an idea of all of

the items that can be changed.

To change the colors in the selected Theme:

1. Click the item whose color you want to change to display your choices.

P
ol Goals
, [ Y
of I'm Mostln'gerest
A ®
°.g My Work

Delete

@ Brain Theme

X

Themes Colors ( Options

- Classic Dark Blue O Background, center

- Light Blue Default O Background, top and bottom

# 20 Years @ Thoughts, text

# 20 Years-Light © Thoughts, text shadow

# Brain Animals O Thoughts, background

# Brain Animals-Light @ Highlighted Thoughts

# Brain Waves 1 | %Links

# Brain Waves 2 M Highlighted Links

# Brain Waves 3

# Cold Ocean

# Dark Garden utline

Figure 65. Color Choices in the Colors Tab

2. Click the color of your choice, then click outside of the box of colors to close

it.
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Ol Goals Themes Colors ( Options
¢/ ® ;
of" I'm Most InEereSted In Custom Settings O Background, center
s 29 - Classic Dark Blue © Background, top and bottom
e.g My Work
® - Light Blue Default @ Thoughts, text

# 20 Years © Thoughts, text shadow
# 20 Years-Light O Thoughts, background
# Brain Animals @ Highlighted Thoughts
# Brain Animals-Light @ Links
# Brain Waves 1 M Highlighted Links

# Brain Waves 2

# Brain Waves 3
utline

# Cold Ocean

. Custom

Figure 66. New Selected Color for Links

Note that while you can change the color of the shadow for Thought text using
the theme’s Color tab settings, you can toggle whether or not text shadows
are displayed using the Look & Feel tab of the Preferences window (as
explained in the Look & Feel Preferences section on page 71). By default, text
shadows are displayed.

When you are happy with your color selections, click the close button (X) in the
Brain Theme window.

Defining and Selecting Additional Colors

You can add additional customized colors if you don’t see the exact shade you
want.

1. Inthe color selection box, click the color that’s closest to what you want,
then click the box next to “Custom,” then click the Define Custom Colors

button.
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Default

@ Thoughts, text
M Thoughts, text sha

ght

Custom

(11 FANNENE
1] HEEENT

Ve

Define Custom Colors >>

ook | Cancell

2. The Color window will expand to provide a slider to fine-tune the shade.
You can also select a different color and fine-tune it or type in specific RGB
or HSL numbers. Click the Add to Custom Colors button when you’re
happy with the sample color, then click the OK button.

Color X
E EECEEN <
H MEFEENE

ERENEENEE

HTMEAEEEEN

EEEEEEEE

EEEENEN

EEEEEEEE =
EEEEEEEE wall

] | Lcoorisoid )y ump17 Bue: 55~
OK Cancel ’ Add to Custom Colors HI

Selecting a Custom Image for the Plex

If you want to use an image of your own instead of using one in the Themes list
of the Brain Theme window, it's very easy to do so.

To select your own background image:

1. Click the Options tab in the Brain Theme window, then click the
Wallpaper check box.

TheBrain 10 User Guide
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@ ‘

Themes Colors [ ) Options ]

Custom Settings f Plex

- Classic Dark Blue

- Light Blue Default

# 20 Years Font | Helvetica 4
# 20 Years-Light

# Brain Animals Notes

# Brain Animals-Light Style | Modern ¥

# Brain Waves 1
# Brain Waves 2

# Brain Waves 3

# Cold Ocean

Figure 67. Options Tab in the Brain Theme Window

2. Inthe Select image file as the wallpaper window, navigate to the location
of your image file, click on it, and then click the Open button. Supported
wallpaper file formats include .jpg, .gif, and .png.

3. Click the close button (X) in the Brain Theme window to save your new
image for the Plex.

To replace or remove a wallpaper image:

= Toreplace the image, click the Select button next to the Wallpaper check
box to navigate to a different image.

= Toremove the image, click the Wallpaper check box to toggle off the check
mark and remove the image from the Plex.

TheBrain 10 User Guide 60



Customizing Your Brain’s Environment

Colors / Options
Plex
allpape
Font | Helvetica X
Notes

Style | Modern v

Figure 68. Replacing or Removing Wallpaper
To dynamically select new Wallpaper from a web site:

1. Go to a web site that offers Wallpaper files, right-click the design of your
choice, then select Copy on the context menu.

2. Return to your Brain, right-click in any blank area of the Plex, then select
Paste Wallpaper on the context menu.

Paste Image

Paste Wallpaper N

Arrange Thoughts by 4
Layout ’
Expand All Ctrl+0

Collapse All
Report

Timeline

Brain Theme...

o

Figure 69. Context Menu on the Plex

Changing the Default Text Font in the Plex

By default, the font for text that appears in the Plex is Helvetica. You can change
it to any font installed on your machine:

1. Click the Options tab in the Brain Theme window, then click the drop-
down button for Font.
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) Brain Theme X
Themes Colors ) Options
Custom Settings Plex
- Classic Dark Blue [] Wallpaper
- Light Blue Default
# 20 Years Font | Helvetica M
# 20 Years-Light Colonna MT
# Brain Animals Notes | Comic Sans MS N
# Brain Animals-Light Style | Consolas =
# Brain Waves 1 Constantia

# Brain Waves 2 Cooper Black

# Brain Waves 3
# Cold Ocean

Copperplate Gothic Bold
Copperplate Gothic Light
Corbel

Courier New
Sove T o f [Bwor]
| DengXian

DengXian Light
DFKai-SB
Dotum
DotumChe

Figure 70. Changing the Font for Plex Text

2. Click the font of your choice. You will see the text in the Plex update
automatically.

Changing the Default Notes Style

By default, the Notes in the Content Area of your Brains appear in a style called
“Modern,” which is a sleek and clear combination of font, color, and size.

To select a different style for Notes:

1. Click the drop-down button for Style on the Options tab in the Brain
Theme window.
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€2 Brain Theme X
Themes Colors ) Options
Custom Settings Plex
- Classic Dark Blue [] Wallpaper
- Light Blue Default
# 20 Years Font | Helvetica v
# 20 Years-Light
# Brain Animals Notes
# Brain Animals-Light Style | Modern ‘1\
# Brain Waves 1 Modern
# Brain Waves 2 Classic
# Brain Waves 3 Codex
# Cold Ocean a Console
Dark
DelRey
Draft
Custom

Figure 71. Changing the Style of Notes

If you have a Note visible in the window, you will see the appearance of the text
change as you click each Style option.

2. Optionally, you can select “Custom” in the drop-down Style list and then on
the Options tab in the Brain Theme window. This provides additional
options:

/ Colors ) Options
Plex

[[] Wallpaper

Font L Helvetica il

Notes

Style Custom Vv |

Font (Default) v

Base Style | Modern ¥ ET

Figure 72. Custom Note Style Options
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Do this ...

Select a different font
for Notes

Click the drop-down button for the Font field and
select from any installed font

Select a different Base
Style for Notes

Click the drop-down button for the Base Style field
and select any of the styles in the list

Swap background
color with text color for
Notes

Click the double-headed arrow next to the two

boxes
-

Base Style | Modern v

.-

Change either the text
color or background
color for Notes

Click either box, then click a new color in the palette;
click outside of the palette to close it

Base Style | Modern v q

3. When you are happy with your Notes choices, click the close button (X) in
the Brain Theme window to save your new Notes styles, which are applied

immediately.

Reverting to the Original Theme’s Default Settings

As soon as you make any changes to a Theme, “Custom Settings” will be
selected in the Themes list.

Colors Options
Plex

[] Wallpaper

Font | Helvetica b
Notes

Style | Custom v

Font | (Default) V.

< et
Base Style | Modern

Figure 73. Custom Settings Indicator

To switch back to the original settings for any Theme, select the Theme name in
the Themes list within the Brain Theme window.
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Saving Themes

1. Make sure the tab with the Brain that has the Theme you want to save is
active in the Plex.

2. Unless the Brain Theme window is already open, either click the Brain
Theme command on the Options menu or right-click a blank area of the
Plex, then click the Brain Theme command.

3. Click the Save Theme button, then type a hame for your new theme in the

field.
o

Themes Colors ( Options
Custom Settings O Background, center
- Classic Dark Blue O Background, top and bottom
- Light Blue Default @ Thoughts, text
# 20 Years © Thoughts, text shadow
# 20 Years-Light O Thoughts, background
# Brain Animals @ Highlighted Thoughts
# Brain Animals-Light @ Links
# Brain Waves 1 @ EovaiTheme X
# Brain Waves 2
# Brain Waves 3 [My ew Theme| I
# Cold Ocean I OK !}J l Cancel I I

Figure 74. Save a Theme

4. Click the OK button. Your new Theme will be inserted into the list of
Themes, ready for use in your other Brains.
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@ Brain Theme

Themes

# Mist Covered Mountains *
# Mystic Lake

# Painted Sky

# Polygon Gray

# Relaxed Ocean

# To the Woods

Dark Gray

Dream Logic

Light Gray

My New Theme %

Purple Prince 24

/ Colors

O Background, center

O Background, top and bottom
@ Thoughts, text

© Thoughts, text shadow

O Thoughts, background

@ Highlighted Thoughts

@ Links

@ Highlighted Links

® Gates

@ Highlighted Gates

@ Active Thought, outline v

¢ Options

Figure 75. Newly Saved Theme in the Themes List

Renaming a Theme

1. Inthe Brain Theme window, click the Theme you want to rename, then

click the Rename button.

2. Type or revise the current name, then click the OK button (or press the

Enter key).

@ Brain Theme

Themes

# Mist Covered Mountains »
# Mystic Lake

# Painted Sky

# Polygon Gray

Colors

O Background, center

O Background, top and bottom
@ Thoughts, text

© Thoughts, text shadow

\ bptions

Fename] [t

# Relaxed Ocean ]
£ Rename the Selected Theme X
# To the Woods
Dark Gray |MY New Themei ]
Dream Logic I OK | | Cancel l
Light Gray W Gartes
My New Theme @ Highlighted Gates
Purple Prince v @ Active Thought, outline v

Figure 76. Renaming a Theme
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3. Click the close button to close the Brain Theme window.

Deleting a Theme

1. Inthe Brain Theme window, click the Theme you want to delete, then click
the Delete button.

@ Brain Theme

Themes

# Mist Covered Mountains *
# Mystic Lake
# Painted Sky

# Palvoon Grav -
# F@ Delete Theme X

#1
Da
Dr
Light Gray

This theme will be deleted. Are you sure?

Delete ;\L [ Cancel
R

My New Theme Favorite

Purple Prince

Figure 77. Deleting a Theme

2. Click the Delete button to confirm that you’re sure you want to delete the
Theme.

3. Click the close button to close the Brain Theme window.
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Importing and Exporting Themes

€2 Brain Theme X
Themes Colors ( Options
- Classic Dark Blue O Background, center
- Light Blue Default O Background, top and bottom
# 20 Years @ Thoughts, text
# 20 Years-Light © Thoughts, text shadow
# Brain Animals O Thoughts, background
# Brain Animals-Light @ Highlighted Thoughts
# Brain Waves 1 @ Links
# Brain Waves 2 @ Highlighted Links
# Brain Waves 3 ® Gates
# Cold Ocean @ Highlighted Gates
# Dark Garden @ Active Thought, outline

Figure 78. Importing or Exporting a Theme
To import a Theme:

= Click the Import button, navigate to the location of the Theme you want to
import, select it, then click the Open button.

To export a Theme:
= Make sure the Theme you want to export is in the active Brain tab.

= Click the Export button, navigate to the location where you want to save the
Theme, then click the Save button.

= Click OK in the confirmation box.

Dark Mode
The all new Dark Mode changes the windows, menus, icons and other user
interface elements to be predominantly dark grey. Dark Mode allows you to focus
on your work with subtle colors fewer distractions.

e To switch to Dark Mode, open Preferences to the Look and Feel tab.
Select Dark under the User Interface setting.

e The Brain will be restarted to apply the change

TheBrain 10 User Guide 68



Customizing Your Brain’s Environment

Ronan | Ronan Howard, Architect

fR2e @&
1 Ronan Howard, Architect ~Willa House # Johnson Landscaping Ronan Howai

Notes B Ronan Howard, Architect.xisx +

Howard + Partners Inc.

.
¢ Architect 11522 W. Washington Blvd.
Scottsdale, AZ 85251

P 480.751.5000

( www.howardparntersinc.com @

+ Ronan Howard, A...
—B

Weekend ...
° A S el SEY

o) Pers.onal
o, Refe;ence

OInfluerlces

@R -vila Hou.. =sEitonPark LosAngele.. LosAngeles Weekend P.. 1 Ronan H...

Figure 79. TheBrain in Dark Mode

¢ You may want to modify your Brain Theme to compliment the darker
interface and tones

Setting Other Preferences

TheBrain’s Preferences dialog box is where you’ll find many of the settings for
adjusting how your Brain works, both mechanically and visually. Preference
settings affect how TheBrain works globally—no matter which Brain is open
when you make your choices.

To open the Preferences dialog box:

* Click the Options menu, then click the Preferences command (on macOS,
the Preferences command is located in the TheBrain menu)
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a

>

30 %

My Brain

.> File Edit Thought View | Options | Online Window Help
/) One Brain for Everything | My E Arrange Thoughts by .
Web Search F4
O AR A R |
Show Forgotten Thoughts
APersonal Life  gMy Work | Hide Private Thoughts
Wander "Nutes +
Brain Theme...
Preferences.. Ctrl+,
Ly
Show TheBrain Preferences window |
¢ My Brain
N
N~
—————— T
~ \‘
o] Go.als o Persorlal Life
o/ ®
] 1 : H
of" I'm Most Interested In... o What I'm Thinking Ab...
® [
°.B My Work
®
{
>
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!q > . Airline Rewar... | Tropical Vacati... giTravel Z=Retiringat50 | Goals My Brain;J

Figure 80. Accessing Preferences

TheBrain Preferences are organized into these categories:

= Look & Feel
= Ul

= System

=  Keyboard

TheBrain 10 User Guide
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@ Preferences

Look & Feel \ Behavior

User Interface
[[] compact window title bar

Theme

Animation
Speed: Fast

Wander Delay: Short (0s)

Thoughts

Spacing: Narrow

Tags text

Tags icons

Text shadows

Links
Curved links

Timeline

[[] Sshow notes and events indicators
Show siblings in normal view
Context sensitive Thought names
[] show label for active Thought

Always show Thought or link name on events

) System /| Keyboard

Light v

Slow

Long (20s)

Wide

Show on hover

Show always ¥

Figure 81. Look & Feel Preferences

Animation

Preference

Description

Compact Window Title Bar

Moves the File, Edit, Thought, View, etc.
menu items up into the frame of the app.

Theme

Switch between Light and Dark Mode.

Speed

Drag the slider right to reduce or left to
increase the speed with which a Thought
becomes active when you click it in the Plex.

Wander Delay

Wandering is an option to step randomly
through TheBrain, to let you see Thought
associations. Drag the slider to specify the
amount of delay between Thought
activations. The delay is shortest by default.

TheBrain 10 User Guide
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Thoughts

Preference Description

Spacing Drag the slider to decrease or increase
space between Thoughts. The wider the
spacing, the larger and more spaced out the
Thoughts will be.

Tags text You can choose to never show, always
show, or only show Tag text on hover
(mouseover).

Tags icons You can choose to never show, always

show, or only show Tag icons on hover
(mouseover).

Show notes and events
indicators

Note and event icons will appear in the
bottom-right area of thoughts that include
Notes and/or events. This preference is off
by default.

Show siblings in normal

This preference is on by default.

view
Context sensitive Thought Context sensitive Thought names are
names explained on page 86. This preference is on

by default.

Show label for active
Thought

This preference is off by default.

Text shadows

This preference is on by default.

Links

Preference

Description

Curved Lines

When selected, links will be curved lines and
when not selected, links will be straight lines.
This preference is on by default.

Timeline

Preference

Description

Always show Thought or
link name on events

This preference is on by default.

TheBrain 10 User Guide
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Behavior Preferences

@ Preferences X
/ Look & Feel ) Behavior | System ) Keyboard
Thoughts
On click active Thought: Open Properties ¥

Custom Thought Context Menu Toggle Commands

Automatically capitalize Thoughts on creation
[C] Activate last created Thought
Download Icons for Attached Email Addresses from Gravatar

Content
On drag and drop of files: Copy dropped files ¥
Content tab location: Top v
For new notes, Enter inserts a: Single line break ~

[[] Update displayed content on hover
[] Show details when selecting attachment to open
Embedded browser for web links
[] Show attachments as a list
[] Use compact toolbars for Notes
Replace URL with page title in Notes on paste
Custom date/time format for Notes ?
dddd, MMMM dd, yyyy HH:mm tt Thursday, March 07, 2019 13:55 PM

Other
Maximize on double-click of plex background or content tab background
[] calendar week starts on Monday

Figure 82. Behavior Preferences

Thoughts

Preference Description

On click active Thought By default, the Thought’s properties will
display when the active Thought is clicked.
The other option is to do nothing.

Custom Thought Context Click on Toggle Commands and uncheck

Menu options that you would like to have hidden.

Automatically capitalize The first letter of the name of the Thought will

Thoughts on creation be automatically capitalized. This preference

is on by default.
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Description

Activate last created
Thought

A Thought will become the active Thought as
soon as it’s created. This preference is off by
default.

Download Icons for
Attached Email Addresses
from Gravatar

This preference is on by default.

Content

Preference

Description

On drag and drop of files

By default, files will be copied when dragged
and dropped. The other options are that they
will be either moved or linked.

Content tab location

The Content tab location is automatic by
default. The other options are to the left and
at the top. This applies to the tabs in the
Content Area, not the Content Area itself.

Update displayed content
on hover

This preference is off by default.

Show details when
selecting attachment to

This preference is off by default.

open
Embedded browser for web  Web content will appear in TheBrain’s built-in
links browser. This preference is on by default.

Show attachments as a list

Attachments will show in the same area
instead of on separate tabs within the
Content Area. This preference is off by
default.

Use compact toolbars for
Notes

This preference is on by default.

Replace URL with page title
in Notes on paste

This preference is on by default.

Custom date/time format for

When this preference is selected, you can

Notes enter a different syntax for how dates and
times are displayed. The default date and
time format is: yyyy/MM/dd HH:mm

Other
Preference Description

Maximize on double-click of
Plex background or content
tab background

Double-clicking either the Plex or Content
Area background will maximize that part of
the Brain and the other part will be hidden.
This preference is off by default.
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Preference Description
Calendar week starts on This preference is off by default and the
Monday Calendar week starts on Sunday.

System Preferences

&2 Preferences X
Look & Feel \ Behavior ‘Iv" System ‘ \ Keyboard
Updates
Check for updates on startup: Always v
Update channel: v

Localization

Interface Language English (United States) “
Spelling Dictionary English (United States) i
Storage

Brain data is stored in the following location. WARNING: Do not set this to a
network share or to removable media such as a USB drive. Doing so will
result in data corruption.

C:\Users\TheBrain\Brains Select Folder

Use default working directory for Import and Sync.

C:\Users\TheBrain\BrnTmp Select Folder

Proxy Settings
[[] use proxy server

Proxy server requires authentication

Figure 83. System Preferences

Updates
Preference Description
Check for updates on Notification of updates on startup. Always,
startup Only free updates or Never.
Update Channel This preference affects which kind of updates

you'll see as available when you click the
Check for Update command on TheBrain’s
Help menu. The default is Stable and the
other choices are Beta and Alpha.
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Description

Interface Language

The default is Automatic.

Spelling Dictionary

The default is Automatic and there are many
other languages to choose from in the drop-
down list. After you select another language,
you'll be prompted to exit TheBrain and
restart so that your change can take effect.

Storage
Preference Description
Storage The location of your Brain data.

Proxy Settings

Preference

Description

Use proxy server and proxy
server requires
authentication

If you are unable to synchronize your Brain
with TheBrain Cloud due to a proxy server or
restricted ports on your network, the Proxy
settings can be used to customize the
synchronization process. Check with your
network administrator for the appropriate
information for these fields. By default, the
Use proxy server preference is off.

Keyboard Preferences

Most Brain commands can be accessed by keyboard commands, which you can
customize based on your preferences. You can even export your settings to
share them with others or to transfer them from one computer to another.
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@ Preferences

Look & Feel \ Behavior ] System / Keyboard

W Application
About
Check for Update
Exit Alt+F4
Hide Others
Hide TheBrain
Manage Endpoints...
Perform Data Integrity Scan
Preferences... Ctrl+,
Show Account Info
Show All
Show Tips
Tutorials
Upgrade Services

WV Attachments
Add Attachment
Copy
Copy in or out of Brain
Copy to Icon
Cut

Palata

| Expand All | | Collapse All

Figure 84. Keyboard Preferences
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Using the Keyboard Preferences Tab

To do this ... Do this ...

Find a command quickly Begin typing the command in the Search
commands field in the bottom-left corner of the
Keyboard tab of the Preferences window.

a4

WV Attachments
Add Attachment ‘

Copy
Copy in or out of Brain ‘

Copy to Icon
Cut ‘

Dalai

] l Expand All I I Collapse AHI

N

As you type, the list will shorten to match what
you’ve typed. When you see the command
you’re looking for, note its shortcut or click it to
define a new shortcut.

Collapse the list to see Click the Collapse All button.

only major headings o
WV Attachments

Add Attachment ‘

Copy
Copy in or out of Brain ‘

Copy to Icon
Cut ‘

Dalai

| Expand All I I Collapse All |

You can also collapse an individual heading,
for example “Application,” to collapse or
expand just that section.

Restore the full list Click the Expand All button.
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P> Application
P> Attachments
P> Brain

P Edit

P> Link

P> Navigation
P Notes

P> Options

P> Report

P> Selection

P Thought

P Thought Icon
P Timeline

P View

P Window

I Expand All |  Collapse All:

To do this ...

Do this ...

Import shortcuts

Click the menu in the bottom-right corner of
the Keyboard tab, then click the Import
Shortcuts command.

Export shortcuts

Click the menu in the bottom-right corner of
the Keyboard tab, click the Export
Shortcuts command, select a location for the
file, then click the OK button. The file will be
named “KeyboardShortcuts.txt.”

Restore default shortcuts

Click the menu in the bottom-right corner of
the Keyboard tab, then click the Restore
Defaults command.

Next Brain Tab

Next Content Tab
Previous Brain Tab
Previous Content Tab
Rotate Splitter
Splitter Left or Up
Splitter Right or Down
Swap Splitter Panes

Ctri+1ab
Ctrl+Q
Shift+Ctrl+Tab
Shift+Ctrl+Q
Shift+Ctrl+D
Shift+Ctrl+A
Shift+Ctrl+S

Expand All | [ Collapse All I @L&

Import Shortcuts

Export Shortcuts

Restore Defaults
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To define a new shortcut:

1. Inthe left column, click the command for which you want to create a shortcut.
The row containing the command will be highlighted and an instruction will
appear under the Preferences tabs.

2 Preferences X

Look & Feel (Ul / System / Keyboard

[ Type keyboard shortcut. Esc to cancel. Delete to remove. ]

heck for ar

WV Application
About
Exit F4
Hide Others
Hide TheBrain

Alt+

Figure 85. Creating a New Shortcut

2. Click on the command of your choice in the left column, then press the
function key or keyboard combination of your choice. For example, you might
choose to assign the “Check for Update” command to Ctrl+Shift+U.

You can’t assign keys that are already used for common operations (such as
Ctrl-C) nor can you use letter or number keys by themselves.

(3

Your new shortcut will display in the list. You can delete the shortcut by pressing
the Delete key while the command is highlighted.

WV Application
About [
[ Check for Update _ Shift+Ctrl+U ]
Exit ' Alt+F4
Hide Others

Figure 86. The New Shortcut in the List

]| |
Bl Default Shortcuts for Windows

Application Commands Shortcut
Exit Alt+F4
Preferences Ctrl+,

TheBrain 10 User Guide 80



Customizing Your Brain’s Environment

Edit Commands Shortcut
Copy Ctrl+C
Cut Ctrl+X
Paste Ctrl+Vv
Paste and Match Format Shift+Ctrl+V
Redo Ctrl+Y
Select All Ctrl+A
Undo Ctrl+zZ
Navigation Commands Shortcut
Activate Tag Ctrl+G
Activate Type Ctrl+E
Backward Shift+Ctrl+Left
Expand/Collapse Current Thought Space
Forward Shift+Ctrl+Right
Navigate Down Down
Navigate Enter Enter
Navigate Escape Esc
Navigate Left Left
Navigate Right Right
Navigate to Pin 1 Ctrl+1
Navigate to Pin 2 Ctrl+2
Navigate to Pin 3 Ctrl+3
Navigate to Pin 4 Ctrl+4
Navigate to Pin 5 Ctrl+5
Navigate to Pin 6 Ctrl+6
Navigate to Pin 7 Ctrl+7
Navigate to Pin 8 Ctrl+8
Navigate Up Up
Notes Commands Shortcut
Find & Replace Ctrl+F
Insert Date/Time Ctrl+D
Open in Browser Ctrl+O
Print Ctrl+P

TheBrain 10 User Guide
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Notes Commands Shortcut
Toggle Bold Formatting Ctrl+B
Toggle Italic Formatting Ctrl+l
Toggle Underline Formatting Ctrl+U
Options Commands Shortcut
Web Search F4

Thought Commands Shortcut
Create Child F6

Create Jump F8

Create Parent F7

Forget Ctrl+Del
Open Attachment Ctrl+O
Open Folder Shift+Ctrl+F
Show Thought Properties Ctrl+Enter
Thought Icon Commands Shortcut
Select Stock Icon Alt+Ctrl+l
View Commands Shortcut
Collapse All Ctrl+9
Expand All Ctrl+0
Expanded Shift+Ctrl+4
Mind Map Shift+Ctrl+3
Normal Shift+Ctrl+1
Outline Shift+Ctrl+2
Zoom In Ctrl+=
Zoom Out Ctrl+-
Window Commands Shortcut
Close Tab Ctrl+wW
Keyboard Focus to Notes Ctrl+N
Keyboard Focus to Search Ctrl+S

New Tab Ctrl+T

New Window Shift+Ctrl+N
Next Brain Tab Ctrl+Tab
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Window Commands

Shortcut

Next Content Tab

Ctrl+Q

Previous Brain Tab

Shift+Ctrl+Tab

Previous Content Tab

Shift+Ctrl+Q

Rotate Splitter

Shift+Ctrl+D

Splitter Left or Up

Shift+Ctrl+A

Splitter Right or Down

Shift+Ctrl+S

s

. Default Shortcuts for macOS

Create Child

Alt+Command+Down

Create Parent

Alt+Command+Up

Create Jump

Alt+Command+Left

Rename Alt+Enter
Focus on Plex Cmd+S
Focus on Notes Cmd+N
Search Web Cmd+E
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Creating Thoughts

Creating a Single Thought

There are many ways to create a Thought, but most start with the same step—
choosing the Thought with which the new Thought will have a relationship. You
will use the chosen Thought as a starting place when creating the new Thought.

Generally speaking, you'll create child Thoughts more often than parents or
jumps. There are certainly exceptions, but usually, using a “top-down” approach
is helpful if you are just getting started: Create children (and jumps, as
appropriate) and let parents happen naturally.

Once you have activated the Thought that will have a relationship with your new
Thought, use any of these techniques to begin creating a new Thought:

= Drag from the Thought’s parent, child, or jump gate

Drag up from
Drag left from here to create a
here to create parent Thought

ajump
Thought
—> - Drag down from

W¥___——here to create a
parent Thought

Figure 87. Gates to Drag for Creating Thoughts

= Or click the Thought menu, then click the Create Child, Create Parent, or
Create Jump command

File Edit | Thought | View Options Online H

= One ﬂ‘l Create Child 6
Create R3ront =
f } Cicsite Crelate a child Thought |,

A3 |

= Or, right-click the Thought, then click the Create Child, Create Parent, or
Create Jump command
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—
o JCustomer ...
. Open in New Tab
¢ Clients b
; Open in New Window
| CreateChild |\ F6

Create Parent E7
Create a child Thought

Create Jump

= Or use a keyboard shortcut:

mll On Windows, press the F6 key (for a child Thought), F7 (for a parent
L[| Thought), or F8 (for a jump Thought)

#_ On macOS, press the Option+Cmd+Down Arrow (for a child
‘ Thought), Option+Cmd+Up Arrow (for a parent Thought), or
Option+Cmd+Left Arrow (for a jump Thought)

No matter which of the above methods you use to begin creating your new
Thought, the next thing you’ll see is the Thought Creation dialog box with the
cursor blinking in the field for typing in the name of your new Thought.

| J :
Type a Thought

name here

xvZ & |

I Type | [ Tags ]

Figure 88. Thought Creation Dialog Box
1. Type the name of your new Thought in the field provided.

2. Press the Enter key or click in a blank area of the Plex to save your new
Thought (or press the Esc key to cancel the process and close the box).

Automatic initial-capitalization: If you type a Thought name using all
lowercase letters, the first letters of words will be capitalized for you
automatically. TheBrain uses “smart rules” to determine which words should be
\/ lowercase (such as “a,” “and,” and “of”). For example, if you’ve typed “visit the
: statue of liberty” the Thought name will automatically become “Visit the Statue
of Liberty.” This feature is active, by default, but you can turn it off in the Ul tab
of the Preferences dialog box.

Creating Multiple Thoughts at Once

TheBrain offers a timesaver (affectionately known as the “semi-colon trick”) for
creating more than one Thought at a time.
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= Type a semicolon (;) to separate multiple Thought names in the Thought
Creation dialog box

{ABC;Best YetCo;New Guys;TriedNTru |

[ Type ] [ Tags l
l BN
4 new ¢m Clients) 5@ 0p
children — — Pyt
created at the ' |
same time

&@ =)
oABC oNew %uys

o Besz Y%tCo OTrie.d I\(J)Tru

Figure 89. Creating Multiple Thoughts

Creating Context-Sensitive Thought Names Using Commas

It's always good to be specific with your Thought names. TheBrain has some
time savers to help you if you have repetitive information that needs to be added
to your Brain. For example, say you have Thoughts for each of your clients, each
of whom has a billing department. You’d like a child Thought named “Billing Info”
for each of your client Thoughts. However, you may not want to have identical
Thought names because when you see these Thoughts later you won'’t be able
to tell them apart without looking at their parents.

To remedy this potential dilemma, when you type the name of the new Thought,
start or end the name with a comma. The parent Thought name will be added
automatically. When this Thought is displayed, its name will vary depending on
the context in which it’'s viewed. If the client Thought is active, the client’'s name
will be hidden and it will appear as just “Billing Info.” But when you activate this
Thought, the full name along with the client’s name will appear.
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comma

G}iilling Info % _ |
When this is &fitered .. — i :I

.. it appears as this

®
oNew @ys

-~

@
= o oNew Guys
New Guys oB||||ng/!nfO ’ :

.. except when the

e it 5 . Thought is active
New Guys, Bill Inf
. ’ ew Guys, Billing In oﬁ : E‘

Actual name in {New Guy? Billing Info]
]hought Propertles v -

Modified:  Today, 8:32:59 AM
Created: Today, 8:32:59 AM
1D: 33f4d395-0d70-4bc1-9a8b-65a4e687362e

Figure 90. Sub-Category Thoughts

The Thought will display its full name when it is active. When its parent Thought
is active, you'll see only the portion of the name that does not repeat the parent’s
name. Ensuring that each of your Thoughts has a unique name will help you find
and identify them more easily.

Tip: The part of the Thought’s name that is hidden is context sensitive.
Say for example that you wanted to have a single place to see the billing
information for all your clients. You might create a Thought called “Billing Info”
and then link to the billing information Thoughts for each of your clients, such as
“‘NewGuys, Billing Info.” If you do this, when Billing Info is active “NewGuys,
Billing Info” will appear as just “NewGuys,” whereas when NewGuys is active,
that same Thought will appear as Billing Info. Try it—you’ll see how this can be
very useful.

Creating Orphan Thoughts

When you create a Thought in your Brain, you usually first decide what
relationship it will have with an existing Thought, but sometimes you just want to
create something without making a relationship.

To create a Thought independently of other Thoughts, type into the Search box
and click the lightning bolt icon. This works well especially when you are looking
for something and discover you haven’t yet put it into your Brain. When no
search results appear, you can just click the icon to add it to your Brain without
having to retype it.
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Dptions  Online  Window Help

Y

Q

&

One Brain for Everything | TriedNTru

& + & Talent Express o

¢ | Goals 0 matches [ Childward only S 2Z=] TriedNTru
Notes +

A

e
oM Clients
9

Talent Express /

¢ Tried NTru

ONew Guys
® [ ]
oZenith

(o]

Figure 91. Creating an Orphan Thought

Changing the Display Order of Thoughts

You can use TheBrain’s hidden ordering system to change the default
alphabetical ordering of Thoughts in the Plex to any order you prefer. To do this,
type a period and a number as the first characters of any Thought name. These
characters will not be displayed in the Plex. For example, try creating the
following group of child Thoughts in one area:

e .01 Zebra
e .02 Walrus
e .03 Aardvark
The Thoughts will appear in the order of Zebra, Walrus, Aardvark (without the

periods or numbers), rather than alphabetically. You can always delete or revise
the numbers in the Thought Properties dialog box.
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|
il —% Before inserting
fNew Petaldeas] hidden numbers

{Nmet_ldeas]

= Z’ebga
After inserting 5| \Walrus
hidden numbers _ q

A.a rdvark

Figure 92. Changing Thought Order

Copying Thoughts Within and Between Brains

Thoughts, including all of their notes, properties, events, and attachments, can
be copied and pasted between Brains or duplicated within a Brain. When
Thoughts are copied, associated Thought types and link types are automatically
copied as well.

To copy a Thought within the same Brain:

1. Right-click the Thought to be copied and then click the Copy “name of
Thought” command on the context menu.
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° :.Food

Or

ginal Thoughtj%

I
Ky <€ Restaurants

My Brain  4# Personal

Open
Open

in New Tab

in New Window

Create Child

Create Parent

Create Jump

Set Type

Set Tags

Add Attachment

Create Event

Paste

Open

Image
Thought Folder

Select Stock Icon

Capture Image

Paste

Icon

Copy

" Restaurants",\

Copy

Local Thoughl{\{JRL

2. Activate the Thought that will be the parent of the newly copied Thought.

3. Right-click within any blank area of the Brain and click Paste Thoughts on

the context menu.

O Health and...

ActiveThought \\; 3 e
- iz Hobbi
@My PSSIOH\ R oo

o .
o4* Home Proi...

|

Paste Thought

hs
Arrange Thoughts by

Layout
Expand All
Collapse All
Report

Timeline

Ctrl+0
“trl+9

Brain Theme...

4. The copied Thought will automatically be linked as a child of the active
Thought and it will also retain all of its original relationships.
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2 Personal Llfe =

P My Passion

B /0_".”VI<=amiTy a.nd Fri...

y,

—0

Heal’_thl.and Fi...

-4

/I \ % e I'TObbl i :
T M®~| o2 Food o® My Pa;ssion
R 3 Copied S \;/?4\,\\
‘ now has\_, (Restourants
oRestaurants 2 parlents
: T

To create a dup

Figure 93. Copied Thought with Two Parents

licate of a Thought:

If you just want to make a duplicate of a single Thought without retaining any of

its links, you can

use the Duplicate Thought command.

1. Right-click the Thought to be duplicated and then click the Duplicate
Thought command on the context menu.
2. The duplicated Thought will appear as a child of the original, as shown in
the figure below.
Perd Copy Local Thought URC
O'M; Passi Copy Web Thought URL
\\ Copy Path to Thought's Folder
Original // ) Duplicate Thought |
Tho tht f/ Forget "L\% 2 L
\ {: Create a duplicate of the selected Thought as a child ‘
—p Books Create Pim
Set as Home Thought
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Figure 94. Duplicating a Thought Within a Brain
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To copy a Thought to another Brain:

1. Right-click the Thought to be copied and then click the Copy “Thought
name” command on the context menu (or activate the Thought, click the
Edit menu, and then click the Copy Thought Thought name command).

Open the Brain into which you want to copy the Thought.

Right-click on the background of the Plex and then click the Paste Thought
command on the context menu (or click the Edit menu and then click the
Paste Thought command).

4. The Thought will be pasted into the Brain and linked as a child of the active
Thought. It will include any attachments, Thought Types, Notes, or other
attributes it had in the original Brain.

the same technique. Right-click anyplace within the Selection box to open the
context menu. See Selecting Multiple Thoughts beginning on page 93 for
complete instructions about selecting multiple Thoughts.

) If you have selected multiple Thoughts, they can all be copied at once using

Undoing and Redoing Actions

Changing your mind about your actions is easy. You can undo up to 100 actions
during your current session. Actions that have been undone can also be re-
executed using the Redo command.

‘File Thought View Options Online Help

‘ ‘ Undo | » Undo Paste Thoughts Ctrl+Z
< Redo ” t Undo Paste Thoughts
Cut Ctrl+X Undo Create Thought
4R CopyThouahtMyBrain _____ Cirl+C Undo Delete "Restaurants”

Figure 95. Undo and Redo Commands

To undo an action:

1. Click the Edit menu and then click the Undo command. The list on the
secondary menu displays your most recent action first.

2. To undo your most recent action, click the first item in the secondary menu.
To undo multiple actions, select the oldest action to be undone from the list.
All actions above that action will also be undone.

To redo an action you have undone:
1. Click the Edit menu and then click the Redo command. If there are multiple
items that can be redone, a secondary menu will be displayed.

2. Click the action of your choice. As in the list of actions that can be undone,
the list is in most-recent-action-first order. All actions above the item you
click will also be undone.
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The Undo and Redo lists are cleared when you sync your Brain (including an
auto sync) and when your Brain is closed.

Editing Thoughts and Links

Renaming Thoughts
You can easily rename any Thought in its Thought Properties dialog box.

= Click the Thought to make it active, then click it again. You may also click the
Show Thought Properties command in the Thought menu or Alt-click a
non-active Thought. In the Thought Properties dialog box, make any edits
you want, then press the Enter key or click in the Plex.

o oNew f’et.ldeas
Original °New Pet Ideas

Thought e S,
name
\ ‘T'rge} Cat ‘ E['
2 +
[ ] o
E X I Type l | Tags |

Modified: ~ Today, 11:33:28 AM

| [
oNew Pet Ideas
Created:  Today, 11:33:28 AM After %

D: 21e53bd0-683e-4f55-8ea1-6e10. F€VISING
h the name
-
>

Figure 96. Renaming a Thought

Selecting Multiple Thoughts
You can select multiple Thoughts in three ways:
= Hold down the Ctrl key as you click each Thought you want to select, or
= Hold down the Ctrl key as you drag to form a box around the Thoughts, or

= Hold down the Ctrl key as you click a gate to select all the Thoughts
connected to that gate
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—
oMy Br’aln -
e = OI Goals
@ Company Goalse— t o i —@ I'm Most Intereste
3 My Team- — : oR Personal Life
7 o What I'm Thlnklng
b e Ny i
i ', Project Management Meetlng Management i
| ol Business. Development SRl Operat|ons !
i a Cllents , Product’ Development i
- o® Customer Service ° ;Sales !
i ® Marketlng i
L e S e e e e e e e e e ]k

Figure 97. Selecting Multiple Thoughts by Ctrl-Dragging

, Selected Thoughts are then added to TheBrain’s Selection box for making
. mass edits on large groups of Thoughts at one time.

After the multiple Thoughts are selected, you can apply actions—Ilink, unlink,
forget, set Thought type, and other actions you would apply to an individual
Thought—to the selected Thoughts en masse. When multiple Thoughts are
selected they are listed in a Selection box on the left side of the Plex and they
are highlighted in the Plex itself.

(. ) .
Selected (3) ®) 2 Personal Life .gMyWork | Goals
£ Bob Jones
9 Cher Wilson . o Family.an.d Friends
A Dan Brown Selection
box . —
S . £ @ .
{# Friends] o Family
§ABOB Jones 5 Ban grown)
“E@:C:EV_W_LEO:”\' o's Debble Miller
\ /

Figure 98. Selection Box and Selected Thoughts
To de-select individual Thoughts:

= Hold down the Ctrl key as you click a Thought (either in the Plex or in the
Selection box) to de-select just that Thought.
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To close the Selection box and de-select all Thoughts:

= Click the close button in the top-right corner of the Selection box. The button
will turn red as you point to it and after the box is closed the Thoughts will no
longer be selected in the Plex.

) Selected (3) ’3% l;PersonaI Life
£ Bob Jones

9¢ Cher Wilson
» Dan Brown

Figure 99. Closing the Selection Box
To perform actions on selected Thoughts:

» Right-click in the Selection box and select the action of your choice on the
context menu. The entries in this menu are also displayed in the Edit menu.

Selected (3) ® 4 personal Life .g My Work | G¢
& Bob Jones
5 Cher Wilson ol Family.ar
+ Debbie Mi...
b Copy 3 Thoughts Ctrl+C
9

Copy as Text Outline

-

Copy as Text Outline with Notes

\al

A
\\

Forget 3 Thoughts

Set Selection Tags »
Set Selection Thought Type »
Set Selection Privacy »

Unlink Selection

Link Selection as Children of "Friends"
Link Selection as Parents of “Friends"

Link Selection as Jumps of “Friends"

Show Common Children

Select Path Between

Figure 100. Selection Box Context Menu
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Other Selection Uses

Once you have created a selection, you can also use it for other things besides
what you see in the menu. For example, you can limit searches to selected
Thoughts. In the example below, only “Debbie Miller” is found because it is the
only Thought name beginning with “D” that is currently selected.

ARS A @ q |
Selected (3) ® ﬁg:(ectlon I 1 match election only | "] Childward only |=
& Bob Jones Thoughts, Links and Events
o Cher Wilson ;% DebbieMiller
+ Debbie Mi...

e Bob JoneSI ol Da.n Brown

@?ggCher Wllson' Debble Miller!

Figure 101. Limiting Searches to Selected Thoughts

Deleting and Forgetting Thoughts

When you no longer need a Thought, it can be forgotten or deleted. A forgotten
Thought may be remembered and restored later, or deleted. A deleted Thought
is gone forever. This is similar to the Recycle Bin/Trash feature on your desktop
which stores your deleted files until you choose to remove them permanently.

To forget a Thought:

» Right-click the Thought to be deleted, then click Forget Thought Name in
the context menu, or

= Click the active Thought to be forgotten, click the menu button in the

Thought Properties dialog box, then, click the Forget Thought Name
command.

TheBrain 10 User Guide 96



My Brain

oNew bet Ideas

Editing Thoughts and Links

61b76d64-1d70-4272-805e-6d3662f9373a

aClients TriedNTru

Add Attachment
Create Event

Open Thought Folder Ctrl+Shift+F

Copy "Cat"

Copy Local Thought URL
Copy Web Thought URL

Copy Path to Thought's Folder
Duplicate Thought

Forget "Cat" . Ctrl+Del

Show History | rorget this Thought
Switch Name and Labe

Create Pin

Set as Home Thought

Convert to Type or Tag...

Figure 102. Forgetting a Thought in its Thought Properties Dialog Box

Once a Thought has been forgotten it will disappear from the display. If you want
to access it again later temporarily, you can do so by turning on the display of
forgotten Thoughts. You can also permanently delete forgotten Thoughts or you

can remember them.

To access forgotten Thoughts:

1. Click the Options menu, then click the Show Forgotten Thoughts

TheBrain 10 User Guide
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' .= One Brain for Everything | What 'm T... \ @

4O AR A A+ @

Showing Forgotten Thoughts ]X

2 Personal Life .gMy Work | Goals

My Brai
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o|" Goals
@

of I'm l\ﬁost Inter...
<o ©®
o.g My Work

o -
o Persorlal Life

{ What I'm Th=inkjng About NowJ 7

2. Notice the “Showing Forgotten Thoughts” message above the pins. This
reminds you why some Thoughts are grayed. You can use forgotten

3.

Figure 103. Forgotten Thoughts in the Plex

Thoughts just like normal Thoughts as long as they are displayed. Click the

View Report button to work directly with the forgotten Thoughts.

Thoughts: Forgotten 4

Time: | Any |
Search:

Access: All ~
Sort: Name v (, =

Figure 104. Forgotten Thoughts in the Report Tab

You can click on a Thought in the Reports tab to activate it.

To delete all forgotten Thoughts using the Reports tab:

= Click the Reports tab menu button, then click the Delete All command. You
will be prompted to confirm the deletion. Alternately, you can use the Ctrl key

to select multiple individual forgotten Thoughts and then delete only those.
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Thoughts: | Forgotten v

Time: Any

Search:

Access: All N

Sort: Name v | EI

Add All to Selection

Remove All from Selection

L% Delete All

Delete all the Thoughts in the report
Save as...

Saved Reports 4
r

Figure 105. Using the Report Tab to Delete All Forgotten Thoughts

* You can click the Refresh button on the Reports tab to update the list.

Closing the Forgotten Thoughts dialog box hides the forgotten Thoughts. You
can also reinstate forgotten Thoughts by clicking the Remember All command
, in the Reports tab menu. You can also reinstate an individual forgotten
: Thought by right-clicking in the Plex, then clicking the Remember Thought
name command on the context menu.

It is generally recommended to forget Thoughts when you don’t need them so
that you can easily retrieve them if you change your mind. If you are sure you will
never need a Thought again and you do not want to be able to remember it in the
future, you can delete it immediately without forgetting it first.

To delete a Thought instantly:

1. Hold down the Shift key as you right-click the Thought to be deleted. The
context menu will be displayed, showing the Delete Thought name
command in place of the Forget Thought name command.

\ Duplicate Thought

I Delete "Dinner” N
e

Delete this Thought
Set as Home tmougnt

Create Pin

o What I'm Th’lnking Private

Show History

Show Thought Properties
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Figure 106. Shift-Right-Click Context Menu for a Thought

2. Click the Delete Thought name command. The Thought will be
permanently deleted. See Selecting Multiple Thoughts on page 93 for
forgetting or deleting multiple Thoughts at once.

Tip: If you delete something by accident you can still recover it if you use
the Undo command immediately.

Unlinking Thoughts
To unlink a Thought:

= Right-click the link, then click the Unlink command on the context menu

)

Tip: If you are moving a Thought from one place to another by linking and
unlinking it, it is generally easier to do the unlinking after you have done the
linking. This avoids making the Thought into an “orphan,” a Thought with no
relatives.

If you have difficulty telling which link you are pointing at with the mouse, just
look at the highlighted Thoughts. When the mouse pointer is over a link, it is
highlighted along with the two Thoughts it connects. This makes it easy to tell
which Thoughts will be unlinked if you click on the link.

In addition to being able to unlink Thoughts one link at a time, you can also select
multiple Thoughts to unlink several of them at once. To do so:

= Select the Thoughts you want to unlink by holding down the Ctrl key and
clicking on each one, or Ctrl drag a box around Thoughts in the same area

= Activate the Thought from which you wish to unlink the selected Thoughts

» Right-click in the Selection box and select the Unlink Selection command

Linking Existing Thoughts

As noted previously, links are power. Not only do links allow for associations that
group Thoughts conceptually, they allow information to be stored in and
accessible from numerous places.

A single Thought may have relationships with multiple Thoughts. For example,
you may want a Thought named “Aunt Mary” to be a child of your “Mentors”
) Thought and also a child of your “Family” Thought. If your Aunt Mary is also
: helping you plan your next vacation, her Thought may also be a child or jump
Thought to your “Vacation” Thought. The possibilities are endless.
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There are several ways to link to existing Thoughts, as described in the following
sections.

Link to Thoughts Visible in the Plex

When the Thoughts you want to link are both visible in the Plex, you can simply
drag from the desired gate of one Thought in the Plex to another Thought in the
Plex. Note that the Thought you drag from or to does not have to be the active
Thought.

In the Normal view, the display of Thoughts is limited to close relations. You may
find it useful to expand the view when linking Thoughts, because you can see
more Thoughts at once.

Link by Dragging to a Pin

You can Link to a Thought that is not visible in the Plex if it has a pin. Simply
drag from the appropriate gate to the pin. When you want to link a Thought to
many other Thoughts, create a pin of the Thought so you can quickly link to it. A
pin’s gates appear when you point at the pin with the mouse.

O AR A A+
¢ £ Personal Life My Work Goals

=1/
Travel

Airline Re...

Summer ...

()
¢b4 Upcoming Trip Plans|

Tropical V...
Urban Tra...

Figure 107. Link by Dragging to a Pin

The relationship you establish by linking a Thought to a pin is between the
Thoughts; if you delete the pin, the Link between the Thoughts is still intact.

Link by Dragging to the Past Thought List

You can link a Thought in the Plex to a Thought in the past Thought list. Like
pins, gates for a Thought in the Past Thought List appear when you point at the
past Thought with the mouse.
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D
< > What : Tropical Va.. §k4 Upcgaing Trip Plans):
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Figure 108. Link by Dragging to a Thought in the Past Thought List

Link by Selecting a Thought in the Create Dialog Box
You can also link by using the Thought Creation dialog box:

1. Make the Thought you want to link from the active Thought, then start
creating a Thought by dragging or using the Thought menu. The Thought
Creation dialog box appears.

2. Type the first few letters of the name of the Thought you want to link to.
Double-click on the Thought you want to link when you see it in the list (or
click it once, then click in the Thought name field and press the Enter key).

{14 Upcoming Trip Plans)
7

I Type I [ Tags I

| B Urban Traveln
3 Upcoming ;-2 Travel Bills
Urgent
: Held Up Project

Figure 109. Create a Link by Starting to Create a Child Thought

Link Using the Selection Box

Thoughts in the Selection box can be linked to the active Thought using the
Selection menu:
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1. Select the Thought or Thoughts you want to link using Ctrl-click or by
holding down the Ctrl key as you drag a box around the Thoughts if they’re
next to each other.

2. Activate the Thought in the Plex to which you want to link.

3. Right-click the Selection box, then click the link command of your choice in
the context menu.

‘File Edit Thought View Options Online Help

-l One Brain for Everything | Upcoming... @

CARS A A+@

Selected (3) ® 2 Personal Life ,gMyWork | Goals
&£ Bob Jones
5§ Cher Wilson o;,..Travel
+ Debbie Miller %
Copy 3 Thoughts Ctrl+C

Copy as Text Outline

= Upcoming Trip Plans)

Copy as Text Outline with Notes

Forget 3 Thoughts

Set Selection Tags >
Set Selection Thought Type »
Set Selection Privacy »

Unlink Selection

Link Selection as Children of "Upcoming..."

Link Selection as Parents of “"Upcoming T..."

{ Link Selection as Jumps of "Upcoming Tri..."

Y Y T —

ShoviEe=eres
) \T Link each selected thought as a jump
Seledrrarrocowecr

Figure 110. Linking Using the Selection Box

Cancel Creation of a Link

Press the Esc key while dragging a link to abort the process. (The mouse button
should still be held down while you press Esc.)

Changing Relationships Using Drag and Drop

Say that you decide that your “Product Promotions” Thought shouldn’t really be a
child of your “Customer Service” Thought. Instead, it should be the child of
“Business Development.” You can quickly change relationships between
Thoughts in a single step: Hold down the Shift key while linking a Thought to a
new parent. All of the current parents will be unlinked automatically. Note that

TheBrain 10 User Guide 103



Editing Thoughts and Links

even if a Thought has more than one parent, all of the former parents will be

unlinked.
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Figure 111. Shift-Dragging to Change Relationships
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Customizing Thought and Link Properties

You can change the colors of Thoughts and links globally using the Brain
Theme window (see the Customizing Your Brain’s Appearance section on
) page 55). This section explains how to view and manage the properties of
: individual and selected Thoughts and links. Changed settings override the
global defaults.

Changing the Properties of a Thought
To open the Thought Properties dialog box, use any of these methods:
= Click the active Thought, or
= Click the Thought once to select it, then a second time to open the box, or
= Alt-click the Thought (whether or not the Thought is active), or

= Right-click the Thought, then click Show Thought Properties on the context
menu, or

= Click the Thought to select it, click the Thought menu in the menu bar, then
click the Show Thought Properties command

Thought name
Thought 9 Thought label Text/background
x colors

6-;
Goals\ E| <
Public/private
g <

icon

— / Actions menu
Thought /’—} Type Tags 4\ -
type Created:  May 20, 2013, 4:36:24 PM N— Thouah
Modified:  Jul 13, 2018, 7:33:37 PM ought tags
ID: b0525¢63-90ch-53de-92da-a3979730b8a0 Y History

F S

Thought details

Figure 112. Thought Properties Dialog Box

Press the Enter key or click anywhere outside of the dialog box to close it and
save any changes.

You can use the Thought Properties dialog box to:
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= Rename a Thought
= Add or edit a Thought Label
= Add or change a Thought Type

= Click the pencil icon next to the Thought Type button to activate the type if
there is one associated with the Thought and modify its appearance

= Add or change a Thought Tag
= Mark the Thought as Private or Public

= Customize the Thought text or background color (just this Thought; global
changes are done in the Themes window)

= Add or change the Thought's icon

= Review the Thought's creation/modification history and ID. The ID is not
normally needed but may be useful when troubleshooting.

= And, using the Thought Properties menu button:
o Forget the Thought
o Create a Pin
o Set as the Home Thought

Changing the Colors of a Thought

While Thought colors are set globally in the Brain Theme window, you can
override these settings for individual Thoughts. To begin, activate the Thought,
then click on it or Alt-click on any inactive Thought.

Note that the individual changes you may make to Thoughts, such as their
color and background, override the settings in the Brain Theme window.

To change the text color of a Thought:

= Click the upper color square, click the color of your choice, then click outside
of the box of colors.
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o

:i:' Retiring at 50

Type Tags

Created: May 20, 2013, 6:37:53 PM
Modified: Today, 4:11:28 PM
ID: cc447f42-c12f-5520-a271-4fabbe2ba297

. Custom . Default

Figure 113. Text Color in the Thought Properties Dialog Box

To change the background color of a Thought:

= Click the lower color square, click the color of your choice, then click outside
of the box of colors.

_I_ Retiring at 50 ﬁ

Type Tags

Created: May 20, 2013, 6:37:53 PM
Modified: Today, 4:11:28 PM
ID: cc447f42-c12f-5520-a271-4fabbe2ba297

I:‘ Custom I:‘ Default

Figure 114. Background Color in the Thought Properties Dialog Box

To swap a Thought’s text color with its background color:

= Click the double-headed arrow next to the two color sample squares in the
top-right area of the Thought Properties dialog box.

_I_ Retiring at 50 Ei
1
o’

Type Tags E

Figure 115. Swapping Text and Background Colors

You can use the same techniques to fine-tune new colors for Thought text and
, background as you can use to define colors globally in the Brain Theme
. window. Please see the Defining and Selecting Additional Colors section on
page 58 for details.
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Adding a Label to a Thought

Labels are hints that appear below Thoughts when you point the mouse at the
Thought.

{2s Product Development)
R ®

JNothing is new for Iongl

Figure 116. A Thought Label
To add a label to a Thought:
1. Activate the Thought, then click on it or Alt-click on any inactive Thought.

2. Type the text for the label in the Label field, then press the Enter key.
When you point at the Thought, the label text will appear in a box below the

Thought.
S ‘ : “
- |Open New Office E
:\ _______ : Phoenix ] lf
Type Tags E

Figure 117. Label Field in Thought Properties Dialog Box

Swapping a Thought’s Name with its Label

You can swap a Thought’s name with its label by clicking the Switch button in
the Thought Properties dialog box. This can be very useful when the default
label and name are assigned based on a URL and the automatic naming isn’t
optimal for your purposes.

‘}
New Hires — E
1
Staff Training o'
Greenlighted Project Urgent E

Figure 118. Swapping Label and Thought Names

TheBrain 10 User Guide 108



Customizing Thought and Link Properties

Adding a Picture to a Thought

You can attach an icon from TheBrain’s built-in selection, an image from a file of
your own, or a screen capture to any Thoughts. These pictures provide a visual
boost to your Brain. When you point to the icon next to the Thought, the picture
zooms to a larger size automatically.

| =
Before mouseover "
» () Hobbies

During mouseover | _y ) obbies

\_./ ~ ,'-:u.-‘_ &

Figure 119. A Thought Icon
To insert an icon from TheBrain’s built-in icon library:

1. Click the Thought icon box, then click the Select Stock Icon command.

T o

| Select Stock Icon | Ctrl+Alt+] | F li\
- Loy
Select an icon from the built in set of icons I
= | Tags E
Copy lcon Vloore
0o h 4
Delete Icon 3
~il Jason

Figure 120. Select an Icon from the Built-in Library

2. Either click any of the categories in the left panel or select All Icons to
scroll through them all. (See the TheBrain Icons section on page 199 for
more about icon choices.) Click an icon of your choice to add it to the
Thought and close the Thought Properties dialog box.
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All Icons
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Figure 121. Icon Choices

To insert an image from a file as a Thought icon:

1. Click the Thought icon box, then click the Choose File command.

‘ o
T

Select Stock Icon Ctrl+Alt+] | IP

= | (thoose File I
las
. 3 Tags @
| Choose an image stored on your local machine |
Copylcon B NIOO! =
o) v
Delete Icon .
+l Jason

Figure 122. Choose a File to Use as an Icon

2. Navigate to the file of your choice, then click the Open button. Supported
file formats for images include .jpg, .png, and .gif.

To insert a screen capture of an image as a Thought icon:

1. Make sure the screen item you want to capture is visible, then activate the
Thought and click on it or Alt-click on any inactive Thought.

2. Click the Thought icon box, then click the Capture Image command.
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- L

Select Stock Icon Ctrl+Alt+I 4 &
S Choose File
| (Capture Image | Tags =
[
i Copy an area of the screen and set it as the icon | e
Delete Icon "|!| Mo ‘

Figure 123. Capture Something on the Screen to Use as an lcon

3. Your Brain will be hidden temporarily and red cross hairs will appear on the
screen. Drag a rectangle around the area to be captured by dragging the
mouse in a diagonal line from one corner of the rectangle to the opposite
corner, then releasing the mouse button.

oK Persorlal Life

{ Pat Green]

Figure 124. Using the Crosshair to Capture an Image

4. When you release the mouse, the image will be in the Icon area of the
Thought Properties dialog box.

‘ Tip: To capture from the Brain window itself, press the Tab key to toggle
its visibility. You will see the crosshairs and you can drag to select the area of

your choice.

While the captured item will become a picture, the source can be anything—a
company logo, a photo, or part of an Excel worksheet or PDF file.
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To paste an image you copy from somewhere else:

1. Copy the image using standard techniques. For example, you may right-
click an image on a web page, then click the Copy Image command.

2. After the image is copied, from the Thought Properties dialog box, click
the Thought icon box or right-click on a Thought in the Plex and select the
Paste Icon command.

~ Aristotle it

Select Stock Icon Ctrl+Alt+1 li\

Choose File

Capture Image Tags =

|_r Paste Icon |
s e -

Use the content of the clipboard as an icon |
DeTete Icon |

Figure 125. Capture Something You’ve Copied to Use as an Icon

To copy an image from the Thought to someplace else:

Images you capture can be copied and pasted as attachments, pasted into
Notes or the Plex, or used as icons.

1. Click the Thought icon box, then click the Copy lcon command.

Aristotle ﬁ |

Select Stock lcon Ctrl+Alt+] d..

e

Choose File

Capture Image Tags

Paste Icon

(0]
Copy Icon |

Delete Icon

Copy the current Thought icon

Figure 126. Copy the Icon to Use Elsewhere

2. Theicon you copied can be pasted elsewhere, such as in a Thought’s
Notes tab or elsewhere on your computer.

To change a Thought'’s icon, repeat the steps above. The icon will be replaced.
To delete a Thought’s icon:

1. Click the Thought icon box, then click the Delete Icon command.
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Aristotle E !

Select Stock Icon Ctrl+Alt+I 4 Ii\

Choose File

Capture Image Tags =

Paste Icon

Copy Icon
|_ Delete Icon |

Delete the current Thought icon |

Figure 127. Removing a Thought Icon

Improved Properties Dialog

All inherited properties, such as from a thought type’s icon, label or colors, are
displayed in the properties dialog.

Thought types or tags are indicated clearly in the dialog

QEREED  osstiton park
. ).

i

..... - [
— 1 Villa House‘ ? :

.........

Current Focus Phase 2 E

_________

e

Figure 128. Properties Dialog Improvements

Making Thoughts Private

Thoughts may be marked “Private.” Private Thoughts will appear with a small
lock icon shown below and to the right of the Thought. The lock appears whether
the Private Thought is active or not. If you make your Brain publicly viewable on
the web, private thoughts remain hidden from view by read only visitors. To mark
a Thought as “Private,” click the lock icon in the Thought Properties dialog box,

TheBrain 10 User Guide 113



Customizing Thought and Link Properties
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Figure 129. A Private Thought

Using Thought URLs

Each Thought in TheBrain is available via a unique URL. A Thought URL can be
used to create links to Thoughts from external third party applications or from
other Brains. Thought URLs can also be used within TheBrain as another way to
connect Thoughts via links within Notes or as attachments to Thoughts.

Thought URLs can be added as hyperlinks in many third party applications so
that when the link is activated, TheBrain will go to the referenced Thought.

To copy a Thought URL:

= Right-click the Thought (or click the Edit menu), then click the Copy Local
Thought URL command.
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Editl Thought View Options Online Help
Undo »

BL

Redo Ctrl+Y

Cut Ctrl+X
Copy Thought Classic TV Shows Ctrl+C

Copy Local Thought URL
Copy Web Thought URL o kina About Now
Copy a link to this thought that will open locally |

Duplicate Thought

Copy as Text Outline TVSh

OwWs
Copy as Text Outline with Notes :
Paste arisv [

Select All Ctrl+A
ol Lov

Add to Selection
Select Related Thoughts

Clear Selection

Show Common Children

Select Path Between

Figure 130. Copying a Thought URL
To paste a copied Thought URL so it will be another Thought’s attachment:

1. Activate the Thought to which it should be copied (which may be in the
original Brain or any active Brain), then right-click the Thought (or click the
Edit menu).

2. Click the Paste Web Link command. The URL will be added to the
Thought as an attachment.

Open in New Tab
o= Aristo Open in New Window

Create Child

Create Parent

Meaning o Create Jump
Set Type
Set Tags

Add Attachment

Create Event

Paste Web Link

Open Thoug Paste on Item

Select Stock Icon

Figure 131. Pasting a Thought URL
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To paste a Thought URL after it has been copied so that it becomes a
hyperlink in a Note:

= |nthe Note, select the text that will be the link, click the Note’s menu button,
then click the Insert Link command. A URL will appear under the Note and
then disappear as soon as you click in the Note.

Notes <
A X B7 AB[Y|=i=a@|=
Select Outdent
" I b Indent
I |OV€ WatChlng CO mnae \ Insert Horizontal Rule
and hIS doq \ Insert Date/Time
| |OV€ watching Columbo Insert Special Character...
and his dog I Inserg Link
In<&}}l ink to Thought

Find & Replace...
A N
/ Show Word Count
v

. Check Spelling as You Type

‘rain://api.thebrain.com/gtAoOFLLIEGp55w1odbebQ/KoVawFbUZUGGXESZCPaZEg/Cqumboﬂ Open in Browser

Print

| love watching Columbo
and his dog

Figure 132. Inserting a Hyperlink in a Note

l To launch the link, click the link icon to the right of the highlighted text.

IPW@ Thought Types and Tags

If you have several Thoughts with which you want to share common attributes,
such as color and an icon, you may want to create a Thought type so that these
attributes can be easily applied to many Thoughts. This is one use of Thought
types.

For example, you may want to create a “person” type for all Thoughts that
represent people in your Brain. This type might have a label— “Person”—and a
specific color and icon so that all people in your Brain stand out and can be
easily recognized.
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Type Thoughts can be edited by activating them and using the Thought
Properties dialog box, just as you would for any other Thought. You can
assign attributes, such as icons, Notes, and attachments, to type Thoughts.

‘ o ﬁriends
@

o § Cher Wilson

$ O
o ¢ Dan Brown

{3 Bob {ones]

Figure 133. Three “Person” Type Thoughts

Once a type has been applied to a set of Thoughts, it can also be used to create
reports of all Thoughts of that type.

When a type has been assigned to a Thought, that Thought is said to be an
“instance” of the type. For example, if you have a Thought named “Jane” of the
“Person” type, the Jane Thought is said to be an instance of the Person type.

Creating a Thought Type
To create a Thought type:

1. Activate the Thought you want to be the first instance of the new type, then
click the Thought to open its Thought Properties dialog box.

2. Click the Type button, then click the New Type command. Alternately, you
can right-click the Thought, click the Set Type command, then click the
New Type command.

3. Enter the name of the type you want to create, then press the Enter key.
Click outside of the Thought Properties dialog box to close it.

4. If you used the context menu to create the new type, the type will appear as

a Thought in the Plex. Type Thoughts are special and have a dotted outline
to distinguish them from other Thoughts.

TheBrain 10 User Guide 117



To do this ...

Customizing Thought and Link Properties

//v
(

®
oBob Joones

Figure 134. An Active Type Thought (“Person”)

Do this ...

Locate and
Activate a Type
Thought

Type the Type’s name in Search box as you would to
search for any other kind of Thought.

&
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Napping
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OR

Activate any Thought associated with that type, and click
on the Parent Thought Type if it is visible.

=
{Person)

Person \

CE& Bob Jones

OR

Click the Activate Type button in the menu bar, then click

the type of your choice or begin typing the name of the
type to locate it quickly if the list is long.
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150/ Drobaalilit,

oR Frlends

TheBrain 10 User Guide

118



Customizing Thought and Link Properties

To do this ... Do this ...
Delete the active  Click the active Type Thought to open its Thought
Type Thought Properties dialog box, click the menu button, then click

the Delete Thought name command.

Note that unlike normal Thoughts, types cannot be
forgotten and remembered. Deleting a type removes it
from your Brain permanently.

Set a Thought's  Use any of these methods:
Type

= Open the Thought’s Thought Properties dialog box,
click the Type button, then click the type of your
choice, or

= Right-click the active Thought, click the Set Type
command, then click the type of your choice, or

= Click the Thought menu when the Thought is active,
click the Set Type command, then click the type of
your choice

= Link the Thought as a child of the type

Set a Thought's  Click the Set Type button in the Thought Creation dialog
Type during box, then click the type of your choice
Thought creation

Remove a Type  Use any of these methods:
from a Thought

= Open the Thought’s Thought Properties dialog box,
click the Type button, then click the Untyped button,
or

= Right-click the active Thought, click the Set Type
command, then click the Untyped button, or

= Click the Thought menu when the Thought is active,
click the Set Type command, then click the Untyped
button

Create new Drag down from the Type Thought’s child gate and
Thoughts linked  continue creating the Thought as usual.
to the active

Type Thought

Create a Super Drag up from the parent gate of a Type Thought, then

Type continue creating as usual or link to another existing Type
Thought.

Reuse a Type in  Copy and paste Type Thoughts from one Brain to another

another Brain the same way you copy and paste other Thoughts.
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)

Tip: To arrange your display by Thought types, right-click on the Plex
background, click Arrange Thoughts by, then click Type.

Attributes that are assigned to a Thought type are inherited by all instances of
the Type but will be overridden if there are attributes assigned directly to the
Thought itself. For example, if you have a Thought named “Jane” of the type
“Person,” you can assign an icon of a smiley face to the Person type and it will
/ appear next the Jane Thought and all other instances of the Person type. But,

: if you then assign a picture of Jane as the icon for that Thought, the picture will
appear on that Thought (only) instead of the smiley face. Likewise, a label
assigned to a specific Thought would override the label of any Thought type
assigned to that Thought.

Super Types

TheBrain supports multiple levels of types for advanced modeling. Just like a
Thought can have a type, each type may in turn have a super type. Super types
are set on the dialog box for the type in the same way a type is set in a Thought’s
Thought tab. The attributes assigned to a super type are inherited by its sub
types and instances.

Super types can be used when there is a category of Thoughts which is subset of
a larger category. For example, the Thought type “Person” could be the super
type of the type “Executive.”

/ To see how to find groups of Thoughts that share one or more of the same
. Type, please see the Running Reports section beginning on page 180.

Using Thought Tags

If there are multiple attributes you would like to add to your Thoughts, you can
create Thought Tags. Tags are useful for flagging Thoughts that you want to be
able to reference as a group, without them having to share a common parent. For
example, you may want to create a “To do” Tag so you can get a list of all of
these Thoughts very quickly.

Tag Thoughts can be edited by activating them and using the Thought
Properties dialog box, just as you would for any other Thought. You can
assign attributes, such as icons, Notes, and attachments, to Tag Thoughts.

Thoughts can have one or many Tags at the same time. Tag Thoughts are global
for a Brain and displaying Tag text and icons can be toggled on and off in the
Look & Feel tab of the Preferences window.
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=]
Thought tag

o
WVgﬂ with an icon
7By Bus ¢—

=By Bus

Figure 135. A Thought with a Tag

To create a Thought Tag:

1. Activate the Thought to which you want to attach a Tag, then click the
Thought to open its Thought Properties dialog box.

2. Click the Tags button, then start typing a name for your new Tag.
Alternately, you can right-click the Thought, click the Set Tags command,
then click the New Tag command and start typing a name for your new
Tag. You can also create multiple Tags at the same time by typing a semi-
colon between each Tag name, just as you can do to create multiple
regular Thoughts at the same time.

3. Press the Enter key. Click outside of the Tags list to close it, then click
outside of the Thought Properties dialog box to close it. The new Tag will
be attached to the active Thought.

, \ : .

| - San Francisco E

l ! 1

S ; o'
Type Tags E

|Ca|ifornia Travel|

.......................................................

Figure 136. Creating a New Tag

Alternately, you can right-click the Thought or click the Thought menu, click
the Set Tags command, then click the New Tag command and start typing a
name for your new Tag. Press the Enter key when you’ve finished.

v

You can also assign one or more Tags to a Thought while you’re creating the
Thought by clicking the Tags button in the Thought Properties or Thought
Creation dialog box.
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Assigning and Removing Tags

You can assign and remove Tags using the same general technique as for
creating them. The only difference is that instead of typing a new name, you
select (to attach) or deselect (to remove) the Tag name(s) in the list.

As shown below, currently assigned Tags are preceded with a check mark. Click
an assigned Tag to remove it and click any Tag in the list to assign it to the active
Thought. This makes it easy to assign and remove multiple Tags at a time.

ol hicann

+ New Tag
T Best in Class
v @By Bus f
K}California TraveU
‘ OFavorite)

§§Funded

QO Gluton Free

¥ [ Healthy|
QOHigh Cost

§LOW Cos£
WM OpenNew.. (= NewHires IT Napp QMedium Cost 1

Los Angeles

mmm——=— =
N e e - - - -

Type

Figure 137. Assigning and Removing Tags

Assigning Tags to Multiple Tags at One Time

If you want to assign Tags to multiple Thoughts at once, first select them, then
right-click in the Selection tab. Click the Set Selection Tags command, then
click the New Tag command or on any of the Tag names in the list.

Deleting a Tag

1. Click the Tags button on the toolbar, then click the Tag of your choice to
activate it.
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A Sports for the Whole
¢ © This Week

QUrgent

Figure 138. Opening the Tags List

2. Either right-click the Thought or click the Thought menu, then click the
Delete “Thought name” command. You can also open its Thought
Properties dialog box, click the menu button, then click the Delete
“Thought Name” command.

To delete multiple Tags at one time:
1. Click the Tags button on the toolbar to display all Tag names in your Brain.

2. Ctrl-click each Tag you want to delete. The Tag is added to the Selection
tab to the left of the list.
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Figure 139. Deleting Multiple Tags List

3. When all the Tags you want to delete are selected, right-click in the
Selection tab, then click the Delete (#) Thoughts command. (Remember
that Tags are also Thoughts themselves.)

Unlike normal Thoughts, Tags cannot be forgotten and remembered. Deleting
a Tag removes it from your entire Brain permanently.

Renaming and Adding Attributes to a Tag

1. Click the Tags button on the toolbar, click the Tag of your choice, then click
the Tag Thought to open its Thought Properties dialog box.

2. You can make the same customizations as you can to any Thought while
you’re in the Tag’s Thought Properties dialog box. When you’re finished
making revisions, press the Enter key.

, Renaming a Tag changes the Tag throughout your entire Brain.

Displaying Thoughts Based on Their Tags

You can show all Thoughts with the same Tag by using Search:

= Begin typing the Tag name in the Search field, then click the Tag name when
it appears. Tags may be indicated with any icon that has been assigned to
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them. When you click the Tag name in the Search hit list, all Thoughts
assigned to that Tag will be displayed in the Plex.

Tag Abbreviations

Along with adding icons to Tags and customizing their names with color, you can
also attach an “abbreviation” for the full Tag name. Abbreviated forms of the
name can serve as hints for what the Tags represent while giving the Plex a
cleaner appearance.

In the Look & Feel tab of the Preferences window, you can change the Tags
text setting to “Show always” if you want the abbreviations to show. Hovering
. over a Thought with Abbreviated Tags or Tag icons will then display the full

Tag name.
P -
|+, !|Favorite
‘Bestm Class }q ) : ‘E
a 3 ) [Fav
R~ i}
|Gluton Free IE L/ Ready in 10 Minutes ‘E
‘ , o= :
Tag VP Tags ‘ = a &
o g | L
{7 My Recipes : T
o Eggplant Parmesan oKung Pao Chlcken
Best in Class ©Gluton Free
o® Kale Ceaser Salad OShoyu Ramen
leut on Free Best in Class OFav
o ® Texas Pete Burritos oThree Bean Chili
B Ready in 10 Minutes 'w¢ Best in Class ©Fav ©Gluton Free
Figure 140. Tag Icons and Abbreviations
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Figure 141. Pointing at a Thought Hides the Abbreviation and Shows the Full Name
To enter a Tag abbreviation:

* |Inthe Tag’s Thought Properties dialog box, type the abbreviation in the field
below the Tag’s name, then press the Enter key.
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Figure 142. Creating a Tag Abbreviation

Additional Thought Type and Tag Features

Visible Thought Types and Tags

Types and tags can now be visible in the plex. Want to see a type or tag as child
thought? Just link any existing type or tag thought as a child, or as a jump. Types
are now optionally visible as parent thoughts as well.

3 TopC )Prioritief;f:

® P.ers.onagl- ¢ Week;nc'I Projects|

( Vacatﬁ)n.PIanning/ OGaraée Repair

Figure 143. Visible Parent Type and Child Tag

Linkable types and tags eliminate the need to create two thoughts when you
want to show all instances of a type or tag within the plex.

e Types are visually distinguished by rounded sides.

e Tags are visually distinguished by chamfered corners.

Hiding Visible Thought Types
Thought types being visible in the plex is optional.
e To prevent a thought type from being visible in the plex, right click on a

thought type and uncheck the option for Visible when Parent of Active
Thought
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' v e
@ Top Priorities)
| N ‘ Visible when Parent of Active Thought |

Open Toggle whether this type is displayed as a parent of instances ‘

Open in New Window |

Figure 144. Toggling the Visibility of a Thought Type

Converting to Type or Tag

You easily change a nhormal thought into a type or tag at any time:

¢ Right click on a thought and select Convert to Type or Tag

Convert "Weekend Projects” to:

® Type O Tag

Thought types pass on their icon, label, and colors to their
children, making them easy to identify. Thoughts can only have
one parent type. Siblings derived via a parent type are not
displayed to prevent clutter.

These characteristics make using Thought types ideal for broad
types of information that are not related to each other.
Common examples of types include: Person, Crganization and
Country.

| OK || Cancel |

Figure 145. Convert to Type or Tag

o Additionally, tags and types can be changed into a normal thought

Clickable Tags

Tag icons that show on thoughts are now clickable. Click any tag that is visible in
the plex to navigate to that tag thought.

Replace Tag

The Replace Tag feature allows you to quickly move a thought through a project
cycle or simply re-classify its tag attributes. To quickly replace a thought’s tag:

e Right click on a tag to open its context menu.
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o Select the option Replace Tag with and select another tag

o™ BISSGlIOHOU...

B villa House|

e
»—=F Pphase > ®Wellington Re...

| Replace Tag with 4 % “Top Priority
¢ Remove Tag © Drafting !
Show Tag Properties Favorite i
N @ © Phase
O 1 Ph(ztOS M Phase 1 E

o Phase 3
o= Rafarencec | L

Figure 146. Replacing a Tag

Nested Tags

Tags can be organized under each other so they are easier to organize, navigate
and apply.

e Link two existing tags with a parent/child relationship to subcategorize

¢ You may also open a tag’s properties to assign it as a sub category of
another tag

¢ Nesting can include multiple tags and multiple layers

™ Phase
Phase

r Closing Procedures

* Accountan

=

&
o
=5
o
%3]
o
lL'u

Designer,

O LA
m

# Musician

Figure 147. Nested Tags

Additional Tag Updates

e Tags Can have background colors associated with them

o Right click on a tag to open its Properties
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o Colors may be selected for the tag’s text and/or background

Tags can be applied to types

Changing the Properties of a Link

Links between Thoughts are normally unnamed. You can hame a link by giving it
a “label.” Just like Thoughts, links can have Types, Notes, and Attachments. You
can control the way they appear in order to clarify relationships or just to create a
more pleasing view of your Brain, based on your personal preference. You can
also manipulate links in order to add or change relationships between your
Thoughts.

Just as each Thought has its own Thought Properties dialog box, each link has
its own Link Properties dialog box.

To open the Link Properties dialog box, use any of these methods:
=  Double-click the link, or
= Click the link once to select it, then a second time to open the box, or

= Alt-click the link (whether or not the link is connected to the active Thought),
or

= Right-click the link, then click Properties on the context menu, or

= Click the link to select it, click the Link menu in the menu bar, then click the
Properties command

............. Change this

" — link’s color
Type a Iab_el that will .Goals
appear in the Plex \. o

'ﬂ,, JQ Make the link’s

\// direction one-way
Select a new thlckness I Dt ) @0“9'“"“’
for this link = Change the
/’ | Untyped | link’s direction
Unlink this Thought ) )
from its parentor  View the history Change properties of the current link Type
Jump Thought of actions taken
on this link Create and attach a link Type or

select an existing Link type

Figure 148. Link Properties Dialog Box
To add a label to a link:

1. Open the Link Properties dialog box for the link, then type a label name in
the Label field.
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[Piano ].
L_Qef.a.ult | © [T]0ne-way
; o
B ——X
= [~—Piano.]
\ o4t
ol 3Ia¥)ing

Figure 149. Adding a Label to a Link

2. Pressthe Enter key, or click outside of the Link Properties dialog box to
close it. The label will appear on the link and will be enlarged when the
mouse points at the link.

To change the color of a link:

1. Open the Link Properties dialog box for the link, then click the color box.

2. Click the color of your choice in the color palette, click outside of the palette
to close it, then press the Enter key, or click outside of the Link Properties
dialog box to close it.

o2 Hobbies

Default

e ——

8

| O [ ] One-wa

c@f[.\ What I'm R

Original color —1/ =

o R I-Tobbies

]

New color —4 \\{

¢7]What I'm Readir

. Custom . Default

Custom Default

Figure 150. Changing the Color of a Link

, This changes the color for the individual link. You can set link colors globally in
. the Brain Theme window (please see the Customizing a Theme’s Colors

section on page 57 for details).
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To change the thickness of a link:

= Open the Link Properties dialog box for the link, click the Default button,
click the thickness of your choice, then click outside of the Link Properties
dialog box to close it.

L
[l Default ﬂo [[] One-way
o | Def L ALY
: i o 2 Hobbies
05 - - %
- Original
. thickness
15
—20 { TeEhnﬁoIogy]
3.0 ' SH.
o 2 Hobbies
50 e
— 1 New
— thickness — &
- 6
150 $.. Technology]

Figure 151. Changing the Thickness of a Link

/ Tip: You might want to thicken links to illustrate the strength of particular
relationships between Thoughts.

o
IPH’@ Link Types

Link types are used to assign commonly-used relationships between Thoughts
that share a label, color, and thickness so they can be easily recognized. Link
properties and types will be retained even if the two linked Thoughts change their
relationship but remain linked (for example, if a child Thought becomes a jump
Thought of the original Thought).

In addition to setting their color, you can add labels to link types and you can
change the thickness of the link to call special attention to relationships.

1. Openthe Link Properties dialog box for the link, then click the Untyped
button.

This button will display “Untyped” if there is currently no Type assigned to the
link and it will display the type name if there is already a Type assigned.
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2. If there’s an existing Type in the list that you want to use, click on it to
select it. Otherwise, click on New Type, then type the name for the new link
in the field that will be displayed.

oJames Fglding

OGrad‘y F(l)JIton

[[]]
28
=
=
<
o
®
o

v Untyped
+ New Type

— Alone
Gear Required

[V

[[Works for{ I]

Figure 152. Creating a New Link Type

2. Press the Enter key to close the Link Properties dialog box.

-
¢James Felding

S
\4_“}
Lo

©
oGrady Féjlton

Figure 153. Appearance of a Link Type in the Plex

, If a Link has both a Type and a label, the label will show in the Plex. While the
. Type won'’t be displayed in the Plex in this case, it can still be used to find all
Thoughts connected to links of that Type.

/ Tip: Point the mouse at a Link Type or label to magnify it in the Plex.
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1. Open the Link Properties dialog box for the link that has the Type you
want to delete, then click the Edit button to open the Type Properties box.

2. Click the menu button then click the Delete command.

| |
| Default | O [ ] One-way
= X Boss 3
4
Edit type
lBoss ]l:]
| Default | © [ ] One-way
r | Delete{\ "
— ] RS

| Delete this link type }

Figure 154. Deleting a Link Type

4

To see how to find Thoughts that share one or more of the same link Type,
please see the Running Reports section beginning on page 180.

Showing Link Directionality

By default, links do not show a directional arrow. You can add directional arrows
that will appear on the link that points to or from the source Thought.

® x oCh
$James Fe?zldmg]

oJaq

3 for— .~
aResponsible 2
[ ..‘Reports [\&O'

t/ -
Report to ]\

OForcas}ing
PS 9
oGrady FéJlton

ORanay B)Iake

Figure 155. Directed Links

A directed link shows an arrow in the middle of the link. If the link has a label

or a Type, the arrow will be next to the text. The arrow is magnified when the
mouse hovers on it. Directional arrows can provide visual cues that are
particularly useful when there’s a link label. For example, for the link label
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“Inspired” (shown below), the link’s directional arrow shows that “Hank
Williams” was a source of inspiration for Elvis. This is also very useful when
you want to represent flows between items like financial relationships.

: ogyLi
(B a5
4/’4\\\\\\\
OBlue H;wau - o OH?Jund Dog
OHank Wllllams OJallhouse Rock
OHeartbreak Hotel OReturn to Sender

Figure 156. Hank Williams Inspired Elvis

To set link direction:

1. Open the Link Properties dialog box for the link to which you want to add

direction. Then:

= Click the icon to the left of the One-way check box to switch between
non-directed, directed, and directed in the reverse.

o EIVI.S
> 4
. lains iredEs==T
oElvis =dInsp
/ - 1t click
: p— oHank Williams' .
..,.,...--\nsp\red" | 7 -
DIl .P.‘r;‘ i
‘ [ o
oHank Williams | Default ] Oy
” =& oElvis
I Default | [:] One-way =
s Syt o
= B I Inspired I Change link direction I H_.,,Aw

| Default

[:] One-way

m

B |

!
L

&

Inspired

Figure 157. Setting the Direction of a Link
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Using One-Way Links

= One-way links appear when the source of the link is active and the source
Thought is already visible.

= One-way links are indicated by an arrow with a rectangle at its base.

o, Soft.bal.l Team OZ.eni't'h

forl‘V"
S woreh

{Guy Smith)

Figure 158. One-Way Link

One-way links are useful where Thought A is relevant when Thought B is active,
but Thought B is not relevant when Thought A is active.

For example, you may want to see what company a person worked for when the
person is the active Thought. However, for a large company with thousands of
employees, you may not want to see all of the employees when that company is
the active Thought. Creating a “works for” link type and making it one-way is a
good way to do this.

To make a Link one-way:

1. Openthe Link Properties dialog box for the link to which you want to add
direction. Then:

= Select the One-way check box to make the selected link one-way. Note
that one-way links cannot be non-directed.

_\Works forl»>

g
oGuy Smith

Change arrow direction

| Default ‘ H E/—Ig)ne-way
[ 3

=K | Works for T"’ Make the arrow one-way

N

Figure 159. Selecting Link Direction
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Customizing Thought and Link Properties

You can also set link direction for link types. The direction of a link type is
inherited by instances of the type and can be overridden by the instance.

oGuy Smith
| ]
| Default | < One-way
El hod | Works for Hg x\
[Works forl X I.
| Default | |$ [] One-way |
E} pod | Change link direction |

Figure 160. Selecting a Link Type Direction
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Advanced Navigation and Alternate Views

Changing How You View Your Thoughts

s
There are three views for displaying your Thoughts:

= Normal view: For focusing on the active Thought and displaying information
pertaining to its parent Thoughts above, child Thoughts below, and jump
Thoughts to the left.

o .
oMy Brain
e e
— j—ff‘f,_’f” OI Goals
] Company Goalse —_— _ o I'm Most | Interested In...
E— My Work
3 N?y Teamo —_— s My Personal Life
B —— 0% What I'm Thlnkmg About Now
o, PrOJect‘Management == ——— f'o/(‘ Meetlng Management
o Business. Development = e oMy We'b Serwces
ol Chents ol Operatlons
o8 Customer Service o4s Product | Development
e Marketmg @ |Sales

Figure 161. A Brain in Normal View

= Qutline view: For a more expanded, primarily hierarchical view of your
Thoughts.

(o] .
oMy B.ranrni

& Company Goalse— =
P} My Teamw

Pl’OJeCt Management
:.o- Busmess Development
"o- Cllents
o8 6ustomer Service
: \.0\ Marketmg
Yo Meetmg Management
o My Web Services
o2 C’perahons
Ouw Product Development
L Sales

/

Figure 162. A Brain in Outline View

= Mind Map view: For a horizontally expanding symmetrical layout.
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eCompleted Prqecﬁ <
Olkeg™ Lgneeg Iq e S S C'onferenceso
‘ oHot | e Sy pProject Ma... (‘.’crporate Brandingo
oPending Projesl O Marketin Z~""% Marketin Evemss
oStalled Project tinge el 9
Stalled = Bnline Markelmgc
oMarket Tre w.i' & = Public Relatlcr\so
oCompany Expansion Ideas oMy B o
‘ cCompet!!ors : ELr P\feetmg Managerger?t? ~
® ~\ P ’ My Web Se..0 My Clientso
olndystry Anal)sm “yoBusiness De... @ -
‘ olndustry Partnersm = — — ~: — -;(.’cmpan) Fmancec
aProduct Promotions ¥ § y e —— dpgra[‘onso i ’ K. Human Resources
>Tar%et Markels i 'Y i & ~ ° ” ifo
@ Company Goals -o 3 My Team g
oABC . Z N 4 Launch New Producto
oBest Yet('g N 7 - Product De..o > % Product Research:
cNew Guys i _< 9CI|e.n;s a 3 * dWeb Site Developmento
o —
Tn:Zd:r[VTZ{ . k =5 Beal Stagese
é L !ncrease Saleso
oCustomer FA& 1 Saless — FfroposalTemplates
oKno\ n Issuesg A pam— e =3 T'ermoneso
‘ oNew Product Releases o SCusﬁomer S 8 = Vie Chents-
aTop Solutions "
|

Figure 163. A Brain in Mind Map View and Expanded

, In addition to selecting a view, you can expand and collapse the display of
. Thoughts in all views to show more or fewer generations.

TheBrain automatically remembers the last view you used and selects it by
default. For example, if you select Outline view and then close TheBrain, the next
time you open it, Outline view will be active.

Three ways to change to a different view:

= Click the Layout button in TheBrain toolbar, then click the view of your
choice, or

» Right-click in the Plex, click the Layout command, then click the view of your
choice, or

= Click the View menu in the menu bar, then click the view of your choice
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K‘Layout button in toolbar
AR A A @

24 Personal Life .y My Work Normal Ctrl+Shift+1
Outline Ctrl+Shift+2
Mind Map Ctrl+Shift+3

Paste Image |
Paste Wallpaper Context menu
in the Plex
Arrange Thoughts by »
[ Layout 4 E] Normal Ctrl+Shift+1
i
Expand All Ctrl+0 Outline Ctrl+Shift+2
Collapse All Ctrl+ Mind Map Ctrl+Shift+3
. E—— — L
— — 0| Goals __ N oy
i Repor . : )< View menu in menu bar
p o w @ TheBrain
H Timeline
‘ A File Edit Thoughtl View IOptions Online Help
Brain Theme... 4 AS 1|
Ve 1 L One Brain for Eve Normal Ctrl+Shift+1 a
Outline Ctrl+Shift+2
ARS . .
Mind Map Ctrl+Shift+3
£ P I Lif aM
[entcing G Expand Al Ctrl+0
Collapse All Ctrl+9
Zoom In Ctrl+=
Zoom Out Ctrl+-
Report
Timeline

Figure 164. Three Ways to Select a View

<

Tip: The check mark in the menu identifies the current view.

you’re creating Thoughts and navigating the Plex, use Outline view when you
want to see a more traditional structure, and to use Mind Map view for viewing
and analyzing the “big picture.”

' A rule of thumb for when you might use each view is to use Normal view when
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Using Outline View

o
o Goals
Q
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Figure 165. Plex in Outline View

Providing a clean, organized way of looking at your Thoughts, Outline view
enables a fast, easily understood overview of the active area of your Thought
network. The level of detail can go as deep as you want while maintaining an

ordered view.

When the Plex is in Outline view, you can show or hide generations of children
for individual Thoughts. To see if a Thought has child Thoughts that aren’t

currently showing, point the mouse at the Thought.

= On mouseover, a plus sign (+) icon will appear above the top edge of the

Thought'’s outline if there are child generations to display. Click the + icon to

expand and show that Thought’s children.

=  On mouseover, a minus sign (-) icon will appear below the bottom edge of the
Thoughts’ outline if child thoughts can be collapsed or hidden. Click the - icon

to hide that Thought’s children.
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Figure 166. Showing/Hiding Additional Generations of Individual Thoughts

Using Mind Map View
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Figure 167. Mind Map View

The Mind Map view allows switching the focused Thought without changing the
layout for when you want to view and alter various pieces of content while
keeping the view mostly static. Traditional mind map layouts can be created

instantly from any Thought.

To navigate to another Thought in your Plex while in Mind Map view, right click

and select Activate Thought.
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=4 p\_ orSTE
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Figure 168. Changing the Active Thought without Changing the Layout

As with Outline view, when the Plex is in Mind Map view, you can show or hide
, generations of children for individual Thoughts by pointing the mouse at a
. Thought, then clicking the plus sign (+) or minus sign (-) icon to show or hide
the Thought’s children.

Expanding and Collapsing Generations

0> Pre

. Besides expanding and collapsing individual Thoughts in Outline view or Mind
Map view, as explained in the previous section, you can also expand and
collapse generations of all Thoughts in all views.

File Edit Thought View,LOptions Online Help

1 One Brain for Eve I/I\\leormal Ctrl+Shift+1
v | Outline Ctrl+Shift+2
AR
Mind Map Ctrl+Shift+3
2 Personal Life  .gMy Work |
Expand All Ctrl+0
Collapse All Ctrl+9
Zoom In Ctrl+=
Zoom Out Ctrl+-
Report
Timeline

Figure 169. Expanding or Collapsing from the View Menu

In Outline and Mind Map view, you can also use the buttons on the toolbar to
expand or collapse all visible Thoughts by one generation.
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File Edit Thought View Options Online Help
Show one fewer géneration i

<« A R

~Show one additional generation

Figure 170. Expanding or Collapsing by One Generation

, In Normal view, the Expand and Collapse by one generation on the toolbar
. work the same way as the Expand All and Collapse All commands on the
View menu.

o 3
offt}Jane's Brain

—0 Goals

\ot‘ I'm Most Interested In...
o2 o] persona| Life o® My Latest Preoccupatlons

/ °q NTy Work
_/"// \‘
— —) e o What I'm Thmkmg About N...

R \%

N : § ag’nily — //// ~Q\ Home Projects
o Food / ~S My Passnon
o® f!nends oW My Pet
Health and Fitness ol Personal Finance
}-Tobbles 0ﬁ~'l'ravel

Figure 171. Jane’s Brain in Normal View with All Collapsed
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Figure 172. Jane’s Brain in Normal View after Expanding All

*

Tip: The vertical scroll bar on the right side of the Plex indicates that
there are more sibling Thoughts in that area which not currently visible.

= Jack

OJacE's Son

<§Jack's %rindson]

oJack's Great Grandson
Jack's Great—Gre’%t Grandson

Figure 173. 5 Generations of Thoughts
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Presentation Mode

Presentation mode makes your Brain full-screen, hiding the title bar, menu bar,
toolbar and Brain tabs. On both Windows and macOS the taskbar and dock are
also hidden. Presentation mode is an excellent viewing option when using your
Brain for effective and focused discussions.

e Enter Presentation Mode by selecting it from the View menu

o Keyboard shortcuts can be used for functionality that is hidden from the
current view, such as switching amongst open Brain tabs without exiting
Presentation Mode

e Just start typing to search and the controls appear and disappear as

= a X
R vl s eSontions Consting nsant Oyra. ) 01 Loop | Fumirs s e 5] 2
CARS A = °
BRonan Howard, Architect  EBVilla House  #Johnson Landscaping Villa House

¢4 Current F...) st Elfon Park
¢ B L E

| = g
] ) i |
B Sid Glasse —T— o™ Bissell Ho... BT PNE hi |
#Débbie R Villa H S om eameet” mpisa e - Srctmson aaicpin —
N Notes +
.
> Office Ideas
-Bids & RFPs 4 Clrrent ... oz Eifon Park

og Hist(.)ric.al Docs

L
o Permittin
< = Bissell H...
-Welli.ngton
* ER

B Sl,d glass-

# Debbie ... CE ';Quée‘

« Bsid... ¢ Villa House, villa ¢ Closing i
\
¢ %
Office Ideas X Phgtos
_— °
Bids & RFPs G References
. 'Q e °®
@ | Historical Docs & Schedule
[ meior L
@ Permitting Site Plans
L] = L] %
<« > @ Villa Hous...  #1 Villa Hous. Closing Pr. Archive] (PPhase 3] ( Phase 2] EhVilla House

Figure 174. Before and after switching to Presentation Mode
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Using TheBrain Content Area

You can think of the parts of TheBrain’s Content Area as personal assistants who
are ready to help when asked. You can give any of them the day, week, or year
off if you choose not to use their services, but they’re all standing by, ready to
assist you—-at the click of your mouse.

The Content Area keeps all of your Thought-specific notes and attachments.
Attachments can be files, web pages, pictures, and more.

Notes tab Attachments tab Active Thought name

\ S

Notes I -+

| Link to File | | Enter URL |
| Open Folder | | Create Event |
| Capture Image | | Templates... | | Paste URL |
Create File \ BrainBox

B data import.xlsx
Microsoft Access Database
g Microsoft Excel Worksheet
2 Microsoft PowerPoint Presentation
@ Microsoft Publisher Document
2 Microsoft Word Document
<. Text Document

& Website Budget.xlsx

-

Figure 175. TheBrain’s Content Area

Content Area Overview
Here are some handy things to know about the Content Area:

= By default, the Content Area shows content attached to the active Thought. If
the active Thought has no content, the Content Area is blank. However, if you
want to see the content for Thoughts you point at with the mouse, select the
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“Update displayed content on hover” option in the Ul tab of the Preferences
window. (Please see the Behavior Preferences section on page 73 for more
information about setting global user interface preferences.)

[ Update displayed content on hover ]

|| Show details when selecting attachment to open

Embedded browser for web links

A Personal Life ,aMy Work |- Goals /* ‘bl My Web Services
rNote51 +
Mouseover
- ThOUg ht Mana... - .
ACtlve op Busnness Dev... R e d e S | g n T| m e
Thoug ht N o8 Cust’omer Se...
o5 yWork z -
— . Marketmg
= Get bids
m Check refs
o Proaucx Dev... Choose a vendor
- ° |Sales z
Content Content for
On drag and drop of files: Copy droppe Mouseover Th(_)tht
. _ “My Web Services”
Content tab location: Automatic v |

Figure 176. Content of an Inactive Thought after Ul Preference is Changed

s

your preferences at any time.

Preferences are global; whatever options are selected when one Brain is
active will also be selected in your other Brains. Of course you can change

= With one click, you can move the Content Area to any side of the Plex—
above, below, left, or right. See the Using Smart Splitter to Arrange TheBrain
Window section on page 51 for details. While you're working on content you
might find it convenient to maximize the Content Area.
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: ©4{ Meeting M...
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My Web Services ‘
Notes =+ o =
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Redesign Time this area
Get bids
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tes ;

Click here to
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»

Figure 177. Maximizing the Content Area

= The size of the Content Area depends on the size of TheBrain window, but
when the Plex and the Content Area are side-by-side, you’re in control of how
much of the available space each area occupies. Just point the mouse at the
line between the two areas and when the double-headed arrow appears, drag
left or right to change the proportions.
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Figure 178. Making the Content Area More Wide or Narrow

Tip: To work with the Content Area in a separate window, click the New
Window command on the File menu. Then, maximize the Plex in one window
and the Content Area in the other. Changes you make in one window will be
reflected in the other because you're working with the same Brain, however, the
windows won’t be in synch. In other words, making a Thought active in one
window won’t make it active in the other.

Creating and Formatting Notes

Take a Note, capture your ideas, or create your next literary masterpiece!

TheBrain 10 User Guide 149



Using TheBrain Content Area

Travel

Notes <

Our Trip to New York

Day 1: Arrival & The Empire State Building &

First impressions of New York are great. We are looking forward to exploring the city for our first time and
visiting many of its most popular locations.

The Ezpire State Building is great for a pamoramic shot of New York.

Day 2: FAO Schwarz & & Times Square &

Made popular by the movie, Big, we finally get to see the famouse toy store in person. And, of course, you
can't come to New York without visiting Times Square!

Figure 179. A Note-Worthy Note

The Notes Toolbar

The Notes toolbar is quite robust—don’t feel like you have to use every feature
for every note. You’ll see many of the tools you're familiar with from word
processing and email applications. And when you want your note to look “just so”
you’ll have an excellent array of options at your fingertips.

Depending on how wide you’'ve made your Content Area, you may see the fully
expanded toolbar or the compact version. Either way, you’ll have access to all
tools via buttons providing access to the additional commands. By default, unless
the Content Area is stretched wide, the compact version of the toolbar will be
displayed.

Tip: To show the expanded toolbar even if the Content Area isn’t very
wide, deselect the “Use compact toolbars for Notes” check box in the Ul tab of
the Preferences window. (Please see the Behavior Preferences section on page
73 for more information about setting global user interface preferences.)
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Content
On drag and drop of files: Copy droppé¢
— Deselecting “Use compact toolbars

for Notes” activates the expanded
Notes toolbar

Content tab location:

Update displayed content on hovgr
[] Show details when selecting attfchment to open
Embedded browser for web li
| 1 Show attachmen i

Click for access to additional

features on the expanded toolbar Compact
{ ! toolbar
i:vﬁ;gzgzs 4——1—")
Notes <+
- Expanded toolbar N
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Figure 180. Compact and Expanded Versions of the Notes Toolbar
The Notes toolbar only appears in the Content Area when you need it—as soon
as you click in the Notes tab.

Text Background
Bo.Id Co‘lor CPIor Numbered Date/Time -

3 Insert Horizontal Rule h
e \ \ J "St)» Indent
Insert Special Character...

N A - - 1 - . l
’A_A]['& o B SIS IMIEIE b] é 'é = Insert Link
T {P h ko d Insert Link to Thought
axt: \ Famgrap Bulleted \Check Outdent .
size Style Italics list box list Find & Replace...

Show Word Count
Toggle Underline Formatting

[<]%]

Check Spelling as You Type
Toggle Strikethrough Formatting

Toggle Superscript Formatting Opea iy Beowses

Toggle Subscript Formatting Bint

Remove Inline Formatting Notes Style

Figure 181. The Compact Notes Toolbar

TheBrain 10 User Guide 151



Using TheBrain Content Area

Here are the additional buttons that show when the expanded Notes toolbar is
displayed.

Show word count

Insert link Underline Superscript Horizontal
to Thought Strlkethrough/ Subscrlpt rule

Remove

Notes +\ \ \ ¥ formatting
\ S
-u Iﬁﬁ@-vprmt et

¥ ——browser Notes

Insert style
Special Spell check as you type

Insert link
character Find & replace

Figure 182. Additional Buttons on the Expanded Notes Toolbar

_ ) All Notes features are always available ho matter which Notes toolbar—
compact or expanded—is displayed.

Entering Notes

To enter a Note, activate the Thought to which the Note pertains, then click in the
open area of the Notes tab in the Content Area and begin typing. The Notes
toolbar will remain displayed whenever the mouse is focused in the Notes tab.

‘v) Notes are saved automatically when another Thought is activated.

You can use all of the standard techniques you use in other text editors when
you type, revise, and format TheBrain Notes:

= Automatic word wrap controls line endings. Press the Enter key to begin a
new paragraph.

= Either apply formatting as you go or select existing text before you apply
formatting such as bold, italics, underlining, and color.

= Standard text selection techniques:

+ Drag the mouse through text to select it, or

+ Click at the beginning of the text, then hold down the Shift key as you
click at the end of the text to select all text in between, or

+ Double-click to select an entire word, triple-click to select an entire line
= To apply formatting to an entire paragraph, such as lists—bulleted,

numbered, or check marked—ijust click anyplace within the paragraph.
There’s no need to first select the entire paragraph.
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= Standard keyboard shortcuts—such as Ctrl-C for Copy, Ctrl-V for Paste,
and Ctrl-A for Select All—work as you would expect in Notes. (On macOS,
the standard Command key shortcuts also work.) You can copy and paste
within Notes and between TheBrain and other applications.

select a formatting command such as bold, highlighting, or change in typeface
or font size, the formatting will apply to the entire word in which the cursor is
currently blinking.

, One special feature for TheBrain Notes is that if no text is selected and you

Tip: You can press Ctrl-Z (or click the Edit menu, then click the Undo
command) to immediately undo your most recent action in Notes.

Choosing a Notes Style

You can choose the style of your notes by clicking the Notes Style button in the
Notes toolbar. The style you choose applies globally to all Notes in a single
Brain, so you can choose a Notes Style that matches the look of each of your
Brains. You can use a different style for each different Brain in TheBrain window.

= To select a style, click in the Notes tab, click the More button, then click the
Notes Style command (or just click the Notes style button if the toolbar is
expanded), then click a style of your choice.

Compact —A[
Notes toolbar |:= E]
Expanded Outdent
Notes toolbar Indent
”3£ ;9: [ E_F Insert Horizontal Rule
Modern “ Insert Date/Time Ctrl+D
Classic 1 Insert Special Character... )
Modern
Codex Insert Link Classi
assic
Console Insert Link to Thought o
odex
Dase Find & Replace... Ctrl+F Gonsole
Deco Show Word Count Dark
DelRey Check Spelling as You Type Deca
Draft
Open in Browser Ctrl+O z DelRey
L S Print Ctrl+P Draft
l Notes Style b » Custom...

Figure 183. Setting the Notes Style

Note Styles also follow a “responsive web design guidelines” approach which is a
fancy way of saying that any Note you create will look great whether it is viewed
on a 30” monitor or a 4” mobile device.
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Tip: You can also create your own unique Notes Styles by selecting the
Custom command and fine-tuning the appearance.

This is a Title This is a Title

Modern

This is normal text.

This is normal text.

This is a Title THIS IS A TITLE

Classic Deco

This is normal text. This is normal text. I

This is a Title This is a Title

Ihisss nopraltcxt. Codex This is normal text. DelRey (Dlefault)

This is a Title This is a Title

L_Console Draft

\ This is normal text. ’

Figure 184. Appearance of Notes Styles

Each Note Style has a set of paragraph styles that help you format your notes
consistently. If you don’t choose a different paragraph style, the text is
automatically attached to a paragraph style named “Normal.”

Notes <

.AA@B .[_ v| ¢

T Title

H Heading

S Sub-heading
v E Normal

<3 Code

Figure 185. Paragraph Styles

with the paragraph, then click the paragraph style of your choice. If you change
to a different Notes Style, the text will change accordingly, based on the
paragraph styles you've selected.

) Paragraph styles apply to entire paragraphs. To select one, just click anyplace
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Changing Text Size in Notes

In addition to changing the size of text by choosing different Notes styles and
paragraph styles, you can quickly adjust text to a size that is most comfortable for
you. It's as easy as clicking the AA Text Size button, then dragging the slider up

or down!
aAText L
size MAIN(B|Z AT v:=ZiZ@|=
button 51 Words

Notes | 4+
- HE BI[Z] A = ‘first of all, if it's on your mind,
bur mind isn't clear. Anything you

Slider consider unfinished in any way

rst of allfif it's on your mind, your m 3

u consigler unfinished in any way mu. must be Captured tha tl’usted
System outside your mind, or wh . .

llection bucket, that you know you'll SyStem OUtSIde your mlnd’ or

ﬂ" SorEthrolgh what | call a collection bucket, that
- David Allen, Getting Things Done you knOW you'[[ come regu[arly

back and sort through."

- David Allen, Getting Things
Done

Figure 186. Slider for Making Note Text Larger or Smaller

Checking Your Spelling

0) Pro

. A spell checker is automatically at work for your Notes. Potential misspellings are
automatically highlighted and you can right-click to view suggestions. Click the
suggestion of your choice to replace the misspelled word. You can customize the
dictionary by adding words to it.
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AN|B 7 ABIv:Zi=Z0@|=

13 words

Talked to Bruce about
the indegndent avant and ha caid
it was fantastic! lodependant N

Ny
interdependent
independence

Independence

denendent

Figure 187. Spell Checker in a Note
If you prefer not to see misspellings flagged as you type:

= Click in the Notes tab, click the More button, then click the Check Spelling
as You Type command (or just click the Check Spelling as You Type
button if the toolbar is expanded).

Compact —4=
Notes toolbar=

13 words

Expanded and he sa Insert Spkcial Character...
Notes toolbar

N_ Norm B U Ctrl+F
LT aEiE0EEHE Q|
RBC > = | Check Spelling as You Type ]
A28 |(EH > 3 &= i’ i
> Open in Browser Ctrl+O
Check Spelling as You Type |
Print Ctrl+P

halked to Bruce about
the indepndent event, and he said tlotesSyie »
it was fantastic!

Figure 188. Disabling Spell Checking

, This is a toggle command. When you want to turn the feature on again, follow
. the same procedure.
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Inserting Horizontal Rules

You can insert horizontal rules (lines) for organizing Notes into sections visually.

= Click in the Note where you want the horizontal rule to appear, click the More
button, then click the Insert Horizontal Rule command (or just click the
Insert Horizontal Rule button if the toolbar is expanded).

Notess 4+ Compact Notes toolbar
AN B 7 A vli= iz @|=
Notes + Expanded Notes toolbar 3 Ouident
i —= Indent
AA N N B /7 U|S XX
— — =5 % | Insert Horizontal Rule
— & |:= iz = = . E QS Insert Date/Time v’
Q  |ABC| ABC | @& i
n a8 | v || S B | E Insert Special Character.
nsert Horizontal Rule
Insert Link
Talked to Bruce about PP
the independent event, and he said
it was fantastic!

Figure 189. Inserting a Horizontal Rule

To remove a horizontal rule:

= Click within the rule to select it, then press the Delete key. If there is a rule
between two paragraphs, the rule will also be deleted if you select and delete

the paragraphs before and after it.
Creating Check Box Lists

You can create a quick check box list and mark the items as complete or

incomplete. You can either create the list as you type or turn any existing text into
a check box list after you select it.

1. Click in the Note where you want to type the first item to appeatr, click in any
paragraph, or select multiple paragraphs.

2. Click the Toggle Check Box List button in the Notes toolbar.
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3. When atask is complete, click the check box to display a check mark and
strike out the text (or click it again to remove the check mark and strike-out
if you decide the task isn’t complete after all).

Notes [ | Marketing Event...

@ Marketing Event... =4

To do:

Meet with Joe

AAEB[;""E

W

| Toggle Checkbox List I

Selected text

To do:

Meet with Joe

Order chairs

After clicking To do:
the check box

>0

Order chairs

Figure 190. Formatting Text as a Check Box List

Linking to Thoughts in Notes

You can create a link to another Thought so that when you click the link the other

Thought will become active.

1. Select desired text or place curser where a new link should appear.

2. Click the More button, then click the Insert Link to Thought command (or

just click the Insert Link to Thought button if the toolbar is expanded).

Type the name of the Thought you wish to link to.

, Insert thought link button enables searching for a thought and no longer

requires that the selected text match a thought name exactly.
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Notes Compact Notes toolbar keting Event... 4
AR |(B 7 A BE[v]iEis

Outdent

Ask Chris Yang for input R
Insert Horizontdl Rule

Notes Expanded Notes toolbar 3Event.. + Insert Date/Tim
i — . Insert Special Character...
oA | N Norme B7 YU S xX ?

. — i Insert Link
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Figure 191. Inserting a Link to a Thought

, After the link has been created, you can change the text of the link and rename
. the Thought without breaking the link.

Creating Quick Web Links

You can add web links to your Brain by using the Add Attachments tab in the
Content area, but a shortcut is to use the Notes tab. Web links can easily be
inserted, edited, and identified within your notes for the active Thought. Use any
of these three ways:

= Typeinthe URL, or

= Paste in the URL from the clipboard after you copy it, or

= Drag the URL in from a browser

The web link will be identified and processed automatically.

, Videos from YouTube and Vimeo are embedded into Notes in a playable form
. automatically. Just drag and drop from your browser into your Notes.
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Figure 192. Dragging a Web Link into a Note

= The URL will be replaced with the title of the page it links to—and you can
easily edit the title by clicking within it and using standard typing and deleting
techniques. If you delete the link icon, the connection to the URL will be
broken.

Volunteer Opportunities in Your
Community | American Red Cross

Red Cross| @

Figure 193. Revising Link Text in a Note

Printing Notes

[ |

.. To print the active Note press Ctrl-P, click the More button, then click the Print
command (or just click the Print button if the toolbar is expanded). The Print
dialog box will open and you can fine-tune your print request.
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Figure 194. Printing a Note

Line Spacing

A preference setting has been added to control the effect of the Enter key to
either create a single line break or a paragraph break.

o Open Preferences and click on the Behavior Tab

e Next to For new notes, Enter inserts a: select either Single Line Break
or Paragraph Break

For new notes, Enter inserts a: Single line break +

Figure 195. Note Spacing Options

IP[r@

Adding Attachments to Your Thoughts

In addition to Notes, each Thought in your Brain can have content associated
with it such as web pages and a multitude of files attachments. You can drag and
drop attachments, create attachments from scratch, and use any of the other
attachment options in the Add Attachment tab of the Content Area.
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My Work

| Link to File
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| | Create Event |

| Capture Image

I
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P
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\ BrainBox
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Text Document

m

Website Budget.xlsx
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& Microsoft Excel Worksheet
Microsoft PowerPoint Presentation
@ Microsoft Publisher Document

Microsoft Word Document

J

W v

Launch any of these
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creating a file attached
to the active Thought

Add a new
template

Figure 196. The Add Attachment Tab in the Content Area

The attachment tab toolbar automatically displays when an attachment is

selected:
Rename
Properties
Open \ /p Actions Menu
( ,.ﬂ \.Schedul éocx Upcoming Trip Plans
Note? ([ @)= ) +

Schedules.docx
C:\Users\TheBrain\Desktop\Summer Plans
11.52 KiB

Modified: Today, 2:03:19 PM

Created: Today, 2:03:18 PM

Figure 197. Attachment Tab Toolbar

= Open: Open the attached file in its default application

= Rename: Change the name of the selected file

= Properties: Display the file’s properties

= Actions Menu: Display all available commands for the selected attachment
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Attaching Files

Using TheBrain Content Area

You can use standard “drag and drop” techniques to add file attachments into
your Brain from other programs to a Thought or to create new Thoughts.

To drag and drop an item into the Content Area of a Thought:

1.

Make sure the Thought to which you want to add the attachment is the
active Thought.

Click the Add Attachment tab in the Content Area.

Position the window containing the item you want to attach so that it and
the Add Attachment tab are both visible, then drag the item to the Add
Attachment tab or into the blank area above the Content Area tabs.

E‘,
View

> Documents * My Docs

0

Summer Plans
"-in.~
N~\
B7 U Y% xx
\

A EIEZAEEHEQS

_ -~
REC) [FBC|| & 3] o 0 words

~

Name

O- August.docx

v @
Search My ... R

Date modified

7/22/2018 3:26 PM
7/22/2018 3:26 PM

7/22/2018 3:26 PM

@ July.docx

Notes

@ June.docx

ummer Plans

3 2L 0=

June.docx
Internal
11.52 KiB

Modified: Jul 22, 2018, 3:26:05 PM
Created: Today, 6:36:41 PM

+

Figure 198. Dragging and Dropping a File into the Add Attachment Tab

Specifying your Drag and Drop Preference

By default, all files that you drag and drop into your Brain will create a copy of the
original file. You can easily change the default to suite your unique environment.
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Please see the Behavior Preferences section on page 73 for information about
viewing and changing the “On drag and drop of files” setting.

Tip: You can also override the current drag and drop setting in the
Preferences window by holding down the following keys as you drag and drop:

am s
L | In Windows ‘ In macOS

" Linktofile = Alt - Link to file = Ctrl

* Move file = Shift = Move file = Cmd

= Copy file = Ctrl = Copy file = Alt

Adding an Attachment Using Link to File

You can also add a file attachment to the active Thought by clicking the Link to
File button on the Add Attachment tab in the Content Area.

= Browse to the file of your choice, then click the Open button.

My Work | Goals Mexco
Notes | 4
[r Link to File N H “ Enter URL |
LMy J
| Open Folder | I Create Event |
. e 4
ropical \./acatlons | Capture Image | | Templates... l I Paste Image |
£ Link to File 4
N « Desktop » Summer Plans v U  Search Summer Plans pel
»Mexico —
© Organize ~ New folder == m @
4 Documer #* A Name Date modified Type
D loa # N o = =
wLoowed @) August.docx 7/22/2018 126 PM  Micrd
= Mlchares: # @2 July.docx 7/23/2018 4:48 PM Micrd
a0f8a67e-7¢ @ June.docx 7/22/2018 1:26 PM Micrd
Brain9 Grapl v < >
File name: | August.docx ¥

Figure 199. Using Link to File to Add a File Attachment
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Attaching Web Pages

e |Pro
. Adding URL attachments to your Brain is a simple process. TheBrain’s built-in
browser will display each web page in a separate Content Area tab.

The easiest method for linking a web page into your Brain is to simply drag and
drop it into your Brain. Click on the URL icon in the address bar of any browser
and drag into one of several different locations to add the web page as an
attachment:

= Drag and drop to the Plex area to create new Thoughts. The Thought name
will be the title of the web page.

= Drag and drop onto existing Thoughts. This will simply add the web page as
an additional attachment. The Thought name will not be updated.

= Drag and drop into a note. This will create hyperlinked text within the note.

= Drag and drop to your attachment list or tabbed attachment area. Again, the
existing active thought will then have this web page as a new attachment.

2 Personal Life B My Work | Goals Hawaii Travel Information | Offi... V Hawaii
Notes | [5] _/ = +
G https://www.gohawaii.com/ g
) - m—
o\ Tropical Vacations em— AWA"AN Q
/}\i\\‘?\o MENU —
[ S—3¢iine.. ISLANDS
: " oAsia Pacific
y Hl \ [¢) .
‘m OM.exico - - :,*q
e © e
o[} Sun’(\jm... ;
< > [EFutur... |\ Tropical Vacati... [ Hawaii

Figure 200. TheBrain’s Built-In Web Browser
Adding a Web Page Using Enter URL

You can also add a web page attachment to the active Thought by clicking the
Enter URL button on the Add Attachment tab in the Content Area.
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Enter key.
Notes | +
| Link to File | l Enter URL I
I/\f
I—g Lﬁps://www.gpjawaii.com/
| Capture Image | I Templates... ] l Paste Image I

Figure 201. Using Enter URL to Add a Web Page Attachment

Attachment Menu for Files

ep|Pro
. Click the Actions Menu button or right-click anyplace in the attachment’s tab to
display all available commands.

Actions Menu

,mi August.docx

Notes | 5 "’ o[z] 'j +

Mexico

August.docx
» C:\Users\TheBrain\Desktop\Summer Plans
1 11.51 KiB

Open

e l

Rename

Properties

Delete

Copy

Cut

Move File into Brain
Copy File into Brain

Show in Explorer

Attachments as Tabs

Attachments as a List

%

Figure 202. File Attachment Menu

= Open: Open the selected attachment in its default application

= Rename: Change the name of the selected attachment
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= Properties: Display all attributes of the selected file in a separate dialog box;
based on the default application, there may be properties you can change

= Delete: Delete the selected attachment (you will be not be prompted to
confirm the deletion but you can use the Edit menu to Undo the deletion)

= Copy: Copy the selected attachment to the clipboard; you can then paste the
attachment elsewhere in your Brain

= Cut: Place the selected attachment into the clipboard; the attachment will be
removed from its current location when it is pasted elsewhere in your Brain

= Move File into/out of Brain: Switch this attachment between internal and
external storage; if you are moving the file out of your Brain, you will be
prompted to specify the destination folder

= Copy File into/out of Brain: Switch this attachment between internal and
external storage; if you are moving the file out of your Brain, you will be
prompted to specify the destination folder

= Show in Explorer: Opens the folder in which the file resides
= Attachments as Tabs: Shows each attachment in a separate tab (default)

= Attachments as a List: Shows all attachments in a single list below any text
in the Notes tab

Attachment Menu for URLS

An attachment that is a web page has a slightly different menu. Access it by
clicking the Actions Menu button or right-clicking the attachment’s tab in the
Content Area.
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Actions Menu

Hawaii Travel Information | Offi... Hawail

Notes 7y Open

G https://v Rename

Edit Location

Delete

m— h Copy
| Cut
MENU
' Attachments as Tabs

Attachments as a List

Figure 203. URL Attachment Menu

= Open: Open the selected web page in its default application
= Rename: Change the name of the selected attachment (not the URL itself)
= Edit Location: Change the URL address for the selected attachment

The rest of the commands work as they do for file attachments.

When a Thought’s attachments are modified, the modification date of the
Thoughts is also automatically updated, improving the accuracy of your
searches and filters.

Other Ways of Opening Attached Files

In addition to clicking the Open command on the attachment’s context menu or
Actions Menu, you can also click the file’s icon next to the Thought in the plex. If
there are multiple attachments, a list will be displayed for you to use to choose
which attachment you want to open. If there is only one attachment, it will be
opened immediately.

Previewing an Attachment

The document Preview option allows you to visualize file attachments right in the
content window of TheBrain without having to launch the file's default application.

ul .
HM indows Instructions

Each file attachment in your Brain has a Preview button in the Content Area.
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Figure 204. Preview Button in the Attachment Tab

= Click the Preview button to launch the Preview for this attachment.
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Market Trends

A market trend is a perceived tendency
of financial markets to move in a
particular direction over time.?’ These
trends are classified as secular for long
time frames, primarily for medium time
frames, and secondary for short time
frames.>® Traders identify market trends
using technical analysis, a framework
which characterizes market trends as
predictable price tendencies within the
market when price reaches support and
resistance levels, varying over time.
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s

' MacOS Instructions

1. Click Preferences on TheBrain menu.

2. On the Ul tab, check the box for Preview File for Attachments. Attached
files will automatically display in the Content Area.

Working with Multiple Attachments

0) Pro

. You can add multiple attachments to Thoughts and you can have many types of
attachments for a single Thought. For example, if you have a Thought for a
person, you might attach their blog as a web page, and their resume in a file—all
in the same Thought.

When there is more than one attachment, the number of attachments is
displayed on the Thought icon. For example, the Thought shown below has two
attachments:

V=D
Sy

Figure 206. Number of Attachments Indicator

Creating an Event as an Attachment

o J»|Pro

. You can use the Create Event button in the Add Attachment tab to add events
to your Thoughts. Please see the Managing Events section on page 191 for
details.

Capturing an Image for an Attachment

1. Navigate to where the picture is so that it is ready to be captured, then
return to TheBrain. Activate the Thought to which you want to add the
image as an attachment.

2. Click the Add Attachment tab in the Content Area, then click the Capture
Image button. Cross-hairs will appear on the screen.

3. Click and drag to the two opposite corners of the area of the screen you
want to use. If you make a mistake, press the Esc key and start over. The
area you selected will instantly be added in a new attachment tab in the
Content Area.
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Modified: Today, 3:34:03 PM
Created: Today, 3:34:03 PM

Figure 207. Capturing an Image

Adding a Template File to Your Brain

There may be types of files that you create frequently that share a common look
and feel. For example, you may prepare correspondence using a common
letterhead. You can designate template files that will be at your fingertips
whenever you create attachments.

To create a template file:

1. Click the Add Attachment button in the Contents Area.

2. Click the Templates button.

E

Notes

Human Resources

| Link to File [ | Enter URL |

| Open Folder | I Create Event I

I Capture Image I I Templates... I I Paste Image I
b

Figure 208. Adding a New Template

TheBrain 10 User Guide

171



Using TheBrain Content Area

3. Click the Yes button to confirm that you want to open the templates folder.

| > Open Templates Folder? X

The templates folder contains files that are copied to create new attachments. For example, to
enable the creation of documents on your letterhead, copy your empty letterhead document
to the templates folder.

t Do you want to open the templates folder now?

I Yes RA | No |

4. Click the Yes button to confirm that you want to open the templates folder.

5. Drag or paste the file of your choice into the window, then close the
window.

The next time you open the Add Attachment tab, the file you added will be
available in the list of attachments.

Tip: If you edit one of the files in your templates folder, save it under a
new name in order to preserve your original template.

Pasting in an Image as an Attachment

If you have copied an image, the Paste Image button in the Add Attachment
tab will be enabled. Click the button to add the image as an attachment to the
active Thought.
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New Hires

Pasted Image.png

Internal
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Modified: Today, 4:02:06 PM
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Using TheBrain Content Area

Y

Notes

;,.+‘

Link to File [ |

Enter URL

Open Folder | I Create Event |

| Capture Image ||

Templates... | | Paste Image |

be

Creating New Files as Attachments

Figure 209. Pasting In an Image

Click any of the file types in the Create File list to begin created a new file in the
associated application. By default, the new file will have the same name as the
active Thought and it will be saved as an internal file.
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Figure 210. Creating New Files

Using the Save As Command

0) Pro

. You can use any application’s “Save as” command to create a new file inside
your Brain. For example, if you have opened a Word file that is an internal
attachment to a Thought, you would click the File menu, click the Save as
command, then enter the name of the new file to create. The new file will
automatically appear in a tab of the Thought’s Content Area.

BrainBox

BrainBox lets you send information to your Brain quickly and easily. Just click the icon in the
top-right corner of TheBrain for Windows or macOS for instant access. Use BrainBox for
adding information on the go, from your desktop, from the web, anything that you want to
quickly capture into your Brain, to be categorized later.
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Accessing BrainBox
The BrainBox Button

At any time, when you have a Brain open, use the BrainBox button in the upper right
hand corner of the window to add previously captured content into your Brain.

1. Click on a Brain to open it.
2. Navigate to the desired thought where you want to add your content.

3. Click on the BrainBox icon to display its content.

=] |
|

Canoe Plans
hittps://www.bearmountainboats.com/collections/cance-plans

9 @ A Shipping Container Turns Into a Backyard Architecture Studio - Dwell
| n !

https:/fwww.dwell.com/article/rba-studio-shipping-centainer-renovation-Tf...

224,50 KiB

Villeneuve House, Permitting.pptx Add to Active Thought or Link
09.00 KiB

Canoe Plans for Lightweight, Elegant Solo and Tandem Cedar Strip Boats
https://ashesstillwaterboats.com/

scorecard.xls + ﬁﬁ o=

Figure 211. The BrainBox Button

4. From here, the file or web page can be:
¢ Added as an internal attachment on a new child thought below the
current active thought. The new thought name will be the file or
web page name.
e Added as an internal attachment to the active thought

e Opened in its default application

¢ Renamed, deleted and other actions applied from the context
menu button

The BrainBox Tab
An alternative way to view and manage the content of your BrainBox is available by

opening BrainBox in its own tab. When you create a new tab, at the bottom of the Brains
list, you'll see the Open BrainBox button.
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{2 TheBrain — m} b
File Edit Options Window Help _
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Figure 212. The BrainBox Tab
Click the Open BrainBox button to open BrainBox in its own tab.

3 TheBrain — O X |

File Edit Options Window Help

, \ y |
/ [:= BrainBox \ @ a1 l
Fel =@ T

Canoe Plans )
https://www.bearmountainboats.com/collections/canoe-plans

@ A Shipping Centainer Turns Into a Backyard Architecture Studio -...
https://www.dwell.com/article/rba-studio-shipping-container-renovati...

Villeneuve House,
Permitting.pptx

Internal

99.00 KiB

Modified: Oct 9, 2017, 2:33:52 PM

=t scorecard.xls
IE Created: Oct 17, 2018, 8:13:28 AM

224.50 KiB
TheBrain - BrainBox - Chrome Web Store
https://chrome.google.com/webstore/detail/thebrain-brainbox/ijepbh...
Villeneuve House, Permitting.pptx
99.00 KiB

@ Canoe Plans for Lightweight, Elegant Solo and Tandem Cedar Stri...
https://ashesstillwaterboats.com/

Yahoo
https://www.yahoo.com/
@ Instag Poetry Is A Huck 's Paradise | HuffPost
https://www huffingtonpost.com/entry/instagram-poetry-atticus-dunc...

Modern House Plans - Architectural Designs
https://www.architecturaldesigns.com/house-plans/styles/modern

|E" pricing chart.xls
64.50 KiB

t Stocklcons.zip

Menus Ancher & Den Restaurant - Grand Cayman - The Beach Ho...
http://anchorandden.com/menus/

[ Homepage - Flambette o

Figure 213. The BrainBox Tab

Use the BrainBox tab to review, edit or delete existing content in your Brainbox.
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BrainBox @
Fe wmO® @

Villeneuve House, Permitting.pptx
Internal

99.00 KiB

Modified: Oct 9, 2017, 2:33:52 PM
Created: Oct 17, 2018, 8:13:28 AM

@ Canoe Plans
https:/fwww.bearmountainboats.com/collections/canoe-...
a A Shipping Container Turns Into a Backyard Architect...
https://www.dwell.com/article/rba-studio-shipping-conta...
scorecard.xls
£ 224.50 KiB
E TheBrain - BrainBox - Chrome Web Store
https://chrome.google.com/webstore/detail/thebrain-bra...
Villeneuve House, Permitting.pptx
99.00 KiB L Rename

Canoe Plans for Lightweight, Elegant Solo and Tande, Open
https://ashesstillwaterboats.com/

E Yahoo Delete
https://www.yahoo.com/ Show in Explorer

E Instagram Poetry Is A Huckster's Paradise | HuffPost Properties
https:)//www.huffingtonpost.com/entry/instagram-poetry.=

Figure 214. Editing Content of The BrainBox
1. Select an item listed in the BrainBox.
2. Use the toolbar button or right-click to show the context menu to:
e Open item in its native application for preview
e Edit the file or link name
e Edit the URL
e Open in Explorer or Finder
¢ View the item properties

e Delete the item from your BrainBox

Sending Web Pages to BrainBox

Add information from any web browser with a single click. When you find a page
you want to capture to be organized later in TheBrain, just click the BrainBox
extension button or bookmarklet (depending on your browser).

You must be logged into your Brain account at https://app.thebrain.com in the
browser you are using in order for the web page to be successfully added into
your BrainBox. If you are not logged in, clicking on the BrainBox extension from
your browser will prompt you to do so in the status screen. Once you have
logged in, return to the desired web page and click the BrainBox button again.

You can use the browser extension or bookmarklet from any computer, even if
TheBrain application is not installed on that device.
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Figure 215. Clicking on the BrainBox Extension

To install the BrainBox extension in your preferred browser visit
https://www.thebrain.com/docs/brainbox and follow the instructions there.

Sending Files to BrainBox

Send copies of individual files into your BrainBox to be organized and associated
with Thoughts at a later time. No additional set up for this feature is required.

Windows File Explorer Send to Integration

From Windows File Explorer, right click on any file and select BrainBox from the

Send to submenu. TheBrain will be started if it is not already running and the file
will be added to BrainBox. To setup the Windows File Explorer integration, install
and run TheBrain 10.
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macOS Dock Drag and Drop

Figure 216. Sending a File to BrainBox

BrainBox

Launch TheBrain application if it is not running already. From any Finder window,
drag and drop any file to TheBrain icon in the macOS Dock. The file will be
added to BrainBox. You can also drag the icon from the title bar of many macOS

apps.
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Running Reports

Running Reports

e |Pro

. Reports are an excellent way to manage large groups of Thoughts in your Brain.
To open a Brain's Report area, click the View menu then click the Report
command. The report pane is resizable.

@ TheBrain
File Edit Thought | View | Options Online Help
= ; v | Normal Ctrl+Shift+1
= One Brain for qu:] | | )
Outline Ctrl+Shift+2
- ARS : A
Mind Map Ctrl+Shift+3
£ Personal Life Expand All Ctrl+0
Collapse All
Zoom In Ctrl+=
Zoom Out Ctrl+-
Report
T'mEI'1 Toggle the display of the report area |

Figure 217. Viewing the Report Area

Selecting Report Criteria

The Thoughts drop-down list includes the following options and each selection
provides additional criteria choices for fine-tuning your reports.

Thoughts: By Types/Tags X

Types: By Types/Tags
Forgotten
Tags:
Parentless
Time: Orphan
Search: Duplicate Names
Access: By Attachments

Figure 218. Thought Options for Reports
You can run reports based on the criteria discussed below.
By Types/Tags

The By Types/Tags option in the Thoughts drop-down helps you filter Thoughts
in your Report by checking for specific Thought Types and Tags. All Thoughts

TheBrain 10 User Guide 180



Running Reports

that don’t meet the criteria will be excluded from the report. By default, Thoughts
of any Type will be included.

= Click the Types field, then select the check box for each Thought Type to be
included. Click outside of the list to close it.

Thoughts: By Types/Tags N/

Types: | Coworker, Expert ’I
Tags: Thought Types #
S [] Untyped
' [] 15% Probability
S h:
eare [] 25% Probability
Access: [] 5% Probability
Sort: [] 50% Probability
75% Probability
& Abdul FalD 4
Anne AdeD .
Barry Sins Coworker

& Betty StaID Director
4 Bill Farrel|[] Executive
4 Chin Lieu|[v] Expert

& Coworker[ "] Hardware

Figure 219. Selecting Thoughts by Types

Use the Tags drop down to filter Thoughts based on your assigned Tags.
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Thoughts:
Types:

Tags:

By Types/Tags v

Coworker, Expert

Any

Time:

Search:
Access:
Sort:

4 Abdul Fa
Anne Ad
Barry Sin

&) Betty Sta

& Bill Farrel

& Chin Liey

&) Coworke
Darren Fi

Y Expert

& Janet Joh
Les Moo

Phil Jaso

Figure 220. Filtering a Report by Tags

Untagged

Best in Class

By Bus
California Travel
Favorite
Funded

Gluton Free
Healthy

High Cost

Low Cost
Medium Cost
Ready in 10 Minutes
Review

Secure Funding

Spicy

\_ Sports for the Whole Family!

Running Reports

Clicking on a Tag in the list will add a “+” next to it, indicating that you want to list
Thoughts that have that Tag. Clicking the same Tag again will add a “-“ next to it.
This indicates that you do not want Thoughts with that Tag listed. Clicking the

same Tag once more will remove it from your list of filtered Tags.

Thoughts:

By Types/Tags Y

Types: |

Coworker, Expert

Tags: |

Best in Class, -Favorite

Time:
Search:
Access:
Sort:

Anne Adz

&) Janet Joh

Phil Jasor -

Figure 221. Filtering With and Without Tags

+

[ ] Untagged

Best in Class

By Bus
California Travel
Favorite
Funded

Gluton Free
Healthy

High Cost

lLowe Coct

Use Types and Tags together in a report for some incredibly powerful Thought
filtering. When your report is displayed, you can click on any result to
immediately navigate to the Thought.
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Forgotten Thoughts

The Forgotten Thoughts selection allows you to quickly view and access any
Thoughts you have forgotten in a Brain.

Thoughts: | Forgotten N N

Time: Any
Search:

Access: All

Sort: Name v | (O =

Figure 222. Forgotten Thoughts Report

With Forgotten selected in the Thoughts drop down, you can use the menu
button to add all forgotten Thoughts in your report to your Selection, remove all
forgotten Thoughts in your report from your Selection, permanently delete all
forgotten Thoughts in your report, or remember all forgotten Thoughts in your
report.

Thoughts: Forgotten Y

Time: Any

Search:

Access: All v

Sort: Name v | @

Add All to Selection
Remove All from Selection
Delete All

Remember All

Save as...

Saved Reports >
\.

Figure 223. Choices for Forgotten Thoughts

A “Showing Forgotten Thoughts” message displays above the Plex. Click any
forgotten Thought in the report to display that Thought in the Plex.
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Thoughts: | Forgotten >
Showing Forgotten Thoughts X

Time: Any
2 Personal Life .gMy Work | Goals il

Access: All

Sort: Name v| (& =

o What I'm Thinking ...

- ®
OBYRAR TIMNEG Foe ot oo st e s www o e aoaatoea e s wwia

"y . O
of Classic...
P =)

Figure 224. Showing Forgotten Thoughts

Parentless Thoughts

Select Parentless in the Thoughts drop down to quickly view and access any
Thoughts that do not have a parent.

Thoughts: Parentless ,k"
Time: I Any
Search:

Access: All

Sort: Name v Q —

@ Company Goals
My Brain
My Brain

.& My Team
Talent Express

Figure 225. Parentless Thought Report

Viewing a Parentless Thought Report is great for tying up any loose connections
or finding groups of disconnected "satellite Thought clusters" in your Brain for
easy reconnection and clean-up.

4

well.

Orphan Thoughts will also appear in a Parentless Thought Report. Jump
Thoughts (when they have no Parent) will frequently appear in this report as
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Running Reports

Select Orphan in the Thoughts drop down to quickly view and access any
Thoughts that do not have any other connections.

Thoughts: | Orphan b N

Time: I Any
Search:

Access: All

Sort: Name v | (& =

ﬂ Held Up Project
My Brain
Talent Express

Figure 226. Orphan Thought Report

Viewing an Orphan Thought Report is an excellent way to find lost Thoughts or
Thoughts that may have inadvertently been disconnected at some point. Is there
a Thought you know you had in your Brain? Try running an Orphan Thought
Report to see if it was previously unlinked by accident.

Duplicate Names

Select Duplicate Names in the Thoughts drop down to quickly view and access
multiple Thoughts with the same name.
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Thoughts: Duplicate Names Li

Search:

Access: All

Sort: Name v | (7

~r
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A
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>3
=1
=X
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Figure 227. Duplicate Names Report
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Viewing the Duplicate Thoughts Report can help you organize and manage your
Brain to make sure you are getting the most out of your information with quick
access to the most important Thoughts.

By Attachments

Select By Attachments in the Thoughts drop down to quickly view and access
all Thoughts that have an attachment.

Thoughts: | By Attachments v

Type: By Types/Tags l
Forgotten 1
Name:
Parentless
Size: Orphan

Time: Duplicate Names D
Search: | By Attachments I: I

Access: All

e
(

Sort: Name v

@ Acquire Company A
X Increase Sales
Lﬂ] Marketing Events
@ Mexico
New Hires

£\ Operations
Figure 228. By Attachments Report

Filtering by Modification or Creation Date

All report options except Duplicate Names can be further narrowed down using
the Time drop down selections. This is incredibly useful for finding information
modified within a specific date range and allows for even more in-depth reporting.
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Thoughts: By Types/Tags \/

Types: I Any
Tags: I Any
Time: | Any N
Search: © Any -

Modified () Created () Event

Access:

Sort:

| Modified: 8/6/2018 - 9/7/2018
O Any

1 Rapport

2) Qualification

3) Presentation ‘13‘%M°d'f'ed O Created O Event
4 August 2018 » | 8/6/201/8 to [9/7/2018
] | &
4 October 2018 )
11 2 3 4
5 n 7 8 9 10 M1
> 1T 2 3 4 5 6

''12 13 14 15 16 17 18 »

, 7 8 9 10 11 12 13
19 20 21 22 23 24 25

: 14 15 16 17 18 19 20

26 27 28 29 30 31 1
D 21 22 23 24 25 26 27

28 29 30 31

Figure 229. Filtering Thoughts in a Report by Modified Date

= Select Modified, Created, or Event to specify what the date range should
pertain to. For example, selected Modified if you want to see Thoughts you
made changes to within a specific period of time.

= Click in the first date field to display a calendar, then select a date; click in the
“to” date to select an end date.

= Select Any if you want to remove the time criteria.

Sorting Report Results

Use the Sort drop down to switch the list order of your report results between
Name and Date, in descending order.
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Thoughts: | By Types/Tags v

Types: I Any

Tags: I Any

Time: I Modified: 9/3/2018 - 9/10/2018
Search:

Access: All

Sort: Name | &, |=

8 Abdul Faj Name
@ Acquire ¢ Pate
" Airline Rewards and Numbers

Anne Adams
Asia Pacific
Barry Sine
& Betty Stark
& Bill Farrel
& Chin Lieu
) Company Expansion Ideas

Figure 230. Sorting Thoughts in a Report

Refreshing or Resetting Report Results

= Click the Refresh button to update the list of Thoughts that match your report
criteria.

Thoughts: | By Attachments v »

Type: Internal Attachments v
Name: ‘

Size:

Time: Any

Search:

Access: All v

Sort: Name v %

@ Acquire Company A
.. o

Figure 231. The Refresh Button

= Click the Reset button to clear all report criteria except the Thoughts field
selection.
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Thoughts: | By Types/Tags ¥
Types: I Any A I
Tags: | Any I
Time: | Any I
Search:
Access: All ¥
Sort: Name v| (& |=
Build Rapport
2) Qualification
D) Dracan Fation

Figure 232. The Reset Button

Adding Report Results to the Selection Box
= Click the menu button, then click Add All to Selection. All report results will

be added to the Selection box where you can apply actions to the Thoughts
all at one time. Right-click in the Selection area to see your choices.

Selected (4) ® Thoughts: | Forgotten v

Time: Any

Search:

Access: Public ¥
Sort: Name v Q E,

l/ Add All to Selection [>
Remove All from Selection

Delete All

Remember All
Save as...

Saved Reports »

Figure 233. Adding Report Results to the Selection Box

Saving and Accessing Reports

|P[f@ Reports can be saved and used again at any time.

To save a report:
1. Click the Save as command on the menu.

2. Type a name for your report, then click the OK button.
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Thoughts: | By Types/Tags | [Reset|
Types: | Expert, Coworker |
Tags: | Best in Class I
Time: | Any |
Search: \ I
Access: ’ Public 7 |
o [ome =] O[]
Anne Adams Add All to Selection
4 Janet Johnson Remove All from Selection
Phil Jason I Save as.. |> |
Sl Reports! Save this as a new report |
|

&3 Enter Report Name X

( [My Experty |

l OK ,\Jl Cancel I

LA\

Figure 234. Saving a Report
To open a saved report:
1. Click the Saved Reports command on the menu.

2. Click the name of the report you want to open.

Thoughts: [ By Types/Tags 2 I IResetl

Types: | Any

Tags: | Any

Time: | Any
Search: [

Access: [ Public v

Sort: Name v G E

1) Build Rapport Add All to Selection

2) Qualification Remove All from Selection

3) Presentation
Save as...

4) Proposal
5) Negotiation l Saved Reports
6) Closed T

v

l | My Expr\rts |
NS

Figure 235. Saving a Report
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Viewing a List of Recent Changes

You can view a quick report of all changes you've made recently to Thoughts.
Your Thought modifications are now logged and instantly viewable in a
chronological display of the previous 1,000 created and modified Thoughts.

Modifications can include:

= Renaming

= Editing, adding or deleting attachments
= Any edit to the Thought notes

= Renaming

= Linking or unlinking to another Thought

To view your recently modified Thoughts, simply click on the clock icon to the
right of the lightning bolt. Modified Thoughts will be displayed starting with the
current date. When you hover over a Thought, a comprehensive, time-stamped
report of the exact modification(s) appear in a pop-up next to the name.

B T T U T

verything | Summer PL... ® B ~
AR+ @~ o

My Work |- Goals Today

a Summer Plans

Bob Jones
1? Set type Untyped Person |" - E
Napping
(% Lee Sharpe Today, 4:44 PM | &8
Yesterday

o, "Airlin | cat

Figure 236. Recently Modified Thoughts and Links

Find and Replace

Find and replace all occurrences of text within thought names and labels, link
labels, external attachment paths and URLs

e Includes support for regular expressions
e Changes are undoable however it is still highly recommended that you
create a Brain Archive (.brz) prior to performing a large Find and Replace

operation on an important Brain.

e To start, select Find and Replace from the File menu under Utilities.
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e Enter the text to be replaced and the text to replace it with.
e Specify where the text occurs. The available locations are:
o Thought Names
o Thought Labels
o Link Labels
o External Attachment Paths
o Attached URLs

e Use the checkboxes to specify whether letter case is to be ignored and if
you want to use regex (regular expressions, which allow sophisticated
pattern matching capabilities)

o Preview your results prior to executing the change and click Replace

when ready
1>
Find: Terrace Consulting In: | Thought names v
| Replace |Terrace LLC [ Ignore case [[] Using regex
|
Preview | 5 matches found.
Before After
Terrace Consulting Annual Report  Terrace LLC Annual Report
Terrace Consulting Terrace LLC I
Terrace Consulting Partnership Terrace LLC Partnership
| Results: | Terrace Consulting Terrace LLC |
Terrace Consulting Board Terrace LLC Board

WARNING: This operation may result in dramatic changes to your Brain. Ensure you have a backup in case
of a problem. This operation will also affect synced instances of this Brain.

| Replace H Cancel i

Figure 237. Find and Replace

Managing Events

e J»|Pro
. Your Brain has its own built-in Calendar. You can access it from the Add
Attachments tab in the Content Area or the Timeline View to can add and modify

TheBrain 10 User Guide 192



Managing Events

events and integrate them with your Thoughts. You can view your Calendar a
day, week, month, or year at a time.

TheBrain also has several different ways to assist you with managing your time,
so you'll know when events are taking place, when content was edited and when
projects are due.

Creating a New Event

You can create a new event using the Add Attachment tab or the Timeline. Both
methods give you full access to all event settings.

Creating an Event from the Add Attachment Tab
1. Select the Thought with which the new event will be associated.

2. Click the Add Attachment tab in the Content Area then click Create Event.

, Events created from the Add Attachment tab are automatically associated
. with the active Thought, but you can easily detach them.

Meeting Management

Notes || ==
\ Link to File [ | Enter URL |
[ Open Folder I [ Create Event {/\@ l
I Capture Image | ‘ Templates... ] Paste

Create File

Microsoft Access Database
g Microsoft Excel Worksheet
& . Microsoft PowerPoint Presentation
@ Microsoft Publisher Document
& . Microsoft Word Document

£ Text Document

Figure 238. Creating a New Event in the Content Area

Use the event editor pop up to enter details about the event. By default, the
name of the event is the name of the active Thought.

As shown below, you can specify start and stop times and dates and add a label,
description, and location in the event editor pop up. You can make the event
recurring and set up a reminder. You can also color code an event—so that all
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events of a specific type (personal, marketing, finance, etc.) will appear in your
Timeline view in an identifiable color.

Detach from

Active Thought \¥ active Thought
W!1en AILDAy ’ i p— Select a color
Is selected, Meeting Management = I
end dates ,
and times are | 19/6/2018 11:00PM | to |9/7/2018 | |12:00 AM ] Start and stop
removed , = = N
> I [ ] All Day "___| Remlnderl 10 minutes v
Im" = r— /\ Reminder options
_—» Never 10 minutes
Repeat | Never ’Meeting Managementi B0 misiistas }4_ Label
options Daily 1 hour P
Weekly e < Description
Monthly 4 hours
Yearly 8 hours i < Location
1 day [
2 days
3 days
4 days
5 days
6 days
7 days
14 days .

Figure 239. The Event Editor

Creating an Event from the Timeline

1. Unless itis already open, display the Timeline by clicking the Timeline
command in the View menu or the Timeline button to the left of the Search
box.

=Nl E3X N
®

| Toggle the display of the timeline

My Work |

Figure 240. Launching TheBrain Timeline

2. Drag on the time ruler at the bottom to select the start and stop times of the
event. After you finish dragging, the event editor will be displayed. By
default, this will be a standalone event, not associated with the current
active Thought. You can easily attach it to the active Thought by clicking
Attach to “active thought” in the event editor menu.
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Oct 19, 2018
08:00 AM

10:00 AM|2 hours

No Thought or Link

2l 2 s la s [6a  |7a a |[9a

Oa 10/19/2018 | 8:00 AM to 110/19/2018 | 10:00 AM
Friday, October 19, 20 Haepesssssseen [b

b [] All Day [ ] Reminder b
-r-a-g
|

Figure 241. Click and Drag to Create a New Event

Please see the Navigating in Timeline View section on page 197 for
[ information about using the Timeline and 1-click fine-tuning based on your
preferences.

Responding to Event Reminders

Reminders appear when the Brain containing the event is open.

One Brain for Everything Reminders

@ Sep 7, 2018, 10:30 AM - Meeting Management - Meet with Z, X
12:00 PM Tammy ’
z
@ Sep 7, 2018, 9:30 AM - Meeting Management - Review Budget Z; X
10:00 AM

Snooze

Snooze amount: | 10 minutes v | | Snooze All

Figure 242. TheBrain’s Event Reminder Pop Up

From the Reminder window, you can snooze for a designated amount of time or

dismiss the reminder. Dismissing the reminder does not delete the event in your
timeline.
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Editing and Deleting Events
To edit or delete an event from the Content Area:

= Click the Events tab, then click the pencil icon to edit the event or the trash
can icon to delete the event.

Notes | | [ 3 Events| |+

@ Sep 13,2018 Meeting Management Edit Delete
£

@ Sep7, 2018, 10:30 AM-12:00  Meet with Tammy
PM

J

@] Sep 7, 2018, 9:30 AM - 10:00 Review Budget V4
AM

(i

Figure 243. Editing and Deleting Events in the Content Area
To edit or delete an event from the Timeline:
= To edit, click the event to open the event editor pop up.

= To delete, right-click the event on the Timeline, then click Delete Event. You
can also delete the event by selecting Delete Event in the event editor pop
up.

Meeting Management .

9/13/2018 | to |9/13/2018 Detach from "Mee

All Day [ ] Reminder I

: Repeat... | Never
Meeting Management

IMeeting Management I

Delerge Event
b

O
o
W &/ Meeting Management
<
infei e safk|6a |[7a |8a |92 |1 &‘e
Thursday, September 13, 2018 &
— .\\0% Activate "Meeting Manager
&
<
,L_ Detach from "Meeting Man
12 2 3 44
sk Delete Event
Properties

Figure 244. Editing and Deleting an Event in the Timeline
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Navigating in Timeline View

= Drag up and down to zoom in and out.

2 < October 2018 »

f & \“"9 : S s o
0& \‘\ B ) ) ) -
N & & ¢ 301 2 3 4 5 6
I «° I 7 8 9 10 11 12 13
I & &S 14 15 16 17 18 [fBY 20
¥ ¢ 21 22 23 24 25 26 27
. ﬁ' e T T 28 29 30 31 ‘

10111211 |2 3 |4 |5 |6 \7‘\, &5 e =0l

, September 13, 2018

@ ‘ October 2018 »
é“ \Z" 2 - A =
B & 5 S W S
O & & 8301 2 3 456
Q@” N o A& 7 8 9 10 111213
&8 & & & 141516 17 18 &Y 20
S (o) _,0\ _,‘-)"’ 21 22 23 24 25 26 27
_. _ 4 o)
7am |8am |9am 10am |11am [12pm | VEDe me S 28 2? 30 ?’J Sl

2018

Figure 245. Click and Drag Up and Down to Zoom

= Drag left and right to scroll through time.
= Buttons allow you to switch between day, week, month and year view. Or,
navigate to a specific day in the mini calendar.
4 October 2018 4

30 1 2 3 4 5 6

R 7 8 9 10 11 12 13
\‘,5,‘1* 14 15 16 17 18 KB} 20
o 210220 23240 250260 2

\'4p_'\ _ 28293031 1 2 3
‘ve-éo—.::= 4 5 6 7 8 9 10
f ) ' ' A 4 4 % Scroll to a specific dateJ
Scroll to current day
Scroll back
Scroll forward
24-hour view
Week view
Month view
Year view

Actions and settings

Figure 246. TheBrain Timeline Buttons
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Google Calendar Sync

If you're synchronizing your Brain to TheBrain Cloud with a Pro Combo account,
you can also synchronize your Brain's Timeline events with Google Calendar.
This will allow you to receive email reminders from Google on events originally
created in TheBrain.

To set up Google Calendar Sync in TheBrain:

1. Open TheBrain Timeline and click the Actions and Settings button, then
click Google Calendar Settings.

2. By default, your Google Calendar Settings is set to None. Click on Manage
External Accounts, then click the Add Google account button. This will
open https://accounts.google.com where you can select your desired
Google account that will be associated with this Brain.

, You can link only one Google account to your Brain.

=

No Google accounts are associated with your TheBrain account.

| ! None (disable Google calendar sync)

@ Manage External Accounts X

Connected accounts:

Add Google,gccountl Remove account

| Manage External Accounts | |

Figure 247. Setting Up the Google Calendar Sync

3. Google will display a confirmation window when you have selected an email
address. Click the Allow button.
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TheBrain Icons

G Sign in with Google

thebrain.com wants to access
your Google Account

° leesharpeé7@gmail.com
This will allow thebrain.com to:

Manage your calendars @

Make sure you trust thebrain.com

You may be sharing sensitive info with this site or app.
Learn about how thebrain.com will handle your data by
reviewing its terms of service and privacy policies. You can
always see or remove access in your Google Account.

Learn about the risks

Figure 248. Confirming Access to Google Account

You will be prompted to close the Google Account window and return to
TheBrain where the new Gmail address will appear on your Google Calendar
Settings window.

4. Select your email address, then click the OK button to confirm that all
events from the Google Calendar will be added to this Brain and vice-versa.

= All new syncs to TheBrain Cloud will also include syncing your Brain
Timeline and your Google Calendar.

TheBrain Icons

TheBrain includes over 2,500 built-in icons for your Thoughts, Types, and Tags.
Choose from a 28 different categories such as Animals, Design, Food,
Multimedia, and Technology, to name a few. Here are some examples:
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To select a Brain icon to be added to a Thought:

1. Right-click the Thought, then click Select Stock Icon or open the
Thought Properties dialog box, click the Thought icon box, then click
the Select Stock lcon command.
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Open in New Tab
Open in New Window

2 8 <
Create Chikd WIHealthy Eating | E]
Create Parent
Create Jump | Select Stock Icon Crl+Alt+1 I * &
Set T ChotSe File
et Type \
Capture Image K4 Tags
Set Tags
Paste Icon 4
Add Attachment x’ v
Copy Icon !
>ersonal Life Srestebvent ) o hy Eating [
— ! Paste Image hnd
Open Thought Folder

[ Select Stock Icon
"W

R SRR

Figure 249. Thought Context Menu

2. Select All Icons and scroll through the pictures or click a specific
category to fine-tune your search. Click on an icon to add it to the
active Thought.

All Icons A S
Animals 6 =
Arrows iy
Business ) = ‘
o
=

Clothes
Design
Emoticons -

Energy

Files
Flags

@
=]
Furnature
Health ”

Holiday
Maps

Multimedia
Objects
People
School

Shopping
Social Media ¥

Healthy Eating] o> MyRe

Figure 250. The Food Category
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Online Menu Options

TheBrain 8 has a hew Online menu in your toolbar. Now you can access your
Cloud Services settings easier from your desktop client and share Thoughts and
Brains quicker.

Window Help

Sync Brain

' Sync Automatically

Open Thought in Web Client
Copy Web Thought URL

Brain Access and Sharing...

Show Account Info

Figure 251. Online Menu Options
Click the Online menu in TheBrain’s toolbar to access the following features:
Sync Brain — Synchronizes the current opened Brain to your Cloud account.

Sync Automatically — Toggle on or off automatic synchronization, once your
Brain is already synchronized to your Cloud account.

Open Thought in Web Client — Launches a Browser window and automatically
loads the current Brain/Thought from TheBrain Cloud.

Copy Web Thought URL — Copies the current active Thought’s online URL to
your system clipboard. This saves you the hassle of launching a new browser
window to log into your Brain Cloud account and navigating to a specific Thought
in order to acquire it's URL.

/ Copy Web Thought URL and View in Browser will only work if you have
: synchronized your Brain to TheBrain Cloud.

Brain Access and Sharing — This is a quick way to switch a Brain’s Access
Control Level (public or private), copy the Brain’s online URL or grant a new
TeamBrain member access. You may also type in an email address to share a
read-only copy of your Brain with someone else.

Show Account Info — Easy access to managing your external accounts and
logging out of TheBrain Cloud.
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Using Mobile Versions of TheBrain

Access your ideas and information on all your devices—including iOS and
Android. TheBrain for mobile devices combines the best of note-taking, file
synchronization, and mind mapping apps to give you the ultimate digital memory
everywhere you go.

The iOS and Android apps include the ability to sync your Brain so you can
access it without an Internet connection. Once you download your Brain locally to
your mobile device, just click the Sync button after making edits or if edits have
been made to TheBrain Cloud.

os §ports
. -
/
L oMamaI Arts
~ Jasone {1 Softball League) o, Baseball
./,,_'\3 Tenms
o+ Emergency Form o wTeam Buuldmg
“* Field Reservatlons o wTeam Roster
ow League Rules o xTournament Schedule
Sync button

Figure 252. Syncing TheBrain on iPhone

TheBrain for iOS can be downloaded from the App Store at
https://itunes.apple.com/us/app/thebrain-tech/id8358733577?mit=8

TheBrain for Android can be downloaded from the Google Play Store at
https://play.google.com/store/apps/details?id=com.thebrain.android
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Share, Synchronize, and Back Up Your Brains

o =|Pro
. You can use TheBrain Cloud to publish and share your Brain. People can view
your published Brains whether or not TheBrain is installed on their machines.

To create a Brain account:

1. Go to http://www.TheBrain.com, then click the Log In button in the top-right
area of the page.

L{@IH pownLoAD [ENOY

Figure 253. Sign Up Button

2. Click the Sign up button.

Log in to TheBrain 9

Lﬂg In } Sign Up Forgot Password?

Figure 254. Login Button

3. Complete all fields in the Sign Up form, then click the Sign Up button. You
will see a message explaining that a confirmation notice has been sent to
the email address you provided. When you receive the message, follow its
instructions to click the link and activate your account.

Allow a few minutes for the email to be delivered. Check your SPAM folder if
: the message doesn’t arrive within a reasonable amount of time.

4. Now you can return to the www.thebrain.com page and click the Login
button to log in using the information you provided when you signed up.
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Synchronizing Your Brain

With TheBrain and TheBrain Cloud Services you can use your Brain on multiple
computers and synchronize changes. Any changes you make to your Brain on
one machine will be reflected on every other machine through synchronization!

Cloud synchronization is protected using 128-bit AES Encryption. (This is the
same encryption used by the US government to protect classified information.)

) Port 443 is used for encrypted syncs. If your IT staff is using a firewall, you can

. ask them to add WebBrain.com and api.thebrain.com to the white list of your
company's firewall. If your IT staff is using a proxy, you will need to try setting
up a Proxy connection via TheBrain by using the options found in TheBrain’s
Preferences > System tab.

Make sure you have created an account on TheBrain.com before you begin
synchronizing. Some Cloud services require a subscription fee.

To synchronize your Brain:

1. Open the Brain you wish to sync. Click the cloud icon in the menu bar, or
click the Online menu, then click the Sync Brain command.

One Brain for Everything | Customer...

A RS A :%’%'

2 Personal Life B My Work{ Sync this brain with the server

. -
o, Project...
i
of Busu.ne...

oM Elients
& 2]

Sy ST N

Figure 255. The Sync Button
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File Edit Thought View Options | Online | Help

' L_1One Brain for Everything | Clients [ Sync Brain
¢ ns

CARS A A+ a

Sync Automatically

Open Thought in Web Client

2 Personal Life .My Work Copy Web Thought URL
Brain Access and Sharing...
°.a My \‘\ Show Account Info

Figure 256. Sync Brain Command
2. Click the Upload button to upload this local brain.

%) Local Brain X

Do you want to upload this local brain?

| Upload I[ Cancel

Figure 257. Confirming Upload

3. A progress indicator shows you the upload is taking place, followed by a
brief confirmation message.

You can keep working while the synchronization process is continuing in the
, background. If there is an interruption during an initial upload of your Brain,
: TheBrain will offer to resume from where it was stopped the next time you
synchronize.

3. When the process is complete, just go to the other computer on which you
want to access your Brain. Open TheBrain application and log in. From the
list of available Brains, click on TheBrain thumbnail, then click the
Download button when it appears.

Do you want to download this remote brain?

| Download || Cancel |

Figure 258. Download for Local Use
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4. To synchronize at any time, click the cloud icon in the menu bar or the
Sync Brain command in the Online menu. The active copy of your Brain
will include the latest changes.

Once your Brain has been

synced, your Brain will be automatically set to auto-

sync. To turn this feature off, click the Sync Status button next to the Cloud icon

in the tool bar.

AR

2 Personal Life

/l(w) One Brain for Everything | Customer... \ @

AR+

hA
S0
@ Up to date

Last synced: Today, 11:51:11 AM
Sync this brain automatically

P P:rgjgct... [

~a My Wol

Figure 259. The Sync Status Button

The Sync Status will also display if local changes or online changes are available

or if the sync is up to date.

The last sync date will also be displayed.

Brain thumbnails in your list of available Brains will indicate if a Brain is local
only, local and online (synced) or online only.

My Brain

Local and online

Product Research
<

I

Local only

Online only

Figure 260. Brain Location Indicators

Editing Your Online Brain

The desktop application has more available features than the web client, but you
can still access and edit your online Brains by performing any of the following

activities:

Unlink Thoughts

TheBrain 10 User Guide
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Change Thought locations (child to jump)
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=  Set Pins
= Edit Notes

=  Add Attachments

/ You can only edit Brains that YOU own.

To edit Notes in your online Brain:

= Click in the Notes tab of the Content Area and make any changes you like.
The revised note will be saved automatically as soon as you click on another
Thought.

Sharing Your Online Brain

All Brains synced to https://app.thebrain.com are private and not accessible to
other users without your personal log in credentials. To share a Version 10 Brain
with other users:

= Open the Brain in your local desktop application
= Click the Online menu, then click Brain Access and Sharing...
* You have two different options for sharing your Brain:

o Option 1: Click the Allow Public Access check box and share the Web
Link with others. This is a great option for sharing your Brain with a large
group of other users or other users that do not use TheBrain software.
Anyone with the URL will be able to view your Brain in read-only mode in
their web browser.

o Options 2: Leave Allow Public Access unchecked and type in an email
address to invite individual users to access your Brain. This is a good
option if you want other users to be able to download a local, read-only
copy of this Brain to their desktop app. The other users must have
TheBrain installed and be logged in to their Brain account with the email
address you specified.

To prepare your Brain to be shared:

1. Activate the Thought that you want to be the Home Thought when your
Brain is viewed. It will be the first Thought your viewers see.

= Right-click the Thought, then click the Set as Home Thought
command
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, The current wallpaper and color theme will be included in your published Brain.

@ One Brain for Everything Brain Access X
Web Link: | https://bra.in/4p7rMv ’

[] Allow public access

his Brain will be inaccessible except to authenticated users.

User Access: | Access Level Group/User

Administrator Me

Users in this list will have access to this Brain including private
thoughts. This Brain will appear in their Brains list and will be
syncable to their local storage.

I Save | | Cancel

Figure 261. Brain Access and Public URL

Creating a Brain Archive to Send Your Brain to Others
You can send your Brain as an email attachment. To make the attachment as
small as possible, you can use TheBrain’s Backup to Brain Archive feature to
create a compact file.
To create a Brain Archive:

1. Click the File menu, then click the Backup to Brain Archive command.

2. Inthe Backup to Brain Archive dialog box, select either of the Access
Control options.
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€2 Backup to Brain Archive X

A brain archive file (extension .brz) is a compressed format suitable for backups and transfering data that
contains everything in your brain except external attachments.

Access Control

() Allow anyone to restore from the exported file

Location

C:\Users\TheBrain\Documents\Brain Miscellaneous\One Brain for Everything 2018-09-07.

Figure 262. Create Brain Archive Options

3. If necessary, click the Change button to change the file name or the folder
where the archive file will be saved. Do not change the filename extension,
which is .BRZ. Click the Backup button to create the archive file.

/ Make a note of where you are saving your archive file so that you can locate
: it easily when needed.

A brief message will display in the toolbar area as the archive is created.

/ Brain Archive files are NOT .zip files. You should not use zip file utilities to
. modify or access your archive files as doing so may corrupt them.

Copying Thoughts into Other Applications as an Outline

You can copy Thoughts from the Selection box into other programs such as
Microsoft Word or Excel and the Thoughts will be formatted as an indented
hierarchical list.

To copy one or more Thoughts into another program as an outline:

1. Select all of the Thoughts you want to include in the outline (Ctrl-click on a
Thought to add it to the selection or use the commands on the Edit menu to
quickly create a selection).

2. Click the Edit menu and then click the Copy as Text Outline command.
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File | Edit | Thought View Options Online Help

)

Sele:

=

.

Undo

Redo
Cut Ctrl+X
Copy 9 Thoughts Ctrl+C

Copy Local Thought URL
Copy Web Thought URL
Duplicate Thought

Copy as Text Outline N

B —

s
Copy as Text Outline with Notes
Paste Ctrl+V

Figure 263. Copying Thoughts as an Outline

3. Open the other application and click where the outline version of the
Thoughts should be inserted.

4. Right-click and then click the Paste command on the context menu (or click
the Edit menu and then click the Paste command).

Pasted into Excel A B c b
~——Y 1 Business Goals
2 Database Mapping Session
Business Goals"] family
4 Brothers
Database Mapping Session§] 5 Favorite Dives
. 6 Foreign Films
Famil/y 7 Atlantis (1991)
Brothersq| 8 Fifth Element, The (1997)
9 Grand bleu, Le (1988)
Favorite DivesY 10
11

Foreign Films9|

Atlantis (1991)1]

-

<¥—_____~ Pasted into Word

Fifth Element, The (1997)

Grand bleu, Le (1988)]

Figure 264. Samples of Outlines Created by Pasting Thoughts from TheBrain

Copying Outlines with Notes

You can copy selected Thoughts along with their notes and place them in a

tabbed outline.

1. Select the Thoughts to be copied, then right-click in the Selection box to
open the context menu.

TheBrain 10 User Guide
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2. Click the Copy as Text Outline with Notes command.

(or use the program’s command for pasting).

Pasting a Text Outline as New Thoughts

You can select tab delineated text in another application, copy it, then paste it
into your Brain. Each paragraph of text will become a child Thought (and possibly
an attachment) of the active Thought, based on the formatting of the text.

3. Switch to Word or any other text application of your choice and press Ctrl-V

Pasted outlines may include labels, attachments, and Notes. If a URL is included,
it is added as an attachment to the Thought in the outline entry above the entry
containing the URL

How TheBrain converts content from the source file:

Each line that ends with an “Enter” or “Shift-Enter” becomes a Thought
A multi-line paragraph with no manual line breaks becomes a Thought
Indentation created using tabs show hierarchical relationships

Lines starting with a hyphen (-) are added as Notes

Lines starting with a plus sign (+) are added as web link attachments

If a pipe (|) symbol is inserted, content to the left of the pipe will be the
Thought name and content to the right of the pipe will become a label (if all
content is in the same paragraph)

Example:

The following text adds a Thought named “Steve Jobs” with the label “Founder of
Apple,” a link to Wikipedia, and a Note containing a quotation.

Steve Jobs | Founder of Apple
+ http://en.wikipedia.org/wiki/Steve_Jobs

-"l want to put a ding in the universe."

TheBrain 10 User Guide

212



Importing Information Into Your Brain

-
’Steve JObS| l E, http://en.wikipedia.org/wiki/Steve_Jobs
Founder of Apple » & Notes| | +
0 —— g ——
"l want to put a ding in the universe."
\ o
oSteve J.obs

|
/

{http://en.w?kipedia.org/...]

Importing Information Into Your Brain

Importing Folders and Mind Maps

€ Import Sl
(O Create a new brain
(%Add to "One Brain for Everything" and link to "Hobbies" H

TheBrain 8 Brain (brainzip, brain) TheBrain 8 Brain

Brain Archive (brz) All of the data from your Brain will be imported

Text Outline (txt) into TheBrain 9. Your existing version 8 Brain will
not be changed and will remain available. Note
that any changes you make in version 9 cannot
FreeMind (mm) be migrated backward to version 8.

Folders

TheBrain 8 XML  (xml)

MindManager (mmap)

To import data from earlier versions of TheBrain,
open it using TheBrain 8 first then import the
resulting Brain here.

I Select File... H Cancel I

[T B e L LTS T

You can import folders and Mind Maps into your Brain. When you import a folder,
it becomes a child Thought of the active Thought.

To Begin Importing:
1. Activate the Thought that will receive the imported information.

2. Click the File menu, then click the Import command.
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For a Folder:

= Click Folders, select the Add to ... button, click the Select Folder button,
navigate to the folder of your choice, then click the OK button. Click the
Import button as soon as it becomes available. Click the next Import button
to confirm that you understand this import can’'t be undone. Each folder will
become a Thought, every file inside the folder will become and attachment,
and any subfolders will become child Thoughts.

For a Mind Map:

*= Click MindManager (.mmap), select the Add to ... button, click the Select
File button, navigate to the file of your choice, then click the Open button.
Each of the topics or ideas will become a separate child Thought of the active
Thought.

Importing TheBrain 8 XMLs

Version 8 Brains that have been exported into an XML format (or properly-
formatted XML that has been generated outside of TheBrain) can easily be
imported back into another Brain as a child of the active Thought.

1. Activate the Thought that will receive the imported XML.

2. Click the File menu, click the Import command, then select the Add to ...
button.

3. Click TheBrain 8 XML, click the Select File button, navigate to the file of
your choice, then click the Open button.

Merging Brains
You can merge two Brains together by importing a Brain Archive file (.BRZ):

1. Open the Brain that you want to merge into another Brain, click the File
menu, then click the Backup to Brain Archive command.

2. Note the location for the new .BRZ file, then click Backup.

3. Open the Brain that will receive the merged Brain, navigate to the Thought
where you want the .BRZ file to be added as a child, click the File menu,
then click the Import command.

4. Select the Add to “open Brain name” and link to “active Thought
name” option, then click Brain Archive (brz) in the list.
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Importing Information Into Your Brain

&2 Import X

(O Create a new brain
I (® Add to "Product Research" and link to "Vegetables" |

TheBrain 8 Brain  (brainzip, brain) Brain Archive
I Braip Archive (brz) I The Brain Archive format stores your Brain in a
Text Outline (txt) compressed form that contains all your data in a
single file.

MindManager ~ (mmap)

FreeMind (mm) This format is very useful to backup your brain or
transfer a brain directly from one computer to

Folders
another without use of TheBrain Cloud Services.

TheBrain 8 XML  (xml)
You can save your brain as Brain Archive from
TheBrain 9 by selecting: File -> Backup to Brain
Archive

| Select File... || Cancel
hs

Figure 265. Merging Brains

5. Click the Select File button, then navigate to and open the initial .BRZ file
you created in the first step. Click the Import button. You will be prompted
to confirm that you want to continue, since importing a .BRZ file can’t be
undone.

, The only Brain that is changed is the one that is open when you begin the
: merge procedure. The Brain you select during step 1 is not changed at all.
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Export

Export

TheBrain 10 features several all-new export options. Export your Brain data
directly to:

e Folders - Exports the thoughts in your Brain by converting them to a
folder hierarchy.

o Each thought becomes a folder containing the attachments and
notes within it.

o The folder structure attempts to mimic the parent-child
relationships between thoughts with parentless thoughts at the top
level.

o Shortcuts on Windows and symbolic links on macOS are used to
represent thoughts that are under multiple parents.

o Text Outline (.txt file) - Creates a text outline of thoughts, notes and
URLs.

o Indented hierarchy mimics parent-child relationships between
thoughts.

o Notes are exported as lines starting with a - (dash)
o URLS are added lines starting with a + (plus)
e JSON Files - Exports your Brain data in JSON format.

o Thoughts, links and other types of data are each exported in their
own .json file.

o Attachments and notes are exported into folders based on the ID
of the thought or link they are attached to.

o This gives you access to 100% of your data in an open and easily
parsed modern text format.

To export your Brain:
o Select Export from the File menu
e Select the output (Folders, Text or JISON) and click on Export
e The output location must be an empty directory

To export just a portion of your Brain, add thoughts first into TheBrain’s Selection
box and then check the option to Only export the selection in the Export
window
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Figure 266. Exporting a Brain to Folders
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Glossary

Activate

Active Thought

Application

Brain button

Brain

Child Thought

Delete

Drag and drop

Forget

Forgotten
Thought

TheBrain 10 User Guide

To bring a Thought to the center of the Plex and make it
the active Thought.

The Thought you are working on right now. The active
Thought occupies the center of the Plex. The active
Thought’s details are described in the Thought tab.
Only the active Thought can be opened by clicking it. A
Thought that is not active can be activated by clicking it,
its pin, or its name in a list and pressing Enter.

A program such as a word processor, database, web
browser, game, or photo editor.

When TheBrain window is set to Auto Hide, it
disappears when you begin working in another
application and is replaced by the Brain button. Click
the Brain button to show the Brain window or attach
files by dragging them to the Brain button.

A collection of associated Thoughts each of which can
have content. TheBrain can create multiple Brains.

A Thought with at least one parent. Children of the
active Thought appear in the child zone, below the
active Thought. In turn, the active Thought is a child of
any Thought that appears above it in the parent zone.

The complete removal of a Thought and/or its content
from a Brain. Deletion is permanent.

To use this feature, select the item you want to drag,
click the mouse button and drag the item to where you
want it to appear.

To remove a Thought from TheBrain without deleting it,
its links, its content, or its note. Forgotten Thoughts can
be “remembered.”

A Thought that is removed from TheBrain without
deleting it, its links, its content, or its note. Forgotten
Thoughts can be “remembered.”
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Gate

Home Thought

Jump Thought

Link

Link Type

Navigate

Notes

Parent Thought

Parentless
Thought
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Glossary

The active Thought and its close relatives have three
circular “gates,” each of which is used to link to a
specific relation: The parent gate is above a Thought;
the child gate is below it; and the jump gate is beside it.
A gate is hollow when there are no links through it, and
solid when links exist.

The Home Thought is the main or top Thought of your
Brain. It is the Thought that is activated when you click
the Home button in the Brain toolbar.

A jump Thought is linked to another Thought through its
jump gate and appears in the jump zone to the left of
the active Thought. Activating a jump Thought produces
a more significant reconfiguration of the Plex than
activating a child Thought or parent Thought. This is
because jump Thoughts of the active Thought are
related exclusively to the active Thought and not to
other Thoughts in the Plex.

The act of connecting Thoughts thereby establishing
close relations. Also, the line connecting two Thoughts
in the Plex.

A category of links that allows you to distinguish how
Thoughts are related visually. For example, you could
have a Link Type called “writes” set so that links
between authors and books display brown with the
label “writes.”

To move from Thought to Thought by activating
Thoughts.

Every Thought can have Notes, displayed in the Notes
tab of the Tools window. Notes can hold any
combination of text, images, sound, or shortcuts. The
Notes function includes a word processor.

A Thought that has at least one child. A parent Thought
is linked to its child Thoughts through its child gate. The
active Thought is a parent of any Thought displayed in
its child zone, below it. Parent Thoughts of the active
Thought appear in the parent zone, above the active
Thought.

A Thought without a parent Thought. A parentless
Thought is often a jump Thought or a Thought
representing a subject heading or organizer. Usually,
the first Thought in a Brain (generally named after the
user) is a parentless Thought.
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Past Thought list

Pin

Plex

Remember

Search field

Search button

Siblings

Template

Thought

Thought Type
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Glossary

The scrollable list of Thoughts at the bottom of the Plex,
arranged in the order activated. The most recently
activated Thought is the rightmost Thought in the list.

An entry point to a Brain. Click a pin to activate its
Thought. A pin is created by dragging a Thought to the
area immediately below the menu bar. The pin stays
there until it is removed by being dragged into the menu
bar or title bar. You can also create a pin of the active
Thought from the Thought menu.

The visible portion of your Brain; includes the active
Thought, its close relations, and the links between
them. It also includes the Search box, the Past Thought
List, and navigation tools.

A Thought that has been removed from the Plex by
“forgetting” can be remembered by selecting Showing
Forgotten Thoughts on the Options menu, right-clicking
the Thought, then selecting Remember Thought name
on the context menu.

The field to the left of the Search button at the bottom of
the Plex. Type text in this field to perform an Instant
Activation search.

The button at the bottom of the Plex that is used to
perform an extended search for the item typed in the
Search field.

Two or more Thoughts with a common parent. When a
Thought that has siblings is active, its siblings are
displayed in the sibling zone, to the right of the active
Thought.

A file used as the basis for creating other files.
Template files can be added to the window of the Add
Attachment dialog box.

The basic unit of a Brain. A Thought can represent
anything the user wants it to. A Thought can have
content in the form of a file, shortcut, or web page, or it
can be devoid of content and simply act as a subject
heading or organizer.

A way to categorize Thoughts and give them distinct
colors. For example, you can have a “Person” Thought
type so that all Thoughts that are people display as
green.
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Timeline

Styles

Unlink

URL

Virtual Thought

Wander

Zones
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Glossary

The Timeline is the visual tool for using TheBrain’s
built-in calendar. Use it to create, edit, and view events
which can be associated with specific Thoughts.

Notes may be formatted using any of TheBrain’s built-in
Styles, which are combinations of font, color, and size.
By default, Notes appear in a style called “Modern.”

Unlink Thoughts that you no longer want to be related
to any other Thought in your Brain, or when you want to
remove a superfluous link. You cannot unlink a
Thought'’s only Link to the active Thought.

Universal Resource Locator; the address of a web site.

A Thought created when a folder is dragged into
TheBrain. Virtual Thoughts are not searchable.

The option to step randomly through TheBrain, to let
you see Thought associations.

Areas in the Plex devoted to specific relations of the
active Thought. There are four zones: the parent zone
above the active Thought, the child zone below it, the
jump zone to its left, and the sibling zone to its right.
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Index

A Forgetting Thoughts - 218
Activate - 218 forgotten Thoughts - 97, 98, 99

active Thought - 4 G

Active Thought - 218 gate - 7
arrange TheBrain windows - 51 Gates
attachments - 25, 42, 89 filled - 219
Attachments - 166, 170 hollow - 219
Auto Hide - 218 Jump - 219
Auto Hide button - 218 Parent - 219
B Sibling - 219

Google Calendar - 198

Brain Settings - 202 guided tour - 14

Brain toolbar - 18

BrainZip - 209, 210 H

BrainZip, create - 209 Home Thought - 219
button bar - 22, 31, 43, 219 Horizontal Rules - 157
C I

Calendar - 192 icons

Child - 219, 221 adding - 109

Child Thought - 6, 218 images

circle highlight - 20 attaching - 109
clock icon - 191 import older Brains - 12
color - 116, 131 install TheBrain - 8
Content Area - 4, 42 instant activation - 47
copy a Thought to another Brain - 92 Instant activation - 24, 25

copy a Thought within a Brain - 89

copy Thoughts into another program - 210
Copy Web Thought URL - 202

create multiple Thoughts - 20

jump Thought - 7
Jump Thought - 219

create Thoughts - 19 K

custom reports, open - 190 keyboard shortcuts - 76

D L

default Brain settings - 51 label

delete a Thought - 99 Thoughts - 108

Dragging - 101, 218 link - 8, 101, 219

duplicate of a Thought - 91 add directional arrow - 133
E directional arrow - 133
events - 193 one-way - 135

Link by Selecting a Thought in the Create
Excel - 210, 214 Child Dialog Box - 102

F Linking existing Thoughts - 101

filename extensions - 11 local Brains - 40

font in the Plex - 61
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M

merging entire Brains - 214
mobile versions of TheBrain - 203
multiple Thoughts

de-select - 94

select - 95

Note Styles - 62
Notes - 155
Notes tab toolbar - 19

o

Online - 202

online Brains - 40

open a Brain - 39

Open Account Page - 202
open older Brains - 11
Operating Systems - 2, 3
outlines - 210

P

Parent - 219

parent Thought - 5, 7

Parentless Thoughts - 219

Past Thought list - 45

Past Thought List - 45, 101, 220

Pasting Outlines - 212

pictures for attachments - 170

Pins - 22, 101, 220
create - 101

pins, create - 44

pins, remove - 44

Plex - 3, 4, 5, 21, 22, 24, 39, 43, 44, 45, 51,
52, 53, 61, 94, 97, 139, 218, 219, 220,
221
move and resize - 52

Preferences dialog box - 69

preview document attachments - 168

preview Thought content - 42

Publish your Brain - 208

Q
Quick-Start Brain - 11
R

redo and undo actions - 92
relationships, change using links - 103

S

Save as - 174
search - 47
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Index

Search file attachments - 49

select multiple Thoughts - 93

Select Thought Icon - 200

semicolon trick - 20, 24, 86

Sibling - 220

sibling Thought - 7

size of Thoughts - 53

smart splitter - 51

spell checker - 155

status (local, online, or both) - 40

super type - 120

Swap Thought name and label - 108

Switch button - 108

Switch View button - 138

synced Brains - 40

Synchronization with TheBrain Cloud
Services... - 202

Synchronize Brain - 205

Synchronize with TheBrain Cloud Services
command - 205

T

tabs in the Brain interface - 41
Tags - 120, 124
Template Brains - 49, 68, 127, 141, 145,
174
Templates - 220
TheBrain Cloud - 204
TheBrain window - 14
Themes - 55, 56, 58, 60, 64, 67
Thoughts - 3, 100, 220
creating multiple - 85
forget - 96
images - 109
rename - 93
unlink - 100
Timeline - 72, 192, 193, 196, 199
navigating - 195, 197

U

undo and redo actions - 92

Unlinking Thoughts - 221

URL - 221

Use the Create Child Dialog Box to Link -
102

Vv

View in Browser - 202

w

Wallpaper - 57, 59, 60, 61
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web page attachments - 26 Child - 221
WebBrain account, create - 204 Jump - 221
Word - 210, 214 Parent - 221
Z Sibling - 221
Zones - 221
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